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Documentation Feedback

At Digidesign, we are always looking for ways to improve our documentation. If 
you have comments, corrections, or suggestions regarding our documentation, 
email us at techpubs@digidesign.com.

Communications & Safety Regulation Information

Compliance Statement
The models D-Control and XMON comply with the following standards regulating 
interference and EMC:
• FCC Part 15 Class A
• EN55103 – 1, environment E4
• EN55103 – 2, environment E4
• AS/NZS 3548 Class A
• CISPR 22 Class A
• ICES-003 Class A

Canadian Compliance Statement:
This Class A digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 
Canada. 

CE Compliance Statement:

Digidesign is authorized to apply the CE (Conformité Europénne) mark on this 
compliant equipment thereby declaring conformity to EMC Directive 
89/336/EEC and Low Voltage Directive 73/23/EEC.

Australian Compliance:

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules. 
Communications Statement
This equipment has been tested to comply with the limits for a Class A digital 
device. Changes or modifications to this product not authorized by Digidesign, 
Inc., could void the Certification and negate your authority to operate the product. 
This product was tested for CISPR compliance under conditions that included the 
use of peripheral devices and shielded cables and connectors between system 
components. Digidesign recommends the use of shielded cables and connectors 
between system components to reduce the possibility of causing interference to 
radios, television sets, and other electronic devices.

Safety Statement
This equipment has been tested to comply with USA and Canadian safety 
certification in accordance with the specifications of UL Standards; UL6500 and 
Canadian CSA standard; CSA C22.2 No.1-M90. Digidesign Inc., has been 
authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this apparatus near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the 
manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, 
or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A 
polarized plug has two blades with one wider than the other. A grounding type 
plug has two blades and a third grounding prong. The wide blade or the third 
prong are provided for your safety. If the provided plug does not fit into your 
outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched particularly at plugs, 
convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Use only with the cart, stand, tripod, bracket, or table specified by the 
manufacturer, or sold with the apparatus. When a cart is used, use caution when 
moving the cart/apparatus combination to avoid injury from tip-over.

13) Unplug this apparatus during lightning storms or when unused for long 
periods of time.

14) Refer all servicing to qualified service personnel. Servicing is required when 
the apparatus has been damaged in any way, such as power-supply cord or plug 
is damaged, liquid has been spilled or objects have fallen into the apparatus, the 
apparatus has been exposed to rain or moisture, does not operate normally, or 
has been dropped.



Do not attempt to service the equipment. There are no 
user-serviceable parts inside. Please refer all servicing to authorized 
Digidesign personnel.

Any attempt to service the equipment will expose you to a risk of 
shock and will void the manufacturer’s warranty.

SPECIAL WARNING REGARDING VENTILATION:

Do not install D-Control anywhere or in any way that blocks free air 
flow at any time around the back panel of the unit.

SPECIAL WARNING REGARDING AMBIENT TEMPERATURE:

Before powering on the D-Control unit, be sure to allow it to reach 
room temperature.  The unit includes some components that are 
senstive to cold temperatures, so it is recommended that you 
unpack the unit and allow it to acclimate before turning it on for the 
first time.
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Part I: Introduction





Chapter 1: Introduction to D-Control
Welcome to the D-Control™ worksurface for Digidesign® 
ICON systems. 

D-Control provides hands-on control of every feature in 
Pro Tools, and offers powerful options for customizing the 
Pro Tools mix environment.

D-Control Features
D-Control provides a full set of controls for all Pro Tools re-
cording, editing and mixing tasks, and a versatile remote-con-
trolled audio monitoring system.

Control Features

• Touch-sensitive, motorized Penny and Giles faders

• Touch-sensitive, multi-purpose rotary controls

• Dedicated controls for assignment and activation of inputs, 
outputs, inserts and sends

• Flexible display of pan, insert, send, plug-in and mic pre 
controls

• Dedicated EQ and dynamics plug-in control sections

• Dedicated controls for all channel strip functions including 
recording and input monitoring modes, mute, solo, and 
channel select

• Dedicated controls for automation mode, enable and safe 
status

• Flip Mode for transfer of parameters from rotary controls to 
faders

• Custom Fader Mode for flexible channel and parameter 
mapping

• Full transport and navigation controls, including location 
commands and scrub/shuttle capability

Monitoring Features

• 8-channel control room monitoring system supports mono 
through 7.1 surround monitoring, with up to 6 possible in-
put sources and 3 selectable output paths

• 2-channel cue system with 5 separate outputs and selectable 
talkback feed

• Built-in talkback microphone and external talkback mic In-
put

• Standalone mode for monitoring without Pro Tools
D-Control System Components
The following components are included in a D-Control 
16-channel or 32-channel system:

Main Unit

• D-Control Main Unit

• AC power cord

• Ethernet cable

• USB cable

• Windows keyboard caps set

• Ethernet loopback plug (for Ethernet testing)

Fader Module 

(1 for 16-Channel System, 2 for 32-Channel System)

• D-Control Fader Module unit

• AC power cord

• Ethernet cable

XMON Monitoring System

• XMON Interface

• AC power cord

• XMON cable

D-Control Stand

• Left and right leg assemblies

• Rear crossbar assembly

• Rear pan support rail

• Front pan support rail

• Left and right plastic side caps

• Leg front caps

• Leg rear caps

• Stand hardware

• Video display arm assembly and hardware
Chapter 1: Introduction to D-Control 3



System Expansion Options

Fader Modules

Additional 16-channel Fader Modules can be added to D-Con-
trol, up to a total of 80 faders (five 16-channel Fader Modules). 

Surround Panner Option

The Surround Panner option for D-Control work surfaces pro-
vides tactile control for many mixing and panning features to 
enhance multichannel mixing for surround sound.

For details on D-Control expansion and customization op-
tions, visit the Digidesign website (www.digidesign.com).

Operational Requirements

Temperature and Ventilation

D-Control should be installed and operated in a climate-con-
trolled environment, away from heat sources, and with ade-
quate ventilation. D-Control should be operated at an ambi-
ent temperature that does not exceed 100 degrees F 
(35 degrees C).

The back panel and the front half of the bottom panel of each 
unit should be exposed to ambient air. Blocking or partially 
blocking the back panel or bottom panel of a D-Control unit 
may cause the unit to malfunction and may void your war-
ranty. 

The D-Control stand is designed to provide adequate ventila-
tion for the D-Control units. Installation of D-Control units in 
other stands or studio furniture is not recommended, and may 
void your warranty if adequate ventilation is not maintained. 

Water and Moisture

D-Control units should be operated away from sources of 
moisture or humidity and should be kept clear of liquids that 
might spill into the units.

Cleaning and Maintenance

If you need to clean the D-Control top surface, apply a 
non-bleach cleaning solution to a cloth or paper towel, then 
carefully wipe the surface. Do not use abrasives, cleaning solu-
tions with bleach, or spray cleaners. 
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Connection Requirements

Power Connections

Each D-Control unit (Main Unit and Fader Modules) and the 
XMON Monitor Interface requires its own power connection. 
Make sure your power source is correctly rated for the number 
of units you are connecting. A surge protected power source 
(not included) is highly recommended.

Ethernet Connections

Each D-Control unit communicates with Pro Tools via Ether-
net. A 10-BaseT Ethernet hub (not included) is required to 
connect D-Control units to the host computer. 

USB Connections

The computer keyboard and trackball on the D-Control Main 
Unit require an available USB connector on the host computer 
or on a USB hub if your system has one. 

Audio Connections

All external analog audio inputs and outputs for control room 
monitoring and studio communication are connected to the 
XMON interface. D-Control connects to the XMON interface 
with a single 15-pin cable (included). All analog inputs and 
outputs on XMON are DB-25 connectors. 

Audio Cables for D-Control Monitoring

Digidesign offers a range of DigiSnake cabling options for con-
necting Digidesign interfaces and external sources to the 
XMON monitoring system. For details, visit the Digidesign 
website (www.digidesign.com).

System Requirements and 
Compatibility
D-Control requires a Pro Tools|HD® system with at least one 
Pro Tools|HD audio interface. 

An expanded HD-series system is required for higher track 
counts.

For complete system requirements and a list of Digidesign 
qualified computers, operating systems, hard drives, and 
third-party devices, refer to the latest information on the 
Digidesign website:

www.digidesign.com/compatibility



Mechanical Specifications
D-Control Stand Dimensions (not including video display arm)

Maximum Height 39.7 inches (100.9 cm)

Maximum Width

Main Unit with 1 Fader Module (16-channel system) 65.3 inches (165.9 cm)

Main Unit with 2 Fader Modules (32-channel system) 88.5 inches (224.8 cm)

Maximum Depth 45.7 inches (116.1 cm)
Figure 1.  Stand dimensions for a 16-fader D-Control system
Figure 2.  Stand dimensions for a 32-fader D-Control system
Chapter 1: Introduction to D-Control 5
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Chapter 2: D-Control Overview

D-Control Main Unit
Main Unit Top Panel
Figure 3.  D-Control Main Unit top panel
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Meter Display

The Meter display on the D-Control Main Unit can be set to 
show the output levels, or levels associated with a track or 
plug-in. See “Meter and Time Code Displays (Main Unit)” on 
page 124.

Time Scale Displays and Location Indicators

The Time Scale displays and Location indicators mirror the 
corresponding indicators in Pro Tools. See “Meter and Time 
Code Displays (Main Unit)” on page 124.

Display Shelf and Display Arm Housing

D-Control gives you two options for using a video display: 
You can place a free-standing display on the display shelf, or 
you can install a VESA TFT display on the included display 
arm. See “Installing a Video Display” on page 27.

Focus Channel Strip

The Focus Channel Strip on the D-Control Main Unit is used 
to bring the controls of any channel strip in a session to the 
center of the control surface, bringing them to the center mix 
position. See “Channel Strips” on page 49.

Dynamics and EQ Sections

The D-Control Main Unit provides dedicated Dynamics and 
EQ sections for plug-ins that support D-Control Dynamics 
and EQ plug-in mapping. See Chapter 7, “Plug-in Controls.”

Monitor Section

The Monitor section on the D-Control Main Unit includes a 
full set of controls for the control room monitoring, head-
phone/cue, and talkback/listenback sections of D-Control. See 
“Monitor Section Controls” on page 115.

Zoom/Navigation Section

The Zoom/Navigate section on the D-Control Main Unit is 
used to control navigation, display, and selections in the 
Pro Tools Edit window. See “Zoom/Navigate Section” on 
page 97.

Bank/Nudge and Bank Select Sections

The Bank/Nudge and Bank Select sections on the D-Control 
Main Unit are used to control the display of Pro Tools tracks 
on the control surface, in both Normal and Custom Fader 
modes. See “Bank/Nudge Section” on page 98 and “Bank Se-
lect Matrix” on page 98. 
D-Control Guide8
Window Management and Session Management 
Sections

The Window Management and Session Management sections 
on the D-Control Main Unit include controls for opening and 
closing Pro Tools windows, and managing and saving 
Pro Tools sessions. See “Window Management Section” on 
page 101 and “Session Management Section” on page 102. 

Soft Keys Section

The Soft Keys section on the D-Control Main Unit provides ac-
cess to a wide range of Pro Tools commands directly from the 
control surface. It also provides access to preferences and set-
tings specific to D-Control. See “Soft Keys Section” on 
page 103. 

Miscellaneous Controls

The Miscellaneous Controls section on the D-Control Main 
Unit includes controls for basic Pro Tools editing and display 
functions. See “Miscellaneous Controls Section” on page 112.

Transport Section

The Transport section on the D-Control Main Unit includes 
two complete sets of transport controls, switches for setting 
the transport mode, scrub/shuttle controls, as well as ad-
vanced audition and locate controls. See “Transport Section” 
on page 91.

Channel Strip Master Section

The Channel Strip Master section is a set of controls that 
appears on both the left and right sides of the D-Control Main 
Unit, allowing easy access to powerful assignment, display, 
and channel function controls from any mixing position. See 
“Channel Strip Master Section” on page 57.

Custom Fader Controls

The Custom Fader controls in the D-Control Main Unit in-
voke a special set of D-Control modes, called Custom Fader 
modes, which let you set aside and customize channel strips 
for display and editing of a variety of functions. See “Custom 
Fader Controls” on page 67.

Talkback Switches

Two Talkback switches on the Main Unit provide mirrored 
control of the D-Control Talkback function. See “Talkback 
Switch” on page 69.

Automation Mode Controls

The Automation Mode controls mirror the function of the 
on-screen Automation Mode selector for each track. See “Au-
tomation Mode Controls” on page 69.



Main Unit Back Panel
Figure 4.  D-Control Main Unit back panel connectors

Footswitch jack

Keyboard/Trackball
USB connector

Ethernet connector

XMON Monitoring System 
connector

AC Power

Power switch
AC Power

The AC Power connector accepts a standard AC power cable. 
The D-Control Main Unit is auto power-selecting (100V to 
240V) and automatically works with a standard modular 
power cord when connected to an AC receptacle in any 
country. 

Power Switch

The Power switch applies power to the D-Control Main Unit.

Footswitch Jack

The footswitch jack on the back panel of the D-Control Main 
Unit is a 1/4-inch TRS jack that supports two footswitch con-
nections. See “Footswitch Connections” on page 34.
Keyboard/Trackball USB Connector

The USB connector on the back panel of the D-Control Main 
Unit links the computer keyboard and trackball on the Main 
Unit to the Pro Tools system. See “USB Connections” on 
page 34.

Ethernet Connector

The Ethernet connector on the back panel of the D-Control 
Main Unit provides communication to Pro Tools. See “Ether-
net Connections” on page 33.

XMON Monitoring System Connector

The 15-pin connector on the back panel of the D-Control 
Main Unit provides remote control of all audio monitoring 
functions from the D-Control Monitoring section. See 
“XMON Monitoring System Connection” on page 35.
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D-Control Fader Module
Fader Module Top Panel
D-Control Guide10
Figure 5.  D-Control Fader Module top panel
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Meter Section

The Meter section on the D-Control Fader Module can display 
track levels, plug-in meters, and other parameters depending 
on D-Control metering preferences. See “Meter Displays 
(Fader Module)” on page 125.

Channel Strip

Each channel strip on the D-Control Fader Module has iden-
tical channel controls, including six touch-sensitive rotary en-
coders, display and mode controls, and a touch-sensitive 
fader. See “Channel Strips” on page 49.

Modifier Keys

Each D-Control Fader Module has a set of four switches in its 
lower left corner that duplicate the function of the Pro Tools 
computer keyboard modifiers. See “Modifier Key Switches” on 
page 56.
Fader Module Back Panel

AC Power

The AC Power connector accepts a standard AC power cable. 
The D-Control Fader Module is auto power-selecting (100V to 
240V) and automatically works with a standard modular 
power cord when connected to an AC receptacle in any 
country. 

Power Switch

The Power switch applies power to the Fader Module.

Ethernet Connector

The Ethernet connector on the back panel of the D-Control 
Fader Module provides communication to Pro Tools. See 
“Ethernet Connections” on page 33.



D-Control XMON Interface
D-Control monitoring is based on the XMON analog interface, which is remotely controlled from the D-Control 
monitoring section.

XMON Front Panel
Figure 6.  XMON front panel

Power
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MIDI Receive
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Mute
indicator

Mute button
Power Switch

The Power switch applies power to the XMON Interface.

Mute Indicator

The Mute indicator shows the mute status of XMON. 
MIDI Receive Indicator 

The MIDI Receive indicator shows MIDI activity between 
XMON and D-Control. 

Mute Button

The Mute button mutes all XMON outputs. It is not possible 
to unmute XMON with this button. The XMON mute state 
can only be cleared from the D-Control Monitor section (see 
“Monitor Section Controls” on page 115).
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XMON Back Panel
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The back panel of the XMON interface includes connectors for all external analog audio inputs and outputs for D-Control. See 
“Audio Connections” on page 35.
Figure 7.  XMON back panel
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Part II: Installation





Chapter 3: Setting Up D-Control

This chapter explains how to set up 16-fader (Main Unit plus one Fader Module) and 32-fader D-Control systems (Main Unit plus 
two Fader Modules). 

D-Control Stand

(16-Fader and 32-Fader Systems)
The stand configurations for 16-fader and 32-fader systems have similar assembly procedures and the same number of parts (the 
crossbar and support rails are longer for a 32-fader system). 

Figure 1.  Assembled D-Control stand 
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Stand Components
D-Control Guide16
Unpack the stand and confirm that you have all of the necessary parts. Figure 2 shows the metal parts of the stand. Figure 3 shows 
the plastics parts of the stand. Set the plastic parts aside to protect them from damage during initial assembly. 
Figure 2.  D-Control metal stand parts

Left leg assembly Right leg assembly Rear crossbar assembly

Front pan support rail

Rear pan support rail
Figure 3.  D-Control plastic stand parts

Left and right side caps

(2) Leg front caps

(2) Leg rear caps



Stand Hardware
The following hardware is provided with the D-Control stand (spare pieces may be included). 
Figure 4.  D-Control assembly hardware for metal and plastic parts

1/4-inch-20 x 1/2-inch button head cap screw

1/4-inch-20 x 1/2-inch socket head cap screw M6 x 8mm Phillips pan head screw

#10-32 x 1/2-inch socket head cap screw

#10-32 x 1-inch socket head cap screw

#10-32 x 3/4-inch socket head cap screw

1/2-inch roll pin

#10 x 3/4-inch Phillips pan head screw

#6-32 x 7/16-inch Phillips pan head machine screw
Hardware for Metal Stand Parts

• (14) 1/4-inch-20 x 1/2-inch button head cap screws

• (10) 1/4-inch-20 x 1/2-inch socket head cap screws

• (22) M6 x 8mm Phillips pan head screws

• (8) 1/2-inch-20 x 1-inch socket head cap screws 
for leveling the stand (not pictured)

• (3) 1/2-inch roll pins

Hardware for Plastic Stand Parts

• (3) #10-32 x 1/2-inch socket head cap screws

• (4) #10-32 x 3/4-inch socket head cap screws

• (26) #10-32 x 1-inch socket head cap screws

• (8) #10 x 3/4-inch Phillips pan head screws

• (3) #6-32 x 7/16-inch Phillips pan head machine screws

Cabling Accessories

• (14) cable tie mounts

• (8) screw mount cable ties

• (14) cable ties

• (4) Velcro rip ties

• (10) #8 x 1/2-inch self-tapping screws (for use with rip 
ties and screw mount cable ties)
Tools for Assembling the Stand

The following tools are included with D-Control:

• 5/32-inch hex driver (for button head cap screws)

• 3/16-inch hex driver (for socket head cap screws)

• 3/8-inch hex driver (for stand leveling screws)

The following additional tools are required to assemble the 
D-Control stand:

• #2 Phillips screwdriver (for large Phillips head screws)

• #1 Phillips screwdriver (for small Phillips head screws)

• small hammer (for 1/2-inch roll pins)

The following tools are optional, but will help with assembly:

• rubber mallet for adjusting the stand

• ratcheting nylon strap for closing up the stand
Chapter 3: Setting Up D-Control 17



Placement of D-Control

In planning the placement of your D-Control, make sure to 
account for the dimensions of the assembled system, allowing 
for at least 1 inch (2.5 cm) of open space behind the finished 
unit. This meets the ventilation requirements for the D-Con-
trol units.

For detailed dimensional information, see “Mechanical Speci-
fications” on page 5.

When assembling the unit, you will need additional clearance 
on either side of the unit to push the sides of the stand to-
gether in the final steps of assembly. You will also need access 
to the rear of the unit to make cable connections.
D-Control Guide18
Preparing the Stand Legs

Before assembling the D-Control stand, make sure the floor in 
the installation space is level and the areas directly under the 
legs are flat. 

Each stand leg has three holes for leveling screws in its base, 
which can be used to fine-tune the leveling of the unit.

If you are placing the unit on a cement or hardwood floor, you 
can apply adhesive-backed rubber pads (included) to the bot-
toms of the legs to protect the floor and help level the stand. 
If you are using the leveling screws, you can place rubber pads 
directly under the screws to further protect the floor. 

Figure 5.  Location of leveling screws

Figure 6.  Applying rubber pads to bottom of D-Control leg

(3) 1/2-inch–20 x 1-inch socket head cap screws



Assembling the Stand
After you have prepared the installation space for D-Control, begin by assembling the metal parts of the stand. 

To assemble the stand:

1  Place the right and left leg assemblies upright, and at the approximate width of the rear crossbar assembly. Position the legs so 
that their crossbar mounting brackets are on the insides of the legs, facing each other as in Figure 7. 

2  Lift the rear crossbar assembly into position and slide it onto the crossbar mounting bracket on each leg. (The two sides of the 
crossbar are identical, so it does not matter which side faces front.) Position the legs so there is a small gap between the sides of 
the crossbar and the inner surface of each leg. The screw holes in the brackets should be visible in the slots on the crossbar. 

It is important that you first build the stand slightly wider than its final dimensions, and leave all screws loose enough to 
allow the stand legs to move side-to-side relative to the rear crossbar and rails. After you install the D-Control units on the 
stand, you will then slide the leg assemblies inward and tighten all screws.

Figure 7.  D-Control stand legs positioned with crossbar brackets facing each other

Figure 8.  Placing the rear crossbar assembly on the mounting bracket (left); Detail of gap between crossbar and leg (right)

Left stand leg

Right stand leg

Crossbar mounting brackets

Gap between crossbar and 
stand leg

Crossbar mounting
bracket
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3  Using a 5/32-inch hex wrench, attach the crossbar to the 
brackets with 1/4-inch-20 x 1/2-inch button head cap screws 
(see Figure 9), using 6 screws on each side (3 in front and 3 in 
back). Make sure to leave the screws loose enough so that the 
legs can be moved side-to-side relative to the rear crossbar.

4  Locate the rear pan support rail, which is the larger of the 
two rails provided with the stand. 

Figure 9.  Attaching the crossbar

Figure 10.  Side view of pan support rails

Rear pan

Front pan
support rail

support rail
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5  Position the rear rail so that the edge with the V-shaped 
notch points toward the left stand leg.

6  Lift the rear rail into place so that the rail rests on the rear 
rail tabs of the stand legs (see Figure 12). The holes on the ends 
of the rail should line up with the slots in the rear rail tabs on 
each leg. 

Figure 11.  V-shaped notch in rear pan support rail

Figure 12.  Rear support rail in place on left stand leg

Notch indicating left side of rear pan support rail



7  Using a 3/16-inch hex wrench, attach the rear rail to the rail 
tabs on each leg from below with 1/4-inch-20 x 1/2 inch 
socket head cap screws (see Figure 13), using 2 screws in each 
side. Make sure to leave the screws loose enough so that the 
leg assemblies can be moved side-to-side relative to the rear 
rail.

8  Locate the front pan support rail, which is the smaller of the 
two rails provided with the stand.

9  Position the front rail so that the edge with the V-shaped 
notch points toward the left stand leg.

Figure 13.  Attaching support rail from below

Figure 14.  V-shaped notch in front pan support rail

Notch indicating left side of front pan support rail
10  Lift the front rail into place so that the rail rests on the 
front rail tabs of the stand legs. The holes on the ends of the 
rail should line up with the slots in the front rail tabs on each 
leg. 

11  Using a 3/16-inch hex wrench, attach the front rail to the 
rail tabs on each leg from below with 1/4-inch-20 x 1/2 inch 
socket head cap screws, using 2 screws in each side. Make sure 
to leave the screws loose enough so that the leg assemblies can 
be moved side-to-side relative to the front rail.

With the rear crossbar, rear support rail and front support rail 
in place (see Figure 15), you are now ready to install the 
D-Control units on the stand. 

Figure 15.  Front and rear support rails in place on left stand leg
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Installing D-Control Units
After the stand has been assembled, the next step is preparing 
the D-Control Main Unit and Fader Modules for installation. 

Attaching the Spacer Plate

A metal spacer plate goes between each D-Control unit on the 
D-Control stand.

A spacer plate is pre-installed on the right side of each Fader 
Module. Depending on the size and configuration of your 
D-Control system, you may need to move the plate from one 
of the Fader Modules to the Main Unit. Refer to the section be-
low for your system configuration. 

16-Fader System

If you are building a 16-fader D-Control, you can place the 
Main Unit either to the left or to the right of the Fader 
Module. 

If you are placing the Main Unit to the left of the Fader 
Module, you need to move the spacer plate from the Fader 
Module to the Main Unit. Refer to “Moving the Spacer Plate” 
on page 23 before installing the units on the stand. 

If you are placing the Main Unit to the right of the Fader 
Module, you can use the spacer plate on the Fader Module as 
pre-installed. Proceed to “Installing the Units on the Stand” 
on page 24. 

Figure 16.  D-Control spacer plate (removed from a Fader Module)

Figure 17.  16-channel configurations

MainFader

Main Fader

16-fader system, Main on right

16-fader system, Main on leftFader
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32-Fader System

If you are building a 32-fader D-Control, you can place the 
Main Unit to the left, to the right, or in between the two Fader 
Modules. 

If you are placing the Main Unit to the left or in between the 
two Fader Modules, you need to move the spacer plate from 
the far-right Fader Module to the Main Unit. Refer to “Moving 
the Spacer Plate” on page 23 before installing the units on the 
stand.

If you are placing the Main Unit to the right of the two 
Fader Modules, you can use the spacer plates as pre-installed 
on the Fader Modules. Proceed to “Installing the Units on the 
Stand” on page 24.

Figure 18.  32-channel configurations

MainFader

MainFader

Main Fader Fader
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Moving the Spacer Plate

When installing any Fader Modules on the right of the Main 
Unit, you will need to remove the spacer plate and its screws 
from the far right Fader Module and place them on the right 
side of the Main Unit. 

To move the spacer plate:

1  Remove the screws holding the spacer plate in place. Make 
sure to note the location of the longer screws (2 in the front 
and 5 in the back) as you remove them. 

2  Remove the spacer plate from the right side of the Fader 
Module. 

3  Remove the corresponding screws from the right side of the 
Main Unit, and save them for the Fader Module.

4  Position the spacer plate on the right side of the Main Unit, 
and attach it in place with the screws that originally held it on 
the Fader Module. Make sure to note the location of the longer 
screws.

5  Place the remaining screws in the side of the Fader Module. 
Make sure to note the location of the longer screws.

Do not use a power screwdriver or similar high-torque 
device to remove and replace the screws for the spacer 
plate, as it might strip the threads in the screw housing.

Figure 19.  D-Control spacer plate (removed from a Fader Module)

Figure 20.  Removing the spacer plate from a Fader Module

The holes on the spacer plate are countersunk for instal-
lation on the right side of a unit. Do not attach the spacer 
plate to the left side of any D-Control unit.

long screws (5)

long screws (2)
Leveling the Pins on the Rightmost Unit

Fader Modules and Producer’s Desks ship with two pins in 
their right side to help anchor the units together on the stand. 
(These pins are not needed on the rightmost unit in your con-
figuration, and can be removed.)

To level the roll pins on the rightmost unit:

1  Identify the unit that will occupy the rightmost position in 
your configuration. 

2  Use a small hammer to tap in the two pins the right side of 
until they are flush with the side of the unit. (There is no stop 
inside the pin rails, so you will be able to install new pins if 
you expand your system later.)

Figure 21.  Installing the roll pin in the top of a D-Control unit

Figure 22.  Installing the roll pin in the front of a D-Control unit

Top roll pin
location

Front roll pin
location
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Installing the Units on the Stand

After the D-Control Main Unit and Fader Modules are pre-
pared for installation, the units are placed on the stand in the 
appropriate order for your configuration. Install the units 
from left to right on the stand.

To install the D-Control units on the stand:

1  Lift the first unit into place on the stand so the channels in 
the bottom of the unit go over the rear and front rails of the 
stand. 

2  Slide the unit to the left side of the stand, leaving a gap of 
about an inch (2 cm) between the side of the unit and the 
flange on the inside of the stand.

Figure 23.  Placing a Fader Module on the stand

Figure 24.  Leaving a gap between the unit and stand
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3  Lift successive units into place on the stand, being careful 
not to bend the pins in the units you installed previously.

4  Slide the units together, guiding the pins in each unit into 
the corresponding holes in the side of the next unit. 

5  Attach the units to the front and rear rails from below with 
M6 x 8mm Phillips pan head screws, using a total of 6 screws 
for the Main Unit (3 each in the front and rear rails) and a total 
of 4 screws for the Fader Module (2 each in the front and rear 
rails). Make sure to leave these screws loose enough so that the 
units can still move side-to-side relative to the rails.

Figure 25.  Attaching a unit to the rails from below



Closing Up the Stand

Next, you will close up the stand and finish attaching the 
units.

To close up the stand:

1  Move the stand legs together to completely close the gap be-
tween the stand and the outer units. (You may want to tap the 
base of the legs with a rubber mallet to help move them into 
place.)

2  Use a ratcheting nylon strap to compress the stand legs to-
gether.

3  If there is still any gap between the rear crossbar assembly 
and either of the legs, position the crossbar so that the gap is 
equal on both sides.

4  Tighten the 6 button cap screws on each side of the rear 
crossbar.

5  If necessary, use the ratcheting nylon strap to compress the 
D-Control units together by running the strap around the top 
part of the legs and across the D-Control units as shown in 
Figure 27. Make sure the nylon strap does not contact any 
switches or encoders on the surface. 

Figure 26.  Using a nylon strap on the stand legs
6  Tighten the 2 socket head cap screws on each side of the 
front and rear rails from below.

7  Attach the outside (rightmost and leftmost) units to the 
flanges on the legs from below with M6 x 8mm Phillips pan 
head screws. Tighten these screws. 

8  Tighten the Phillips pan head screws that attach the D-Con-
trol units to the front and rear rails from below.

9  Remove the nylon strap.

Figure 27.  Using a nylon strap on the D-Control units

Figure 28.  Attaching a unit to the leg flanges (view from below)

(2) M6 x 8mm Phillips pan head screws
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Installing the Plastic Side Caps

With the D-Control units in place and attached to the stand 
rails, you are now ready to install the plastic side caps. 

To install the plastic side caps:

1  On each side of the system, locate the pair of #6-32 machine 
screws, arranged one above the other, near the front of each 
unit. Remove the lower of the two screws from each side of the 
unit.

2  Locate the two small blue rubber meter break caps and in-
stall them in the inside of the plastic side caps.

Do not use a power screwdriver or similar high-torque 
device to attach the plastic side caps, as it may distort 
or damage the caps.

Figure 29.  Removing the machine screw from a unit

Figure 30.  Installing a meter break cap in a plastic side cap

Remove this screw
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3  Place the plastic side caps over each side of the unit, starting 
by hooking the front of each cap around the front part of the 
stand leg, then sliding the cap backward into place. The holes 
on the cap should line up with holes on the stand. 

4  Attach each plastic side cap with the screws indicated in Fig-
ure 32. Leave the screws loose until you have placed all of the 
screws, then go back and tighten all of the screws carefully. 

Figure 31.  Placing a plastic side cap on the stand

Figure 32.  Attaching the plastic side caps

(6) #10-32 x 1-inch socket head cap screws

(3) #10 x 3/4-inch Phillips pan head screws

(1) #6-32 x 7/16-inch Phillips pan head
machine screw



Installing the Plastic Leg Caps

You can install the D-Control plastic leg caps at any time. 

To install the plastic leg caps:

1  Place the front leg caps over each leg. Attach each front cap 
with the screws indicated in Figure 34. 

2  Place the rear leg caps over each leg. Attach each rear cap 
with the screws indicated in Figure 35. 

To protect the plastic leg caps from damage, install them 
last, after you have finished installing and configuring 
any other D-Control components and moved the system 
into place. If necessary, continue with other installations 
and return to these steps when you are finished.

Figure 33.  Plastic leg cap placement

Figure 34.  Attaching the plastic front leg caps

Figure 35.  Attaching the plastic rear leg caps

(2) #10-32 x 3/4-inch socket head 

(1) #10-32 x 1/2-inch socket head

cap screws

cap screw

(2) #10-32 x 1-inch socket head 
cap screws

(3) #10-32 x 1-inch socket head cap screws
Installing a Video Display
D-Control gives you two options for using a video display:

Free-Standing Display The display shelf on D-Control can sup-
port a free-standing flat screen display. 

Arm-Mounted TFT Display Using the video display arm in-
cluded with the Main Unit, you can mount a TFT-type display 
on D-Control.

General instructions for installing each display are given in 
the following sections. For details on setting up a particular 
display, refer to the manufacturer’s instructions.

Installing a Free-Standing Display

The display shelf on the D-Control Main Unit can support a 
free-standing flat screen display (such as an Apple Cinema dis-
play) up to a 20-inch screen size. (Larger displays may obstruct 
the view of the meter bridge on the Main Unit.) 

To install a free-standing display:

1  Remove the display shelf panel from the Main Unit.

Figure 36.  Removing the display shelf from the Main Unit 
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2  Replace the mounting post housing on the underside of the 
display shelf panel with the provided cover plate. 

3  Run the display cabling through the cable port in the dis-
play shelf panel.

4  Route the display cabling down through the Main Unit and 
through the cable port in the bottom of the Main Unit. (You 
may need to remove a panel covering this cable port.)

5  Replace the display shelf panel on the Main Unit.

6  Place the display on the display shelf. 

Figure 37.  Mounting post housing (back of display shelf panel)

Figure 38.  Cable port in bottom of Main Unit (view from below)
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Installing an Arm-Mounted TFT Display

The articulated video display arm included with the D-Con-
trol Main Unit can support a VESA-style display that weighs 
up to 20 pounds (9 kg). 

To install an arm-mounted TFT display:

1  Mount the video display on the display arm assembly ac-
cording to the manufacturer’s instructions. 

2  Discard the mounting post included with the monitor arm 
assembly. A correctly sized replacement post is included with 
the D-Control Main Unit. 

3  Install the new mounting post in the Main Unit. Note the 
orientation of the post (the side with the longer slot faces the 
back of the unit). 

4  Run the display cabling through the cable port behind the 
mounting post housing (you many need to remove the dis-
play shelf to route any connectors through the port). 

5  Route the display cabling down through the Main Unit and 
through the cable port in the bottom of the Main Unit. (You 
may need to remove a panel covering this cable port. See Fig-
ure 38.)

6  Place the display arm collar over the mounting post assem-
bly. Do not tighten the set screw for the collar.

The video display arm is packaged separately and includes 
hardware that is not needed for D-Control. The 
arm-mounting hardware is pre-installed in the bottom of 
the Main Unit.

Figure 39.  Installing the mounting post in the Main Unit



7  Place the display arm assembly on the mounting post as-
sembly.

8  Adjust the display arm collar so that its stops prevent the 
arm assembly and video display from hitting the D-Control 
meter bridge. In most cases, the setscrew should not go into 
the hole in the mounting post assembly, but should be 
slightly to the right of the hole and the cable port as shown in 
Figure 41. 

9  Tighten the setscrew to fix the collar in place. 

Figure 40.  Placing the arm assembly on the mounting post

Figure 41.  Detail of display arm collar and setscrew
10  Insert the top cap/threaded rod in the mounting post as-
sembly and tighten it with the provided wrench.

Figure 42.  Attaching the arm assembly with the top cap/threaded rod 

Figure 43.  Installed arm mount assembly and video display
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Mounting D-Control Cables (Optional)
Three different kinds of cable ties are provided with D-Con-
trol. 

Velcro Rip Ties These ties can be affixed to the D-Control 
stand legs. Two pre-drilled holes inside each leg accept #8 x 
1/2-inch self-tapping screws. 

Screw-Mount Ties These ties can be affixed to the D-Control 
stand legs with the #8 x 1/2-inch self-tapping screws.

Adhesive-Backed Ties These self-sticking tie mounts let you 
place cable ties anywhere on the D-Control unit, and can be 
used to dress cables or to mount an Ethernet hub under the 
unit. 

Reconfiguring the D-Control Keyboard 
for a Windows System
The computer keyboard on the D-Control Main Unit ships 
with a Mac keyboard configuration. 

If you will be using D-Control with a Windows-based 
Pro Tools system, you will need to reconfigure the computer 
keyboard.

To reconfigure the D-Control computer keyboard for Windows:

1  Using a 5/64-inch hex wrench, remove the screws in the 
computer keyboard panel and detach it from the D-Control 
Main Unit.

2  Locate the switch on the printed circuit board under the 
keyboard and move it to the opposite position. 

3  Remove the two Apple Command ( ) keys from either side 
of the Spacebar on the alpha keyboard. 

4  Move the Alt/Option keys inward to replace the Apple Com-
mand keys. 

Figure 44.  Removing the computer keyboard from the Main Unit
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5  Install the included Start (or “Windows”) keys to replace the 
Alt/Option keys.

6  Remove the Equals (=) key, also called “Capture” key, from 
the numeric keypad. 

7  Move the Slash (/) key, also called the “Enter Start End 
Length” key, to replace the Equals key. 

8  Move the Asterisk (*) key, also called the Enter Main Counter 
key, to replace the Slash key. 

9  Move the Minus (–) key to replace the Asterisk key. 

10  Remove the Plus (+) key and install the included dou-
ble-sized plus key to replace the old Plus and Minus keys.

11  Replace the computer keyboard panel on the D-Control 
Main Unit and reattach its screws. 

Figure 45.  Windows keys in place on alpha keyboard

Figure 46.  Windows keys in place on the numeric keypad



Moving the Keyboard and Trackball 
(Optional)
You can move the trackball on the D-Control Main Unit to the 
left of the computer keyboard. 

To move the keyboard and trackball:

1  Using a 5/64-inch hex wrench, remove the screws in the 
computer keyboard panel and the trackball panel on the 
D-Control Main Unit.

2  Exchange the position of the trackball and keyboard panels, 
and carefully rearrange their cables underneath the panels.

3  Reattach the computer keyboard and trackball panels to the 
Main Unit.

Replacing the Trackball with an 
External Trackball or Mouse (Optional)
If you prefer to work with your own trackball or mouse, you 
can remove the D-Control trackball from the D-Control Main 
Unit and replace it with the provided blank plate, and place 
your USB-compatible trackball or mouse on top of the blank 
plate.

To remove the trackball:

1  Using a 5/64-inch hex wrench, remove the trackball plate 
on the D-Control Main Unit.

2  Disconnect the Molex plug from the P1 connector on the 
printed circuit board on the bottom of the trackball plate.

3  Disconnect the Molex plug that comes from under the 
D-Control keyboard from the trackball assembly. 

4  Remove the screws holding the printed circuit board to the 
trackball plate. Set the D-Control trackball plate aside.

5  Locate the blank plate and install the printed circuit board 
on the underside of the blank plate.

Figure 47.  Trackball located on left side of keyboard on the Main Unit
6  Locate the USB connector on the printed circuit board, and 
connect your trackball or mouse to it.

7  Connect the Molex plug you disconnected in Step 3 to the 
P2 connector on the printed circuit board. Make sure you fit 
the connector and plug together correctly (so that the plug 
snaps into place) to maintain polarity of this connection. 

8  Route the cable of your trackball or mouse through the slot 
in the blank plate. 

9  Attach the blank plate to the Main Unit.

Reinstalling the Trackball

If you need to reinstall the factory trackball on a D-Control 
Main Unit, carry out the following procedure.

To replace the trackball:

1  Using a 5/64-inch hex wrench, remove the blank plate from 
the Main Unit.

2  Disconnect the Molex plug from the P2 connector on the 
printed circuit board. 

3  Disconnect the external trackball or mouse from the USB 
connector on the printed circuit board.

4  Remove the screws holding the printed circuit board to the 
bottom of the blank plate. Set the blank plate aside.

5  Locate the D-Control trackball plate and install the printed 
circuit board on the underside of the trackball plate.

6  Connect the Molex plug that runs from the D-Control track-
ball assembly to the P1 connector on the printed circuit board. 
Make sure you fit the connector and plug together correctly 
(so that the plug snaps into place) to maintain polarity of this 
connection.

7  Connect the Molex cable that comes from under the D-Con-
trol keyboard to the connector on the D-Control trackball as-
sembly. 

8  Reattach the trackball plate to the Main Unit. 
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Chapter 4: Connecting D-Control

D-Control Connections
D-Control units require power, Ethernet and USB connections to operate with Pro Tools. An optional footswitch connection is 
also available on the Main Unit. The connectors on the back panel of the D-Control Main Unit are shown in Figure 48. 

Be sure to make all connections with your D-Control units and computer turned off. 

Figure 48.  D-Control Main Unit back panel connectors

Footswitch jack

Keyboard/Trackball
USB connector

Ethernet connector

XMON Monitoring System connector
Power Connections

Each D-Control unit (Main Unit and Fader Modules) and the 
XMON Monitor Interface requires its own power connection. 
D-Control Main Units, Fader Modules, and XMON Interfaces 
are auto power-selecting (100V to 240V) and automatically 
work with a standard modular power cord when connected to 
an AC receptacle in any country. A power cable is provided 
with each D-Control unit and the XMON interface. 

To make D-Control power connections: 

For each D-Control unit and the XMON Interface, connect 
the included AC power cord the unit and to a power source. 
Ethernet Connections

Each D-Control unit communicates with Pro Tools using 
Ethernet. An Ethernet cable is included with each D-Control 
unit. A 10-BaseT Ethernet hub (not included) is required to 
connect D-Control units to the host computer. 

To make D-Control Ethernet connections:

1  Install the Ethernet hub according to its instructions, apply 
power to it, and verify that it is functioning properly.

2  Connect the Ethernet hub to the Ethernet port on your 
computer. 

3  For each D-Control unit, connect one end of the supplied 
Ethernet cable to a port on the Ethernet hub, and the other 
end to the Ethernet port on the back of the unit. Do not use 
any port labelled for LAN connections.

Connection sequence to the Ethernet hub does not mat-
ter, because the order of the units can be configured 
from within Pro Tools.
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Using D-Control on an Ethernet Network

You can purchase a combined 10/100-BaseT Ethernet hub that 
can simultaneously support D-Control over 10-BaseT and 
other network traffic over 100-BaseT. This will allow you to 
use D-Control over a local area network.

Moderate network traffic (such as e-mail) should not affect 
communication between D-Control and the computer. If your 
network experiences heavy traffic, you may want to create a 
dedicated Ethernet network for D-Control.

Controlling Pro Tools Systems Over a Network

When D-Control is connected to an Ethernet network, it will 
be available to be declared by any Pro Tools system on that 
network. This lets you control different Pro Tools systems on 
the network with a single D-Control console. (You can only 
control one Pro Tools system at a time.)

USB Connections

The computer keyboard and trackball on the D-Control Main 
Unit use a USB connection to communicate with the host 
computer. A USB cable is required (not included). 

The D-Control USB connection supports the use of a USB hub, 
if your system has one. A powered USB hub is not required. 

To make the D-Control USB connection:

Connect one end of a USB cable to the USB port on the back 
panel of the D-Control Main Unit, and the other end to the 
USB port on the computer or USB hub. 
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Footswitch Connections

You can connect two SPST (single-pole, single-throw) foot-
switch units to the D-Control Main Unit to control any of the 
following functions:

• Starting and stopping Pro Tools playback

• Starting Pro Tools recording

• Toggling Talkback on and off

The footswitch connector is a single 1/4-inch TRS jack on the 
back panel of the D-Control Main Unit. 

To wire a TRS connector for the D-Control footswitch jack:

Use the following wiring convention: Tip = Footswitch 2, 
Ring = Footswitch 1, Sleeve = Ground.



Audio Connections
D-Control monitoring is based on the XMON analog interface, which is remotely controlled from the D-Control monitoring sec-
tion. All external analog audio inputs and outputs for control room monitoring and studio communication are connected to the 
XMON interface. 

XMON provides 18V phantom for its three external mic inputs (External Talkback Mic, Listen Mic 1, Listen Mic 2). 

All audio connections are made with standard DB-25 connectors. The back panel of the XMON is shown in Figure 49. 

XMON Monitoring System Connection

D-Control connects to XMON with a single 15-pin cable. A 50-foot (15.25 m) cable is included with the D-Control Main Unit. 
The system supports up to an 80-foot (24.5 m) cable. 

To connect the XMON to D-Control:

1  Connect the included AC power cord to the back panel of the XMON and to a power source. A surge protected power source 
is highly recommended. 

2  Connect one end of the included XMON cable to the Control Surface port on your XMON unit, and the other end to the 15-pin 
Control port on the back panel of the D-Control Main Unit.

Figure 49.  XMON back panel

Cue Inputs

Cue Outputs
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Control Room Monitoring Connections

Inputs

• Main Inputs (8 channels), balanced, +4 dBu (from Pro Tools)

• Surround Inputs (8 channels), balanced, +4 dBu

• Stereo 1 Inputs (2 channels), balanced, +4 dBu/–10dBV

• Stereo 2 Inputs (2 channels), balanced, +4 dBu/–10dBV

• Stereo 3 Inputs (2 channels), balanced, +4 dBu/–10dBV

• Stereo 4 Inputs (2 channels), balanced, +4 dBu/–10dBV

• AFL/PFL Inputs (2 channels), balanced, +4 dBu 

• Listen Mic 1 (external), mic level (XMON provides 18V phantom power)

• Listen Mic 2 (external), mic level (XMON provides 18V phantom power)

Outputs

• Main Control Room Outputs (8 channels), balanced or unbalanced, +4 dBu

• Alt Control Room Outputs (8 channels), balanced or unbalanced, +4 dBu

• Mini Control Room Outputs (2 channels), balanced or unbalanced, +4 dBu

Figure 50.  Control room monitoring system block diagram
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Headphone/Cue System Connections

Inputs

• Main Monitor Input (2 channels)

• Cue 1 Input (2 channels), balanced, +4 dBu

• Cue 2 Input (2 channels), balanced, +4 dBu

• Cue 3 Input (2 channels), balanced, +4 dBu

• Internal Talkback Mic (from internal mic)

• External Talkback Mic, mic level (XMON provides 18V phantom power)

Outputs

• Cue 1 (2 channels), +4 dBu

• Cue 2 (2 channels), +4 dBu

• Cue 3 (2 channels), +4 dBu

• Headphone (2 channels), to internal headphone jack

• Studio Loudspeaker (2 channels)

Figure 51.  Headphone/Cue system block diagram
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• Talkback/Slate Output (1 channel)
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Example XMON Wiring Diagram
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The following diagram shows basic XMON connections for a Pro Tools|HD system with a Digidesign 192 I/O with 16 analog out-
puts (with a 192 AD card installed). 

Figure 52.  Wiring diagram for 192 I/O and XMON

Analog Outputs 1-8 Analog Outputs 9-16

Cue Inputs Main Inputs

Main OutputsCue Outputs Talkback/ListenbackAlt Outputs

Analog Outputs 1-8

1-2: Studio
3-4: Cue 1
5-6: Cue 2
7-8: Cue 3

1 = L
2 = Lc
3 = C
4 = Rc
5 = R
6 = Ls
7 = Rs
8 = LFE

1 = L
2 = Lc
3 = C
4 = Rc
5 = R
6 = Ls
7 = Rs
8 = LFE

1 = Ext Talkback Mic Input
2 = Listen Mic 1 Input
3 = Listen Mic 2 Input
4 = AFL Input 1
5 = AFL Input 2
6 = Mini Speaker Out 1 (L)
7 = Mini Speaker Out 2 (R)
8 = Talkback/Slate (Out)

To 
Cue System
Amplifiers

To 
Main

Speakers

To 
Alternate
Speakers

To 
Various
Inputs
and

Outputs

DB-25 to DB-25
connectors

DB-25 to XLR
snakes

192 I/O

XMON



Chapter 5: Configuring D-Control
Starting Up and Shutting Down the 
System
Your D-Control-based system must be started up and shut 
down in a specific order.

Start your D-Control-based system in this order:

1  Turn on external hard drives first. Wait 10 to 15 seconds for 
them to come up to speed. 

2  Turn on the D-Control units. 

3  If you plan to work with MIDI equipment, turn on MIDI in-
terfaces and other MIDI devices. 

4  Turn on all Pro Tools audio interfaces. 

5  Turn on the computer. 

6  Turn on the XMON interface.

7  Turn on monitor amplifiers or self-powered speakers.

Shut down your D-Control-based system in this order:

1  Turn off monitor amplifiers or self-powered speakers.

2  Turn off the XMON interface.

3  Turn off all Pro Tools audio interfaces.

4  Shut down the computer.

5  If using MIDI equipment, turn off MIDI interfaces or con-
trollers. 

6  Turn off the D-Control units. 

7  Turn off external hard drives.

Software Configuration
All D-Control software is included when Pro Tools software is 
installed. The Pro Tools software installer places the D-Con-
trol Personality folder on the system drive.

Refer to the Getting Started Guide that came with your system 
for instructions on installing or updating Pro Tools software. 
Updating System Firmware

Each release of Pro Tools software includes the most current 
D-Control firmware. When you declare a D-Control unit in 
the Pro Tools Peripherals dialog, Pro Tools compares the firm-
ware of all connected units to the version available in 
Pro Tools software, and prompts you if an update is available.

If you are prompted to update firmware, follow the on-screen 
instructions to load the latest firmware to each D-Control 
unit. 

Declaring D-Control Units in Pro Tools

Communication between D-Control and Pro Tools is config-
ured from Pro Tools.

To declare D-Control units in Pro Tools:

1  Choose Setups > Peripherals, and click Ethernet Controllers. 

2  Select Enable. Pro Tools scans the Ethernet connection for 
any D-Control units connected to the system.

3  Select the units in order as you want them arranged left to 
right. 

Ethernet Controllers display in the Peripherals dialog

It is not necessary to declare units in the same sequence 
as they are physically arranged in the D-Control stand. 
You can set a Pro Tools system to use D-Control units in 
any order, to fit your workflow. 
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As each unit is selected, Pro Tools scans and brings it online. 
The current status of each unit is indicated in the Peripherals 
dialog in the following ways:

• Bold indicates a connected unit.

• Italics indicate an offline or disconnected unit. 

• Underlining indicates that the selected unit is in use by 
another Pro Tools system.

4  After enabling all units, click OK to close the Peripherals 
window.

When communication is established, Pro Tools displays col-
ored outlines identifying each bank of Pro Tools tracks. 

The colors in each unit row are used to identify controller fo-
cus on-screen in Pro Tools. The bank, track, insert, send, or 
other element currently the focus of D-Control is outlined in 
the color associated with each unit. 

Naming D-Control Units in Pro Tools

You can set the names for D-Control units from Pro Tools. 

To name D-Control units in Pro Tools:

1  Choose Setup > Peripherals, and click Ethernet Controllers. 

2  Click Name Units.

3  Enter the names for the units and click OK. 

You can also set the names for D-Control Main Units and 
Fader Modules directly from the units themselves, by using 
Utility mode. For details on naming D-Control units in Utility 
mode, see “D-Control Name Page” on page 158.

Setting D-Control Preferences
This section describes the settings and preferences for D-Con-
trol that are set directly from the control surface. For details on 
preferences that are set from Pro Tools, see the Pro Tools Refer-
ence Guide.

Naming D-Control units
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Fader, Encoder and Switch Preferences

The following settings and preferences affect operation of the 
faders, encoders, and switches on D-Control.

Fader Bank Justification

The Bank Justification preference determines whether banks 
of channels in Normal mode are justified at the left, left center 
(to the left of the Main Unit), right center, (to the right of the 
Main Unit) or right side of the control surface.

To set bank justification: 

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes Bank Justification 
(“BnkJus”).

2  Press the Soft Key that corresponds to “BnkJus” to choose 
between the “Left,” “CenterL,” “CenterR,” and “Right” set-
tings. 

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Faders On/Off

The Faders On/Off preference lets you temporarily turn off 
D-Control faders to prevent fader movement when monitor-
ing a mix.

To toggle D-Control faders on and off:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Faders On/Off pref-
erence (“Faders”). 

2  Press the Soft Key that corresponds to “Faders” to toggle all 
faders on and off.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Touch Value

The Touch Value preference determines whether faders and 
encoders, when touched, temporarily show the value of the 
parameter they are controlling.

To toggle display of values on or off:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes Touch Value (“TchVal”).

2  Press the Soft Key that corresponds to “TchVal” to toggle 
value display On and Off.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.



Display of Slave Track Controls in VCA Master Track 
Encoders

If you don’t want to view or adjust slave track controls from 
the VCA Master channel strip, you can turn off the display of 
slave track controls in the encoders of VCA Master tracks. 

To toggle display of slave track controls in VCA Masters:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Encoder VCA dis-
play preference (“EncVCA”).

2  Press the Soft Key that corresponds to “EncVCA” to toggle 
the setting between “Yes” (display of slave track controls in 
encoders) and “No” (no display of slave track controls). 

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.

Display of Insert and Send Positions in Encoders

The Show Send/Insert Letters preference lets you display Send 
and Insert letters on send and insert positions with no assign-
ment.

Encoder and channel strip displays show Insert and Send in-
formation as follows:

With the Show/Send Insert Letters preference enabled, in-
serts with no assignments show only uppercase letters (A–J) in 
the corresponding positions.

With the Show/Send Insert Letters preference enabled, 
sends with no assignments show only lowercase letters (a–j) in 
the corresponding positions.

Inserts and Sends with assignments show only the Insert or 
Send name and no letters.

To enable display of Insert and Send letters:

1  In the Console Prefs Soft Keys section, press the Operation 
switch repeatedly to display the page that includes Show 
Send/Insert Letters (“Lettrs”).

2  Press the Soft Key that corresponds to “Lettrs” to toggle the 
setting between “On” and “Off.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.
Rotary Encoder Velocity Mode

The Rotary Encoder Velocity mode affects responsiveness of 
rotary encoder knobs. Fixed mode is at normal resolution. In 
Velocity Sensitive mode, acceleration can be set to slow, me-
dium or fast. In Fine mode, response is fixed at fine resolution.

To set the Rotary Encoder Velocity mode:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Rotary Encoder Ve-
locity Mode preference (“Rotary”). 

2  Press the Soft Key that corresponds to “Rotary” to choose be-
tween the “Fixed,” “Vel-Sl” (velocity-sensitive slow) “Vel-Md” 
(velocity-sensitive medium) “Vel-Fa” (velocity-sensitive fast) 
and “Fine” settings.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Pan on Lower Encoder

The Pan on Lower Encoder preference determines whether 
Pan controls are displayed on the bottom encoder of each 
channel, even when another type of control is displayed on 
the upper encoders. 

To set the Pan on Lower Encoder preference:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Pan on Lower En-
coder preference (“PanBot”). 

2  Press the Soft Key that corresponds to “PanBot” to toggle the 
setting between “Yes” and “No.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Encoder Order

The Encoder Order preference determines whether inserts, 
sends, and pan controls will be displayed in order from 
top-to-bottom or bottom-to-top on D-Control rotary encod-
ers.

To set the Encoder Order preference:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Encoder Order pref-
erence (“Encod”). 

2  Press the Soft Key that corresponds to “Encod” to toggle the 
setting between “Bot-Tp” (bottom-to-top ordering) and 
“Tp-Bot” (top-to-bottom ordering). 

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.
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Select Switch Latch Mode

The Select Switch Latch mode determines whether channel 
Select switches follow latching or exclusive-or (non-latching) 
behavior when in Select mode. 

To set the Select switch mode:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Select Switch Latch 
mode preference (“Select”). 

2  Press the Soft Key that corresponds to “Select” to toggle the 
setting between the “Latch” and “ExclOr” (unlatched) set-
tings.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Custom Fader Preferences

The following settings and preferences affect display of Cus-
tom Faders on D-Control. For more information on using Cus-
tom Faders, see Chapter 13, “Custom Fader Modes.”

Maximum Custom Fader Bank Size

The Maximum Custom Fader Bank Size preference determines 
the number of channels to be used when displaying tracks in 
the Left or Right Custom Fader bank. 

Custom Fader Bank Size is set independently for each category 
of Custom Fader modes (Plug-Ins, Groups, and Track Types). 

Options for bank size include 4, 8, 16, or 32 channels, up to 
the total number of channels on the D-Control system. You 
can choose settings for each of these sizes (indicated by the 
prefix “Min”) that use the minimum number of channels nec-
essary, so that the Custom Fader section dynamically resizes 
to match the number of channels in the group. 

LCFPI (Left CF Bank Size for Plug-ins) Determines the number 
of channels allocated for Custom Fader Plug-in mode in the 
Left Custom Fader section.

RCFPI (Right CF Bank Size for Plug-ins) Determines the num-
ber of channels allocated for Custom Fader Plug-in mode in 
the Right Custom Fader section.

LCFGrp (Left CF Bank Size for Custom Groups and Mix/Edit 
Groups) Determines the number of channels allocated for Cus-
tom Groups mode in the Left Custom Fader section.

RCFGrp (Right CF Bank Size for Custom Groups and Mix/Edit 
Groups) Determines the number of channels allocated for Cus-
tom Groups in the Right Custom Fader section.

LCFTyp (Left CF Bank Size for Track Type) Determines the 
number of channels allocated for Custom Fader Tracks mode 
in the Left Custom Fader section.
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RCFTyp (Right CF Bank Size for Track Type) Determines the 
number of channels allocated for Custom Fader Tracks mode 
in the Right Custom Fader section.

To set the maximum Custom Fader bank size:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Custom Fader Bank 
Size preferences. 

2  Do one of the following:

• To increment the number of channel strips, press the Soft 
Key that corresponds to the preference setting you want 
to change.

– or –

• To decrement the number of channel strips, hold Shift 
and press the Soft Key that corresponds to the preference 
setting you want to change.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Custom Fader Bank Justification

The Custom Fader Bank Justification preference determines 
the distribution of the two available Custom Fader banks on 
the control surface.

LCFJst (Left Custom Fader Justification) Determines whether 
the Custom Faders controlled by the left Custom Faders sec-
tion are placed at the left, left center, right center, or right of 
the Main Unit.

RCFJst (Right Custom Fader Justification) Determines whether 
the Custom Faders controlled by the right Custom Faders sec-
tion are placed at the left, left center, right center, or right of 
the Main Unit.

To set Custom Fader bank justification:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Custom Fader Bank 
Justification preferences (“LCFJst” or “RCFJst”):

2  Repeatedly press the Soft key that corresponds to “LCFJst” 
or “RCFJst” to choose between the “Left,” “CenterL,” “Cen-
terR,” and “Right” settings for the corresponding bank of Cus-
tom Faders.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.



Display of Hidden Tracks in Custom Faders

You can set D-Control to show hidden tracks in the Custom 
Fader views. You can then mix those hidden tracks, but you 
cannot select or record-enable them. Hidden track names are 
displayed in yellow in the Custom Faders.

To make hidden tracks visible in Custom Fader views:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes Custom Fader Tracks 
(“CFTrks”). 

2  Press the Soft Key that corresponds to “CFTrks” to toggle the 
setting between Show Hidden Tracks (“ShwHdn”) and Hide 
Hidden Tracks (“HidHdn”). 

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Custom Fader Plug-In Mode View Definitions

There are three view options available for display of plug-in 
parameters in the channel displays of the Custom Faders. 
These options, or view definitions, are accessible from the 
D-Control operation preferences. 

Name View Shows the track name, plug-in name and channel 
format of the currently focused plug-in in the channel dis-
plays of the Custom Faders. 

Expanded View Shows additional plug-in controls in the chan-
nel displays of the Custom Faders. This view can also be seen 
at any time by pressing and holding the Plug-In switch in the 
Custom Fader section until the switch flashes. See “Expanded 
Plug-In View” on page 154.

Fader View Maintains track names on channel displays and 
fader control of track volume while Custom Fader plug-in pa-
rameters are displayed in the channel encoders. Entering Ex-
panded view or Plug-In Map mode automatically exits Fader 
view. 

To set the Custom Fader Plug-In Mode view:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes Plug-In View Definitions 
(“LPIDef” and “RPIDef”). 

2  Repeatedly press the Soft key that corresponds to “LPIDef” 
or “RPIDef” to choose between the corresponding settings for 
the Plug-In Mode view.

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.
Focusing Plug-ins in Custom Fader Mode

You can set D-Control to focus plug-ins directly in Custom 
Faders Plug-In mode instead of focusing them channel strips.

To enable focusing of plug-ins in Custom Faders on D-Control:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes Channel Editing for 
Plug-Ins (“ChanPI”).

2  Press the Soft Key that corresponds to “ChanPI” to toggle 
the setting between “On” (to focus plug-ins on Custom Fad-
ers) and “Off” (to focus plug-ins in channel strips). 

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.

To focus a plug-in directly in Custom Faders:

1  Press the Inserts switch for the channel to display plug-in 
names on the channel’s encoders. Press the Page Up and Page 
Down switches on the channel to display additional plug-ins.

2  Press the encoder Select switch for the plug-in you want to 
focus.

The controls of the focused plug-in appear in Custom Fader 
Plug-In mode.

To focus a plug-in using the opposite mode from the current 
ChanPI setting:

Hold Control+Alt (Windows) or Command+Option (Mac) 
when pressing the encoder Select switch for a plug-in. 

Transport Mode Preference

D-Control can operate in Dual or Single Transport mode. Dual 
Transport mode activates the second set of transport controls 
in the section labeled “Machine Transport.” In Single Trans-
port mode, only the transport controls marked “Pro Tools 
Transport” are active.

To set the Transport mode:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Transport Mode 
preference (“Trnspt”). 

2  Press the Soft Key that corresponds to “Trnspt” to toggle the 
setting between “Dual” and “Single.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.
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Display Preferences

The following preferences affect the interaction of D-Control 
with on-screen display of elements in Pro Tools.

Target Track from Application

The Target Track from Application preference determines 
whether selecting an Insert or Send on-screen makes its track 
the focused track on the D-Control Main Unit. For details on 
focusing a track on D-Control, see “Focusing a Track” on 
page 131.

To set the Target Track from Application preference:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Application Target 
preference (“APTrgt”). 

2  Press the Soft Key that corresponds to “ApTrgt” to toggle the 
setting between “Yes” and “No.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Channel Window Display

The Channel Window display preference determines whether 
displaying plug-in or send pan parameters (by pressing an en-
coder Select switch) on D-Control opens the corresponding 
plug-in or send window on-screen in Pro Tools. This prefer-
ence also determines whether the Channel Select switches (in 
the Dynamics or EQ sections) change the channel display of 
multi-mono plug-ins.

When this preference is set to “Yes,” the on-screen display 
of plug-in and send windows changes to reflect the state of the 
control surface. 

When this preference is set to “No,” the on-screen display of 
plug-in and send windows does not change to reflect the state 
of the control surface. 

To set the Channel Window display preference:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Channel Window 
display preference (“ChanWn”). 

2  Press the Soft Key that corresponds to “ChanWn” to toggle 
this setting between “Yes” and “No.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.
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Meter Preferences

The following preferences affect operation of the meters on 
D-Control.

Send Meters On/Off

The Send Meters On/Off preference toggles send metering on 
and off. This preference applies when sends are displayed on 
the D-Control rotary encoders. This metering follows Send 
pre- or post-metering settings in Pro Tools.

To toggle send meters on and off:

1  In the Soft Keys section, press the Meter switch repeatedly to 
display the page that includes the Send Meters On/Off prefer-
ence (“SndMtr”).

2  Press the Soft Key that corresponds to “SndMtr” to toggle 
the setting On and Off. 

3  Hold Control (Windows) or Command (Mac) and press the 
Meter switch to exit.

Insert Meter On/Off

The Insert Meters On/Off preference toggles insert metering 
on and off. This preference applies when inserts are displayed 
on the D-Control rotary encoders.

To toggle insert meters on and off:

1  In the Soft Keys section, press the Meter switch repeatedly to 
display the page that includes the Insert Meters On/Off pref-
erence (“InsMtr”).

2  Press the Soft Key that corresponds to “InsMtr” to toggle the 
setting On and Off. 

3  Hold Control (Windows) or Command (Mac) and press the 
Meter switch to exit.

Meters Pre/Post Fader

The Meters Pre/Post Fader preference toggles channel meter-
ing between pre- and post-fader modes. 

To toggle channel meters between pre- and post-fader metering:

1  In the Soft Keys section, press the Meter switch repeatedly to 
display the page that includes the Meters Pre/Post Fader pref-
erence (“Meters”).

2  Press the Soft Key that corresponds to “Meters” to toggle the 
setting between “PreFad” (pre-fader metering) and “PostFd” 
(post-fader metering). 

3  Hold Control (Windows) or Command (Mac) and press the 
Meter switch to exit.



Center Meters Track/Output

The Center Meters Track/Output preference toggles the 
8-channel meter display on the Main Unit meter bridge be-
tween main output levels and the focused track. When set to 
meter the focused track, you can view levels for multichannel 
tracks up to 8 channels (7.1 surround).

To toggle the center meters between output and track metering:

1  In the Soft Keys section, press the Meter switch repeatedly to 
display the page that includes the Center Meters Track/Output 
preference (“CtrMtr”).

2  Press the Soft Key that corresponds to “CtrMtr” to toggle the 
setting between “Output” and “Track.”

3  Hold Control (Windows) or Command (Mac) and press the 
Meter switch to exit.

Gain Reduction Priority

When encoder LED rings and channel meters are set to display 
dynamics plug-in gain reduction, you can set which function 
has priority when multi-function Compressor/Gate plug-ins 
are used.

To set the gain reduction metering priority:

1  In the Soft Keys section, press the Meter switch repeatedly to 
display the page that includes the Gain Reduction Priority 
preference (“GRPrio”).

2  Press the Soft Key that corresponds to “GRPrio” to toggle the 
setting between Compressor/Limiter (“CompLm”) and Ex-
pander/Gate (“ExpGat”). 

3  Hold Control (Windows) or Command (Mac) and press the 
Meter switch to exit.

VCA Slave Metering On/Off

The VCA Meters On/Off preference toggles metering of VCA 
slave track levels on VCA channel rotary encoders on and off. 

To toggle VCA slave track metering on and off:

1  In the Soft Keys section, press the Meter switch repeatedly to 
display the page that includes the VCA Meters On/Off prefer-
ence (“VCAMtr”).

2  Press the Soft Key that corresponds to “VCAMtr” to toggle 
the setting On and Off. 

3  Hold Control (Windows) or Command (Mac) and press the 
Meter switch to exit.
System Calibration

Recalibrating D-Control Faders

If a fader on a D-Control Unit shows response problems, you 
can recalibrate the faders with the Recal command in Utility 
mode. See “Recal” on page 161 for details.

Calibrating the Output Meters

You can calibrate the output meters on the Main Unit meter 
bridge from XMON, in order to match metering levels in 
Pro Tools with metering levels of external sources. The exam-
ple below uses a Digidesign 192 I/O as the reference source.

To calibrate the D-Control output meters:

1  Set the reference level of your 192 I/O according to the in-
structions in the 192 I/O Guide.

2  With the 192 I/O analog output connected to the XMON 
Main Input, send a calibration tone to the D-Control Main 
Outputs, and note the output level on the D-Control meters. 

3  Disconnect the 192 I/O analog output from the XMON 
Main Input and connect it to the XMON Alt Input.

4  Activate the Alt Output. 

5  Adjust the trim pots on the back panel of the XMON until 
the output level for each channel on the D-Control matches 
the level displayed for the Main Output.

6  When you are finished, reconnect the 192 I/O analog out-
put to the XMON Main Input.

Calibrating SPL Indication on the Monitor Section

The D-Control Monitor section lets you display output level 
in dB or dB SPL. You can calibrate the SPL display to reflect the 
sound pressure level at the mix position. See “Calibration 
Mode Switch” on page 118.
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Part III: Reference





Chapter 6: Channel Strip Controls
Channel Strips
The D-Control Main Unit has one central channel strip, called 
the Focus Channel Strip, and each D-Control Fader Module has 
16 channel strips. Each channel strip (Figure 1) has identical 
controls, including six touch-sensitive rotary encoders, dis-
play and mode controls, and a touch-sensitive fader. 

Figure 1.  D-Control Channel Strip
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Each channel strip has six touch-sensitive rotary encoders 
with LED ring, display, mode switches, and status indicators. 
Rotary encoders control channel input, insert, send, pan, and 
mic pre parameters.

Encoder Knob

The encoder knobs on D-Control channel strips are 
touch-sensitive. When you touch the encoder, the encoder 
display switches from the parameter name to the parameter 
value. Touch display of parameter values can be turned off.

When you are automating a parameter controlled by an en-
coder, touching the encoder knob starts writing automation. 

Inputs, Outputs, Inserts and Sends

When assigning a channel input or output, or an insert or 
send, the encoder knob is used to scroll through available in-
puts, outputs, inserts, or sends. When adjusting the phantom 
power on a remote-controlled mic preamplifier (such as the 
Digidesign PRE), the encoder knob can be used to toggle phan-
tom power on and off.

Instrument Tracks

On Instrument tracks, the bottom encoder knob is used to 
control MIDI Volume. 

VCA Master Tracks

On VCA Master tracks, the encoder knobs are used to control 
the Volume of slave tracks. 
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Encoder LED Ring

Each encoder has a ring of 15 three-color LEDs. Discrete or 
stepped information is shown by single LEDs, and continu-
ously variable information is shown by an expanding series of 
LEDs.

In Normal mode, encoder LED rings can show send level, pan 
position, plug-in parameter values, and mic pre settings. In 
Flip mode, they show track level.

Instrument Tracks

On Instrument tracks, the bottom encoder LED ring shows 
MIDI Velocity. 

VCA Master Tracks

On VCA Master tracks, encoder LED rings show levels of slave 
tracks. 

Encoder Automation Mode Indicator

Below each encoder knob is an LED marked “auto,” which 
lights when the corresponding parameter is enabled for auto-
mation. The indicator lights green for Read mode, solid yellow 
when armed for automation in any of the Write modes, and 
flashes red when writing automation in any of the Write 
modes. 

Encoder Display

Each encoder has a six-character display that shows parameter 
names. When the corresponding encoder knob is touched or 
moved, the display shows parameter values.

Encoder displays use colors and backlighting to indicate the 
following:

• Green: Default color for input, insert, send, pan, and mic 
pre parameter names and values

• Inverted green: Inactive input, inactive output, inactive 
plug-in or inactive send names

• Yellow: Assignment options in Assign mode, any param-
eters in Flip mode

• Red: Clipped plug-in, send or channel
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Dynamics and EQ Plug-in Indicators

When viewing inserts on an encoder, these LEDs light to indi-
cate the presence of a Dynamics plug-in (yellow LED) or EQ 
plug-in (green LED).

Mute and Pre Indicators

When viewing sends on an encoder, these LEDs light to indi-
cate that the send is muted (red LED) or set to pre-fader oper-
ation (green LED).

Encoder Select Switch

Each encoder has a Select switch that is used to assign an in-
sert or send to that encoder, or to display insert or send 
parameters for editing.

Inserts

When assigning an insert, the encoder Select switch is used to 
confirm the selection of the following elements on each level:

• Insert type (TDM plug-in, RTAS plug-in, Multi-Mono 
TDM plug-in, Multi-Mono RTAS plug-in, or Hardware 
Insert)

• Plug-in subfolder (such as EQ, Dynamics, Pitch Shift, 
Reverb, or Delay)

• Individual insert or plug-in

When viewing a plug-in, the encoder Select switch is used to 
display and edit plug-in parameters on that channel’s rotary 
encoders.

Sends

When assigning a send, the encoder Select switch is used to 
confirm the selection of the following:

• Send type (interface or bus)

• Send assignment

When viewing a send, the encoder Select switch is used to dis-
play and edit send pan information on that channel’s rotary 
encoders.

VCA Master Tracks

On VCA Master tracks, encoder Select switches focus the cor-
responding slave tracks in the Focus Channel Strip.



Bypass/Mute/Pre Switch

Each encoder has a Bypass/Mute/Pre (B/M/P) switch whose 
function depends on what is currently displayed on the en-
coder. With Sends, the function of the B/M/P switch also de-
pends on the current Switch Mode setting. 

See “Switch Mode Switch” on page 61 for more information 
on changing the Switch mode and viewing the current func-
tion of the B/M/P switch. 

Inserts

When a plug-in name is displayed on an encoder (in the top 
level Inserts display), the B/M/P switch bypasses the corre-
sponding plug-in. The B/M/P switch lights when the plug-in is 
bypassed.

When a plug-in parameter is displayed on an encoder (by 
pressing its Select switch) the B/M/P switch affects certain pa-
rameters (such as polarity or channel linking) that can be tog-
gled on and off.

Sends

When a send name is displayed on an encoder, the B/M/P 
switch does one of the following:

• If the Switch Mode is set to Mute, the B/M/P switch 
mutes the corresponding send. The red Mute LED lights 
to indicate that the send is muted. 

• If the Switch Mode is set to Pre, the B/M/P switch toggles 
the corresponding send between pre- and post-fader op-
eration. The green Pre LED lights to indicate that the 
send is set for pre-fader operation. 

Mic Pre

When mic pre parameters are displayed on a channel strip’s 
encoders (in the top level Mic Pre display), the B/M/P switches 
do the following:

• Top encoder B/M/P: toggles phantom power on and off

• Gain encoder B/M/P: toggles mic pre HPF on and off

• Source encoder B/M/P: toggles mic pre Insert on and off

• Pad encoder B/M/P: toggles mic pre Pad on and off

• Polarity encoder B/M/P: toggles mic pre Polarity

Instrument Tracks

On Instrument Tracks, the bottom B/M/P switch is used to 
control MIDI Mute state. 

VCA Master Tracks

On VCA Master tracks, B/M/P switches are used to control the 
Mute state of slave tracks. 
MIDI Controls on Instrument Tracks

The Instruments View in Pro Tools contains MIDI controls 
that can be displayed on the bottom encoder of D-Control 
channel strips. 

To display MIDI volume and mute controls on an Instrument 
track:

Press the Input switch in the Channel Strip Mode controls 
section of the Instrument channel strip.

The MIDI controls appear on the bottom encoder (Encoder 6) 
as follows:

• Encoder knob: MIDI Volume

• B/M/P switch: MIDI Mute

• Encoder LED ring: MIDI Velocity meter

To display MIDI pan controls:

Hold the Input switch and press the Pan switch in the Chan-
nel Strip Mode controls section of the channel strip.

The bottom encoder (Encoder 6) knob controls MIDI Pan.

To exit display of MIDI controls:

Press another switch in the Channel Strip Mode section. 

Slave Track Display on VCA Master Tracks

In normal Mode, VCA Master tracks show their slave tracks in 
their rotary encoders, as follows:

• Encoder knob: Slave track Volume control

• Encoder LED ring: Slave track meter level

• Encoder B/M/P switch: Slave track mute

• Encoder Select switch: Focuses slave track in Focus Chan-
nel Strip

If there are more than six slave tracks for a VCA Master, you 
can the press the channel Page Up/Page Down switches to dis-
play the additional slave tracks on the rotary encoders.
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Channel Strip Mode Controls

Each channel strip has a set of Channel Strip Mode controls 
for displaying and editing pan, plug-in, mic pre, insert, or 
send parameters on the encoder section of the D-Control 
channel strip. 

Page Up and Page Down Switches

Control parameters are arranged on channel strip rotary en-
coders in pages, or groups of up to six parameters at a time.

The Page Up and Page Down switches light to indicate the 
presence of additional pages of sends, pan, plug-in, mic pre 
parameters, or (for VCA Master tracks) slave tracks, in the cor-
responding direction on each channel strip. If no additional 
pages are available, neither switch is lit.

To move the page display of parameters on the encoders up or 
down:

Press a lit Page Up or Page Down switch.

Dynamics and EQ Switches

The Dynamics and EQ switches light to indicate the presence 
of the corresponding type of plug-in on a channel strip.

To display a channel strip’s first Dynamics or EQ plug-in on the 
rotary encoders for editing:

Press a lit Dynamics or EQ switch. 

To cycle through all the Dynamics or EQ plug-ins on a channel:

Repeatedly press the corresponding switch.

Channel Strip Mode controls

Page Up switch

Dynamics switch

Microphone
Preamplifier switch

Inserts switch Pan switch

Bypass/Spill
switch

Sends switch

Input switch

EQ switch

Page Down switch
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Input Switch

With Audio and Auxiliary Input tracks, the Input switch is 
used to put channels into Inline mode. See “Inline Console 
Mode” on page 135.

With Instrument tracks, the Input switch is used to display 
that track’s MIDI controls on the rotary encoders. See “MIDI 
Controls on Instrument Tracks” on page 51. 

Mic Pre Switch

When you press the Mic Pre switch, the controls for an avail-
able remote-controlled microphone preamplifier (such as the 
Digidesign PRE) are displayed on the channel strip’s rotary en-
coders for editing. Microphone preamplifiers are declared in 
the Pro Tools Peripherals dialog, and assigned to channels in 
the Pro Tools I/O Setup dialog.

Inserts Switch

When you press the Inserts switch on a channel strip, plug-in 
names are shown in two groups of five (Inserts A–E or Inserts  
F–J) on the encoder displays. 

You can use Flip mode to transfer controls for any insert (A–J) 
from the channel encoders  to the Faders.  See “Flip Mode” on 
page 133.

To toggle display of Inserts A–E and F–J on a channel strip:

1  Press the Inserts switch in the Channel Strip Mode controls 
section of the channel strip to show the top level Insert dis-
play.

2  Press the Page Up and Page Down switches to toggle the top 
level Send display between the two sets of five sends (A–E and 
F–J). 

To view the parameters for an individual plug-in:

Press the Select switch on the corresponding encoder. 

To return to the top level display of plug-ins on the channel strip:

Press the Inserts switch again.

The Inserts switch flashes when a plug-in on that channel has 
clipped. To clear a clip, press the Clear Clip switch in the Ses-
sion Management section. See “Clear Clip Switch and Plug-in 
Clip Indicator” on page 102 for more information.



Pan Switch

When you press the Pan switch, the pan controls for the chan-
nel strip are displayed on the encoder displays.

If the track is a multichannel track, its Page Up switch lights to 
indicate that there are multiple pages of pan controls. Multi-
channel pan controls are arranged as follows:

To open/close the Output window on-screen for a track:

1  Press the Pan switch on the channel. 

2  Hold Start (Windows) or Control (Mac) and press the chan-
nel’s encoder switch.

Two-Knob Surround Panning

When working in surround, you can link the front and rear 
pan controls on D-Control to facilitate X-axis motion in the 
sound field. 

To link front and rear surround panners:

1  Press the Operation switch in Console Prefs section until 
“2KbPan” appears in the Soft Keys.

2  Press the Soft Key that corresponds to “2KbPan” to toggle 
the preference on or off. 

Surround Pan Display, Page 1

Display Pan Control 

LFE LFE channel

Cntr% Center Speaker Percentage

F Div Front Divergence

Rear Rear Pan

F/R Front/Rear Balance

Front Front Pan

Surround Pan Display, Page 2
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F/R Front/Rear Balance

F Div Front Divergence

Front Front Pan
Bypass/Spill Switch

The function of the Bypass/Spill switch depends on what is 
currently displayed on the channel strip. 

Inserts

In the top level Inserts view (when plug-in names are dis-
played on a channel strip’s encoders), the Bypass/Spill switch 
bypasses all plug-ins on that channel.

When a single plug-in’s parameters are displayed on a chan-
nels strip’s encoders, the Bypass/Spill switch bypasses that 
plug-in only.

Sends

In the top level Sends view (when send names are displayed 
on a channel strip’s encoders), the Bypass/Spill switch mutes 
all sends on that channel.

When a single send’s parameters are displayed on a chan-
nels strip’s encoders, the Bypass/Spill switch has no effect.

VCA Master Tracks

On VCA Master tracks, the Bypass/Spill switch displays (or 
“spills”) the slave tracks for the VCA in Custom Faders.

Sends Switch

When you press the Sends switch on a channel strip, sends are 
shown in two groups of five (Sends A–E or Sends F–J) on the 
encoder displays. The rotary encoders control Send level. 

You can use Flip mode to transfer controls for any send posi-
tion (A–J) to the Faders. See “Flip Mode” on page 133.

To toggle display of Sends A–E and F–J on a channel strip:

1  Press the Sends switch in the Channel Strip Mode controls 
section of the channel strip to show the top level Send display.

2  Press the Page Up and Page Down switches to toggle the top 
level Send display between the two sets of five sends (A–E and 
F–J). 

To open/close a Send window on-screen:

1  Press the Sends switch on the channel whose Send window 
you want to open/close. 

2  Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Send you want to open/close.
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Send Pan Mode

Send Pan mode allows you to adjust panning and level for an 
individual send on a channel at the same time. In Send Pan 
mode, Send Level is controlled by the channel fader and Send 
Pan is controlled by the encoders. 

Send Pan mode lets you view different sends on individual 
channels, or by using the Do To All or Do To Selected 
switches, the same send across multiple channels. 

In Send Pan mode, you can link Pan controls of individual 
Sends to the Main Pan controls of their tracks (the “Follow 
Main Pan” or “FMP”). 

To enter Send Pan mode:

1  Press the Sends switch to display sends on the channel’s en-
coders.

2  Press the encoder Select switch that corresponds to the send 
you want to display. The channel’s Send and Pan switches 
light to indicate that it is in Send/Pan mode. 

To return to the top level display of sends on the channel strip:

Press the Sends switch again. 

To link a Send’s Pan controls to the Main Pan controls of a track:

1  Put the track in Send Pan mode for the Send you want to 
link. 

2  Press the B/M/P switch on any of the active encoders on the 
track to toggle the FMP status of the send.

Send Clipping Indication

The Sends switch flashes when a send on that channel has 
clipped. To clear a clip, press the Clear Clip button in the Ses-
sion Management section. See “Clear Clip Switch and Plug-in 
Clip Indicator” on page 102 for more information.
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Channel Strip Function Controls

Each channel strip has a set of Channel Strip Function con-
trols for controlling channel selection and focus, mute, solo, 
and record enable status, input monitor mode, and automa-
tion mode.

Input Monitor Mode Switch

The Input Monitor Mode switch toggles the input monitoring 
mode for that channel between Auto Input and Input Only 
mode. The switch lights when the channel is in Input Only 
mode. 

Record Enable Switch

The Record Enable switch toggles record enable status for the 
channel. When the channel is record-enabled and the 
Pro Tools transport is stopped, the switch flashes. During re-
cording, the switch lights continuously.

Record Safe Mode To record safe a track from D-Control, hold 
Control (Windows) or Command (Mac) and press the track’s 
Record Enable switch.

Channel Select Switch

The function of the Channel Select switch depends on the Se-
lect/Focus Mode setting. See “Select/Focus Mode Switch and 
Indicators” on page 67 for more information on changing the 
Select/Focus mode.

Select Mode If the Select/Focus Mode is set to Select, the 
Channel Select switch selects the channel in Pro Tools. The 
switch lights when the channel is selected. In this mode, the 
Channel Select switch can be set to follow latching or exclu-
sive-or (non-latching) behavior.

Focus Mode If the Select/Focus Mode is set to Focus, the Chan-
nel Select switch focuses that channel’s controls on the Focus 
Channel Strip on the Main Unit. The switch lights when the 
channel is focused. In this mode, because only one track can 
be focused at a time, the Select switch follows exclusive-or 
(non-latching) behavior only. 

Channel Strip Function controls

Input Monitor Mode
switch

Channel Select
switch

Solo switch

Mute switch

Channel display

Automation Mode
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Solo Switch

The Solo switch toggles solo status for the channel. When a 
channel is soloed, the Solo switch lights, and the Mute 
switches on other channels in the session flash to indicate im-
plicit mute. The Solo switch function follows the Pro Tools 
Operation preference for latched operation.

Solo Safe Mode To solo safe a track, hold Control (Windows) 
or Command (Mac) and press the track’s Solo switch. 

When a track is solo safed, its Solo switch flashes once. 

Mute Switch

The Mute switch toggles mute status for the channel. 

When a track is muted, its Mute switch lights solid. 

When a track is implicitly muted (when another track is so-
loed), its Mute switch flashes. 

Channel Display

Each channel display shows the channel information in the 
following display modes. In each mode, when the channel 
fader is touched, the display shows the channel volume in dB. 

Track Name Mode Shows the track name only.

Group/Name Mode Shows the group membership of the track 
(by group letter) and an abbreviated track name.

Track Position Number/Name Mode Shows the track position 
number and an abbreviated track name.

Headroom Mode Shows the abbreviation “HR” followed by the 
remaining headroom in dB.

Level Mode Shows the track volume level in dB only. 

Channel displays use colors and backlighting to indicate the 
following:

• Green: Channel names and values

• Inverted green: Inactive channel

• Red: Clipped channel
Automation Mode Switch

The Automation Mode switch cycles the channel through the 
Pro Tools automation modes (Write, Latch, Touch, Read and 
Off). The active mode is shown by the Automation Mode LED 
indicators to the left of each channel’s fader. When in Off 
mode, none of the indicators is lit.

The Automation Mode switch lets you cycle the channel 
through Touch, Latch, and Read modes during playback, but 
it prevents you from entering Write or Off mode during play-
back. To directly enter Write or Off mode during playback, use 
the Automation Mode controls in the lower left and right of 
the Main Unit. (See “Automation Mode Controls” on 
page 69.)

You can use the Do To All and Do To Selected switches to se-
lect automation modes across multiple channels.

To select an automation mode for a channel, do one of the 
following:

• To cycle forward through the automation modes, press 
the Automation Mode switch on the channel.

– or –

• To cycle backward through the automation modes, hold 
Shift and press the Automation Mode switch on the 
channel.

Automation Trim Switch

The Automation Trim switch toggles the channel into the cor-
responding Trim mode for Write, Latch, Touch, and Read 
modes. Active Trim mode is shown by the yellow Trim mode 
LED indicator to the left of each channel’s fader. The Automa-
tion Trim switch has no effect while the channel is in Off 
mode.
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Fader Section

Fader

The touch-sensitive faders on D-Control channel strips con-
trol channel volume in Normal mode, and a wide range of pa-
rameters in Flip mode or the Custom Fader modes. When you 
touch a fader, its channel strip display changes from track 
name to track volume level (in Normal mode), or from param-
eter name to parameter value (in Flip modes or Custom Fader 
modes). When you are automating a parameter on a fader, 
touching the fader starts writing automation. 

Automation Mode Indicators

The Automation Mode indicators, located to the left of each 
channel’s fader, indicate the active automation mode. 
WR (Write), TC (Touch) and LT (Latch) are red LEDs; TM 
(Trim) is a yellow LED; and RD (Read) is a green LED. 

When in Write mode, the Write indicator flashes at all 
times. 

When in Touch or Latch modes, the corresponding indica-
tor lights solid until automation writing begins. 

When a track in Latch mode is primed for writing automa-
tion, its Latch mode indicator flashes. 

When automation writing begins, the appropriate indicator 
flashes. 

If automation is turned off for the channel (Off), none of 
the indicators is lit. 

Group Status Indicator

The Group Status indicator (a green LED marked GRP), located 
to the left of each channel’s fader, lights to indicate that the 
channel is a member of an active Mix or Edit group in 
Pro Tools. If the channel is a member of an inactive group, or 
if groups are suspended, this indicator is off. 

Channel Strip Fader section

Automation Mode
indicators

Group Status
indicator

Custom Fader Mode
indicator

AutoMatch
indicators

Channel
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Custom Fader Mode Indicator

The Custom Fader Mode indicator (a blue LED marked CF), lo-
cated to the left of each channel’s fader, lights to indicate that 
the channel is currently in Custom Fader Mode. 

AutoMatch Indicators

The AutoMatch indicators (green arrow-shaped LEDs), located 
to the left of each channel’s fader, light to indicate the direc-
tion you need to move the fader in order to match the auto-
mation level previously written for that track. This is espe-
cially useful when editing fader automation. 

Modifier Key Switches

Each D-Control Fader Module has a set of four switches in its 
lower left corner that duplicate the function of the Pro Tools 
computer keyboard modifiers. 

Shift Switch (Windows and Mac)

The Shift switch duplicates the function of the Shift key on 
the D-Control computer keyboard.

Control Switch (Windows and Mac)

The Control switch duplicates the function of the Control key 
on the D-Control computer keyboard. 

Win Switch (Windows) or Option Switch (Mac)

The Win/Option switch duplicates the function of the Win-
dows (Start) key (Windows) or the Option key (Mac) on the 
D-Control computer keyboard. 

Alt Switch (Windows) or Command Switch (Mac)

The Alt/Command switch duplicates the function of the Alt 
key (Windows) or the Command key (Mac) on the D-Control 
computer keyboard.

Modifier Keys (Fader Module)

The order of the modifier keys on the Fader Module 
reflects the order of the corresponding keys on a 
Windows or Mac keyboard, from left to right.

Shift Control Win (Start) (Windows)
Option (Mac)

Alt (Windows)
 (Command) (Mac)



Channel Strip Master Section
The Channel Strip Master section (Figure 2) is a set of chan-
nel-related controls that appears on both the left and right 
sides of the D-Control Main Unit, allowing easy access to 
these controls from any mixing position. The operation of 
each control in this section is mirrored on both sets of con-
trols at all times.

Flip Switches

The six yellow Flip switches in the Channel Strip Master sec-
tion correspond to the six horizontal rows of rotary encoders 
on the D-Control channel strips.

Flip Mode

The Flip switches invoke Flip mode, which transfers controls 
from the corresponding rotary encoder to the fader on each 
channel strip, allowing convenient editing and automation of 
send, pan, plug-in, and mic pre parameters directly from the 
channel faders. 

In Flip mode, the rotary encoder control swaps with the chan-
nel fader; the encoder Select switch swaps with the channel 
Select switch; the encoder Bypass/Mute/Pre switch swaps with 
the channel Mute switch; and the encoder display swaps with 
the channel display. 

In Flip mode, the Flip switch for the affected row of encoders 
is lit, and the affected encoder displays appear in yellow.

Instrument Tracks and Flip Mode

In Flip mode, Instrument track controls are transferred as fol-
lows:

• The fader on each channel controls the parameter (MIDI 
Volume or MIDI Pan) that was assigned to the bottom en-
coder, and the bottom encoder controls track Volume.

• The channel Mute switch controls the MIDI Mute function, 
and the B/M/P switch on the bottom encoder controls 
channel mute.

To transfer controls from a row of rotary encoders to the channel 
faders:

Press the Flip switch that corresponds to the encoder row.

To exit Flip mode:

Press a lighted Flip switch.

When D-Control is in Flip mode and you enter Make 
Inactive mode or Assign mode, it is temporarily taken 
out of Flip mode, but the Flip switch remains lit. 
When you exit Make Inactive mode or Assign mode, 
controls return to their flipped positions. 
Figure 2.  Channel Strip Master section
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Flop Mode

A variation of Flip mode, Flop mode transfers controls from 
any of the top five rows of rotary encoders to the bottom row 
of rotary encoders, allowing you to bring any encoder control 
within easy reach from the mix position. 

In Flop mode, the affected row of encoders moves to the bot-
tom row of encoders, the Flip switches for both affected rows 
are lit, and the encoder displays for both rows appear in yel-
low. 

To transfer controls from any of the top five rows of encoders to 
the bottom row of encoders:

Hold the Start key (Windows) or Control key (Mac) and 
press the Flip switch that corresponds to the encoder row.

To exit Flop mode:

Press either of the lighted Flip switches.

Make Inactive Controls

The Make Inactive controls are used to make tracks, inputs, 
outputs, sends, or inserts inactive. Each switch puts D-Control 
into a temporary Make Inactive mode in which elements are 
made inactive or reactivated. The switch flashes while Make 
Inactive mode is in effect. 

Making a Track Inactive

In Make Inactive mode, channel Select switches are lit on all 
tracks.

To toggle a track inactive/active:

1  Press any of the Make Inactive switches.

2  Press the channel strip Select switch for each track you want 
to deactivate or activate. 

3  Press the flashing Make Inactive switch to exit Inactive 
mode.

When D-Control is in Make Inactive mode or Assign mode, 
it is temporarily taken out of Flop mode, but the Flip 
switches remains lit. When you exit Make Inactive mode or 
Assign mode, controls return to their flopped positions. 

Make Inactive Controls

Inputs Inactive
switch

Sends Inactive
switch

Outputs Inactive
switch

Inserts Inactive
switch
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Inputs Inactive Switch

The Inputs switch invokes Inputs Inactive mode and displays 
channel inputs in the bottom row of encoders. The By-
pass/Mute/Pre switch on the bottom encoder toggles the in-
put inactive and active.

Outputs Inactive Switch

The Outputs switch invokes Outputs inactive mode and dis-
plays the main channel outputs in the bottom row of encod-
ers. The Bypass/Mute/Pre switch on the bottom encoder tog-
gles the output inactive and active.

Sends Inactive Switch

The Sends switch invokes Sends Inactive mode and displays 
the channel’s sends on its encoders. The Bypass/Mute/Pre 
switch on each encoder toggles the corresponding send inac-
tive and active.

Inserts Inactive Switch

The Inserts switch invokes Inserts Inactive mode and displays 
a channel’s inserts on its encoders. The Bypass/Mute/Pre 
switch on each encoder toggles the corresponding insert inac-
tive and active.

To toggle an input, output, send, or insert active/inactive:

1  Make sure the channel is showing the top-level view for the 
element you want to make active/inactive.

2  Press a Make Inactive switch to enter the appropriate Make 
Inactive mode. 

3  Press the Bypass/Mute/Pre switches on encoders to deacti-
vate or reactivate their corresponding track elements.

4  Press the flashing Make Inactive switch to exit Inactive 
mode.



Plug-in Automation Controls

The Plug-in Automation controls are used to enable parame-
ters for automation and to place them in automation safe 
mode.

Enable Parameters Switch

The Enable Parameters switch lets you enable parameters for 
automation by touching or pressing their controls. 

In Enable Parameters mode, the Enable Parameters switch is 
lit. While in this mode, the Auto LED for any rotary encoder 
enabled for automation is lit red, and the switch for any pa-
rameter enabled for automation is lit. 

To toggle automation on and off for plug-in parameters:

1  Press the Enable Parameters switch.

2  Touch the rotary encoders or press the switches for the con-
trols whose automation you want to toggle on or off. 

3  Press the Enable Parameters switch again to exit Enable Pa-
rameters mode.

Automation Safe Switch

The Automation Safe switch invokes a mode in which the By-
pass/Mute/Pre switch for each plug-in or send and the chan-
nel Select switch for each track become Safe switches.

Plug-ins and Sends

While in Automation Safe mode, pressing a Bypass/Mute/Pre 
switch on a plug-in or send protects any automation on that 
plug-in or send from being overwritten. The Bypass/Mute/Pre 
switch for any protected plug-in or send is lit, reflecting the 
state of the Safe button in the on-screen plug-in or send out-
put window. 

Tracks

While in Automation Safe mode, pressing a channel Select 
switch protects volume, pan and mute parameters on that 
track from being overwritten. The channel Select switch for 
any protected track is lit, reflecting the state of the Safe button 
in the on-screen track output window.

Plug-in Automation controls

You can also toggle automation for a plug-in parameter by 
holding Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touching the rotary encoder for the 
parameter.

Enable Parameter
switch

Automation Safe
switch
To toggle automation safe on and off:

1  Press the Automation Safe switch.

2  Press the channel Select switch on the tracks for which you 
want to toggle automation safe status. The automation safe 
status of the track is reflected by the Safe button in the track’s 
on-screen output window. 

3  Press the Bypass/Mute/Pre switch for the plug-ins or sends 
for which you want to toggle automation safe status. 

4  Press the Automation Safe switch again to exit Automation 
Safe mode.

Assign Controls

The Assign controls are used to assign inputs, outputs, inserts, 
and sends to channels. Each switch puts D-Control into a tem-
porary Assign mode in which elements are assigned or re-
moved from channels. The switch flashes while Assign mode 
is in effect.

You can enter Assign mode while Pro Tools is playing back. To 
confirm the assignment of inputs, outputs, and sends, the 
transport must be stopped. You can, however, confirm the as-
signment of inserts during playback.

Assign Inputs Switch

The Inputs switch invokes Assign Inputs mode, in which the 
bottom row of encoders shows channel inputs. 

When assigning an input, the Select switch on the bottom en-
coder is used to navigate down through Input menu levels, 
and the encoder knob is used to scroll through available 
choices at each level:

• Input type (Interface or Bus), shown in yellow

• Individual inputs, shown in green

Press the Bypass/Mute/Pre switch on the bottom encoder to 
navigate back up the Input menu levels.

Assignment controls
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Assign Outputs
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Assign Inserts
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Assign Outputs Switch

The Outputs switch invokes Assign Outputs mode, in which 
the bottom row of encoders shows channel outputs.

When assigning an output, the Select switch on the bottom 
encoder is used to navigate down through Output menu lev-
els, and the encoder knob is used to scroll through available 
choices at each level:

• Output type (Interface or Bus), shown in yellow

• Individual outputs, shown in green

Press the Bypass/Mute/Pre switch on the bottom encoder to 
navigate back up the Output menu levels.

Assign Sends Switch

The Sends switch invokes Assign Sends mode, in which the 
channel encoders shows the sends on a channel. 

When assigning a send, the encoder Select switch is used to 
navigate down through Send menu levels, and the encoder 
knob is used to scroll through available choices at each level:

• Send type (Interface or Bus), shown in yellow

• Individual sends, shown in green

The Bypass/Mute/Pre switch on each encoder is used to navi-
gate back up the Send menu levels.

Assign Inserts Switch

The Inserts switch invokes Assign Inserts mode, in which the 
channel encoders show the inserts on a channel. When as-
signing an insert, the encoder Select switch is used to navigate 
down through Insert menu levels, and the encoder knob is 
used to scroll through available choices. The Bypass/Mute/Pre 
switch on the bottom encoder is used to navigate back up the 
Insert menu levels.

The order in which plug-ins appear in the Insert menu is de-
termined by the Pro Tools Display preference for plug-in orga-
nization. 

If the Organize Plug-in Menus by Category option is selected, 
menu levels and choices include:

• Insert type (TDM plug-in, RTAS plug-in, Multi-Mono 
TDM plug-in, Multi-Mono RTAS plug-in, or Hardware In-
sert), shown in yellow

• Plug-in subfolder (such as EQ, Dynamics, Pitch Shift, Re-
verb, and Delay), shown in yellow

• Individual insert or plug-in, shown in green

If the Organize Plug-in Menus by Category option is not se-
lected, the Plug-in subfolder level is not present.
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To assign an input, output, send or insert:

1  Press an Assign switch to enter the corresponding Assign 
mode. 

2  On the channel where you want to make the assignment, 
turn an encoder knob to select from the first level of menu 
choices.

3  Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels. 

4  Do one of the following:

• Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the assignment. 

– or –

• Press the flashing Escape switch to cancel the assign-
ment.

To assign multiple inputs, outputs, sends, or inserts:

1  Press an Assign switch to enter the corresponding Assign 
mode. 

2  Turn the encoder knobs and use the encoder Select and By-
pass/Mute/Pre switches to select each assignment.

3  Do one of the following:

• Press the flashing Assign switch to confirm all the assign-
ments at once. 

– or –

• Press the flashing Escape switch to cancel all the assign-
ments.

To remove an input, output, send or insert:

1  Press an Assign switch to enter the corresponding Assign 
mode. 

2  For the assignment you want to remove, press the encoder 
Bypass/Mute/Pre switch repeatedly until you reach top level 
menu for the assignment. 

3  Turn the encoder knob counter-clockwise until no assign-
ment is visible. 

4  Do one of the following:

• Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the removal. 

– or –

• Press the flashing Escape switch to cancel the removal 
and restore the assignment.



Removing Plug-in Assignments

You can use the Set to Default switch to quickly remove 
plug-in assignments from tracks, without having to go into 
Assign mode.

To quickly remove plug-in assignments:

1  Press the Set to Default switch.

2  Press the encoder Select switch for each plug-in assignment 
you want to remove. 

3  Press the flashing Set to Default switch.

Assigning MIDI Inputs and Outputs on Instrument 
Tracks

The Assign Inputs and Assign Outputs switches can be used to 
assign the MIDI Inputs and Outputs on Instrument tracks.

To assign a MIDI Input or Output on an Instrument track:

1  Press the Assign Inputs or Assign Outputs switch to enter the 
corresponding Assign mode. Encoder row #5 shows MIDI in-
puts/outputs.

2  On each channel where you want to make an assignment, 
turn the encoder knob in encoder row #5 to select from the 
first level of MIDI menu choices.

3  Press the encoder’s Select switch to move down and the By-
pass/Mute/Pre switch to move up through MIDI menu levels.

4  Do one of the following:

• Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the assignments.

– or –

• Press the flashing Escape switch to cancel the assign-
ments. 

This method removes the assignments immediately, 
and cannot be canceled. 
Switch Information Controls

The Switch Information controls are used to change the mode 
and display of encoder Bypass/Mute/Pre switches, and glo-
bally show encoder parameter values.

Switch Mode Switch

The Switch Mode switch toggles the function of encoder By-
pass/Mute/Pre switches between Mute and Pre-Fader func-
tions when displaying sends on the encoders.

• When the Switch Mode is set to Bypass, the encoder B/M/P 
switch mutes the corresponding send.

• When the Switch Mode is set to Pre, the encoder B/M/P 
switch toggles the corresponding send between pre- or 
post-fader operation.

To set the Switch Mode:

Press the Switch mode switch repeatedly until the appropri-
ate indicator lights (Mute or Pre). 

Switch Info Switch

The Switch Info switch can follow toggling or momentary be-
havior. If pressed briefly, it toggles the encoder display to 
show the function assigned to the Bypass/Mute/Pre switch on 
each rotary encoder. If held, the function is shown until the 
switch is released. 

Show Values Switch

The Show Values switch can follow toggling or momentary 
behavior. If pressed briefly, it toggles encoder display between 
parameter name and parameter value. If held, parameter value 
is shown until the switch is released. 

Switch Information controls
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Automation Enable Controls

The Automation Enable controls are used to enable or suspend 
writing of each type of automation on all channels. The Auto-
mation Enable controls mirror the function of the corre-
sponding buttons in the Automation Enable window. 

When writing is enabled for an automation type but it is not 
currently writing on any track in the session, the correspond-
ing switch lights solid. 

When writing is enabled for an automation type and it is 
currently writing on any track in the session, the correspond-
ing switch flashes. 

Inserts Switch

The Inserts switch enables and suspends writing of automa-
tion for any automation-enabled plug-in parameters on all 
tracks in the session.

Volume Switch

The Volume switch enables and suspends writing of channel 
volume automation on all tracks in the session. 

Pan Switch

The Pan switch enables and suspends writing of channel pan 
automation on all tracks in the session. 

Mute Switch

The Mute switch enables and suspends writing of channel 
mute automation on all tracks in the session. 

Send Volume Switch

The Send Volume switch enables and suspends writing of send 
volume automation on all tracks in the session. 

Send Pan Switch

The Send Pan switch enables and suspends writing of send 
pan automation on all tracks in the session. 

Automation Enable controls
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Send Mute Switch

The Send Mute switch enables and suspends writing of send 
mute automation on all channels. 

Automation Write To Controls

The Auto Write To controls invoke the manual “Write to 
Start/End/All/Punch/Next” commands and the automatic 
“Write to Start/End/All/Punch/Next on Stop” automation 
commands in Pro Tools.

The “Write to Start/End/All/Punch/Next” commands can also 
be invoked from the Soft Keys section of D-Control. 

All Switch

The All switch writes the current automation value of all 
write-enabled parameters to an entire selection or track when 
performing an automation pass.

To manually write automation to all of a track or selection:

Press the All switch during playback.

To write automation to all of a track or selection on stop:

Hold the Start key (Windows) or the Control key (Mac) and 
press the All switch.

To set Write to All on Stop to remain enabled after each 
automation pass:

Hold the Alt+Start keys (Windows) or the Option+Control 
keys (Mac) and press the All switch. 

To disable automatic Write to All on Stop:

Press the flashing All switch.

“Auto Write To” switches

Automation
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Automation
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Start Switch

The Start switch writes the current automation value of all 
write-enabled parameters to the start of a selection or track 
when performing an automation pass. 

To manually write automation to the start of a track or selection:

Press the Start switch during playback.

To write automation to the start of a track or selection on stop:

Hold the Start key (Windows) or the Control key (Mac) and 
press the Start switch.

To set Write to Start on Stop to remain enabled after each 
automation pass:

Hold the Alt+Start keys (Windows) or the Option+Control 
keys (Mac) and press the Start switch. 

To disable Write to Start on Stop: 

Press the flashing Start switch.

End Switch

The End switch writes the current automation value of all 
write-enabled parameters to the end of a selection or track 
when performing an automation pass.

To manually write automation to the end of a track or selection:

Press the End switch during playback.

To write automation to the end of a track or selection on stop:

Hold the Start key (Windows) or the Control key (Mac) and 
press the End switch. 

To set Write to End on Stop to remain enabled after each 
automation pass:

Hold the Alt+Start keys (Windows) or the Option+Control 
keys (Mac) and press the End switch. 

To disable automatic Write to End on Stop:

Press the flashing End switch.
Punch Switch

The Punch switch writes the current automation value of all 
write-enabled parameters back to the punch point (the loca-
tion in the track where the current automation pass started). 

To manually write automation back to the punch point:

Press the Punch switch during playback.

To write automation back to the punch point on stop:

Hold the Start key (Windows) or the Control key (Mac) and 
press the Punch switch. 

To set Write to Punch on Stop to remain enabled after each 
automation pass:

Hold the Alt+Start keys (Windows) or the Option+Control 
keys (Mac) and press the Punch switch. 

To disable automatic Write to Punch on Stop:

Press the flashing Punch switch.

Next Switch

The Next switch writes the current automation value of all 
write-enabled parameters forward to the next automation 
breakpoint. 

Unlike the other Write To commands, the Write to Next on 
Stop command always remains enabled after each automation 
pass, until you disable it. 

To manually write automation forward to the next breakpoint:

Press the Next switch during playback.

To set Write to Next on Stop to remain enabled after each 
automation pass:

Hold the Start key (Windows) or the Control key (Mac) and 
press the Next switch. 

To disable automatic Write to Next on Stop:

Press the flashing Next switch.
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Global Controls

The Global controls are used to apply commands that affect 
multiple channels in various ways. 

Do To All and Do To Selected Switches

The Do To All and the Do To Selected switches on D-Control 
can be used in two different ways: to apply actions to multiple 
tracks in a Pro Tools session, and to change the display mode 
of multiple channel strips on D-Control.

The Do To All and Do To Selected switches can follow mo-
mentary or latching behavior. 

When single-pressed, their effect applies only to the next 
operation. 

When held, they apply to all operations carried out while 
being held. 

When double-pressed, they latch on and flash until pressed 
a second time.

Applying Actions to Multiple Tracks in Pro Tools

The Do To All and Do To Selected switches are convenient for 
performing tasks such as muting, soloing, assigning sends, or 
assigning the same plug-in across multiple tracks in a session. 

Global controls

Do to Selected

Set to Default

Do to All switch

Suspend Groups

switch

switch switch
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To apply actions to multiple tracks in a Pro Tools Session:

1  Do one of the following:

• Press the Do To All or the Do To Selected switch to apply 
the action to one parameter. 

– or –

• Double-press the Do To All or the Do To Selected switch 
to latch the corresponding action and apply it to multi-
ple parameters. 

2  Press any of the following switches to apply the correspond-
ing action to all tracks or all selected tracks in the current ses-
sion:

• Channel Mute switch

• Channel Solo switch

• Channel Solo Safe: Control (Windows) or Command 
(Mac) + Solo switch

• Automation Mode switch

• Automation Trim switch

• Channel Select switch (in Select mode)

• Record Enable switch

• Record Safe: Control (Windows) or Command (Mac) + 
Record Enable switch

• Input Monitor Mode switch

3  Depending on the current channel strip display mode, you 
can apply the following across all tracks or all selected tracks 
in the session:

• Mic Pre Controls: Polarity, Pad, Impedance, Source, Gain

• Send Pre/Post: B/M/P switch in Send Pre/Post mode

• Send Mute: B/M/P switch in Send Mute mode

• Plug-in Bypass: B/M/P switch in Inserts mode

4  You can also carry out any of the following tasks across all 
tracks or all selected tracks in the session:

• Assigning Inputs, Outputs, Inserts and Sends

• Deactivating Inputs, Outputs, Inserts, Sends and Tracks

• Resetting controls with the Set to Default switch

• Changing panner linkage

• Changing panner editor choice

5  When you are finished, if Do To all or Do To Selected are 
latched on, press the flashing Do To All or Do To Selected 
switch to exit the corresponding mode.



Changing Parameter Display on D-Control Channel Strips

The Do To All and Do To Selected switches can be used to dis-
play and edit pan, mic pre, insert, or send parameters across all 
tracks or all selected tracks in a session. 

The Do To All and Do To Selected switches are applied inde-
pendently to channel strips in Normal mode and channel 
strips in Custom Fader mode. The display mode of the Focus 
Channel Strip is not affected by Do To All or Do To Selected 
operations.

This independent operation lets you put banks of channels in 
several display modes at once (for example, pan on channels 
in Normal mode, plug-ins on channels in Custom Fader 
mode, and sends on the Focus Channel Strip).

To change the display mode of D-Control channel strips:

1  Press the Do To All or the Do To Selected switch.

2  Press any of the following Channel Strip Mode switches on 
any individual channel to apply the corresponding action to 
all or all selected channels on D-Control:

• Dynamics switch

• EQ switch

• Input switch

• Microphone Preamplifier switch

• Inserts switch

• Pan switch

• Bypass/Spill switch

• Sends switch

3  When you are finished, if Do To all or Do To Selected are 
latched on, press the flashing Do To All or Do To Selected 
switch to exit the corresponding mode.

Set To Default Switch

The Set to Default switch is used to reset parameters on the 
D-Control surface to their default values. This switch works in 
both Normal and Custom Fader modes. 

Channel Strip Mode controls

Instead of using the Set To Default switch, you can 
also hold the Alt key (Windows) or the Option key 
(Mac) and press the corresponding switch to reset pa-
rameters to their default values.
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The Set to Default switch can follow momentary or latching 
behavior. When single-pressed, its effect applies only to the 
next operation. When double-pressed, it latches on and 
flashes until pressed a second time. 

While the Set to Default switch is pressed or latched on, the 
following parameters can be reset:

To reset a channel’s track volume to 0 dB:

Press the Set to Default switch + the channel Select switch.

– or –

Hold Alt (Windows) or Option (Mac) and touch the channel 
fader. 

To reset a channel’s pan control to 0 (center)

Press Set to Default + the pan encoder Select switch. 

To reset a send’s level to 0 dB: 

Press Set to Default + the send encoder Select switch. This 
sets the send level to 0 dB, regardless of the Send default set-
ting in Pro Tools Operation preferences.

To reset a channel’s mic pre gain to 0 dB: 

Press Set to Default + the mic pre gain encoder Select switch

To reset an LFE channel’s gain to 0 dB:

Press Set to Default + the encoder Select switch for the LFE 
channel.

To set a plug-in’s parameters to their default values:

Press Set to Default + the Compare switch for the plug-in. 
(The Compare switch appears in the D-Control Dynamics and 
EQ sections, and in Custom Fader Expanded Plug-in mode.)

Suspend Groups Switch

The Suspend Groups switch suspends all groups in the session. 

The Suspend Groups switch follows latching behavior, and 
flashes to indicate groups are suspended. To exit Suspend 
Groups mode, press the Suspend Groups switch again. 

You can also use the Set to Default switch to remove 
plug-in assignments from channels. See “Removing 
Plug-in Assignments” on page 61.
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Global Channel Strip Mode Controls

The Global Channel Strip Mode controls are used to display 
and edit pan, mic pre, insert, or send parameters across all 
tracks in a session. These controls do not affect channel strips 
in any of the Custom Fader modes. 

Global Page Up and Page Down Switches

The Global Page Up and Page Down switches change the page 
display on all channel strips. 

To move the page display of parameters on all rotary encod-
ers up or down, press the Global Page Up or Page Down 
switch.

Global Dynamics and EQ Switches

The Global Dynamics and EQ switches display the first plug-in 
of the corresponding type on the rotary encoders across all 
channels. To cycle through all the Dynamics or EQ plug-ins 
across all channels, repeatedly press the corresponding switch.

Global Input Switch

The Global Input switch toggles all applicable channels into 
Inline mode (Audio and Auxiliary Input tracks) or to display 
MIDI controls on the rotary encoders (Instrument tracks). 

See “Inline Console Mode” on page 135 and “MIDI Controls 
on Instrument Tracks” on page 51. 

Global Mic Pre Switch

The Global Mic Pre switch displays the controls for re-
mote-controlled microphone preamplifiers on the rotary en-
coders across all channels.

Global Channel Strip Mode controls
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Global Inserts Switch

The Global Inserts switch displays inserts on the rotary encod-
ers across all channels.

Global Pan Switch

The Global Pan switch displays the channel pan controls on 
the rotary encoders across all channels.

Global Sends Switch

The Global Sends switch displays the send controls on the ro-
tary encoders across all channels. 

Channel Strip Master Function Controls

The Channel Strip Master Function controls are used to 
change modes for the channel Select switches, channel dis-
plays, clear Solo and Mute states, and globally suspend auto-
mation. 

Escape Switch

The Escape switch is used to exit modes and to cancel opera-
tions or on-screen dialogs. When an action has occurred that 
can be exited or canceled with the Escape switch, the switch 
flashes. 

Channel Strip Master Function controls
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Select/Focus Mode Switch and Indicators

The Select/Focus Mode switch toggles the function of channel 
Select switches between Select and Focus mode. 

In Select mode, channel Select switches are used to select 
channels in Pro Tools. 

In Focus mode, channel Select switches are used to focus a 
channel’s controls on the Focus Channel Strip on the Main 
Unit. 

The LEDs on either side of this switch indicate the current 
mode. 

Solo Clear Switch

The Solo Clear switch clears all latched Solo switches in the 
session. This switch flashes when any channel is soloed. 

Mute Clear Switch

The Mute Clear switch clears all mutes for all tracks in the ses-
sion. This switch lights when any channel is muted. 

The Mute Clear action can be undone by pressing the Undo 
switch. 

Display Mode Switch

The Display Mode switch toggles the channel display between 
the five display modes: Track Name, Group/ Name, Channel 
Number/Name, Headroom Value, and Level modes. See 
“Channel Display” on page 55 for more information. 

Automation Suspend Switch

The Automation Suspend switch suspends reading and writ-
ing of all automation on all tracks in the session. All channels 
are left in their current automation mode, but automation op-
erations are temporarily suspended. 

The Automation Suspend switch flashes while automation is 
suspended. 
Custom Fader Controls

The Custom Fader controls invoke a special set of D-Control 
modes, called Custom Fader modes, which let you set aside and 
customize channel strips for display and editing of a variety of 
functions. The Custom Fader modes are Custom Groups mode, 
Mix/Edit Groups mode, Tracks mode, and Plug-in mode. See 
Chapter 13, “Custom Fader Modes” for complete information 
on Custom Fader modes.

Custom Faders Display

When a Custom Fader mode is active, the Custom Faders 
display shows the name of the Custom Group, Mix/Edit 
Group, or the plug-in displayed on the Custom Fader chan-
nels.

When no Custom Fader mode is active, the Custom Faders 
display shows the name of one of the plug-ins on the focused 
channel. (When you enter Custom Fader Plug-in mode, this 
plug-in will be displayed on the Custom Fader channels.)

Custom Switch

The Custom switch invokes Custom Groups mode, which lets 
you create a custom collection of channels and arrange them 
in any order in the Custom Fader channels. Custom Groups 
are unique to D-Control and are not reflected on-screen in 
Pro Tools. 

Groups Switch

The Groups switch invokes Mix/Edit Groups mode, which lets 
you create, edit, and recall Pro Tools Mix and Edit groups to 
the Custom Fader channels. 

Custom Fader controls
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Tracks Switch

The Tracks switch invokes Track Type mode, which lets you 
call any of the following track types to the Custom Fader 
channels: Master Faders, Audio Tracks, Auxiliary Inputs, MIDI 
Tracks, Instrument Tracks, or Hidden Tracks. 

In Track Type mode, the Bank Select switches in the Bank Se-
lect Matrix are used to select the track type to display. 

Plug-in Switch

The Plug-in switch invokes Plug-in mode, which lets you call 
the currently focused channel’s plug-in controls to the Cus-
tom Fader channels. 

Map Switch

The Map switch works with Custom Groups mode, Mix/Edit 
Groups mode, and Plug-in mode. While in these modes, the 
Map switch lets you further customize the control layout by 
mapping individual rotary encoder controls to faders within 
the Custom Fader channels. 

The Map switch has no effect on other D-Control channels in 
Normal mode. 

Flip Switch

The Custom Fader Flip switch works with Custom Groups 
mode, Mix/Edit Groups mode, and Plug-in mode. While in 
these modes, pressing the Flip switch transfers controls from 
the top row of encoders to the faders in the Custom Fader 
channels. Pressing the Flip switch additional times flips subse-
quent rows of encoders to the faders. The Custom Fader Flip 
switch has no effect on other D-Control channels in Normal 
mode. 
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Lock Switch

The Lock switch applies to Custom Fader Plug-in mode only. 
This switch locks the plug-in that is currently displayed in the 
Custom Faders display, so that it does not change when you 
focus a different channel in the Focus Channel strip. The Lock 
switch lights when the plug-in is locked.

When Custom Fader Plug-in mode is active, the locked 
plug-in appears in the Custom Fader channels, so you can fo-
cus a different channel on the Focus Channel Strip and keep 
the locked plug-in in the Custom Fader channels.

When Custom Fader Plug-in mode is not active, the locked 
plug-in appears in the Custom Faders display, so you can focus 
a different channel on the Focus Channel Strip and keep the 
locked plug-in in the Custom Faders display. (When you enter 
Custom Fader Plug-in mode, this plug-in will be displayed on 
the Custom Fader channels.)

Window Switch

The Window switch opens and closes the plug-in window 
on-screen for any plug-in whose name is displayed in the Cus-
tom Faders display. 

Bank/Cycle Switch

While in Custom Groups or Mix/Edit Groups mode, the 
Bank/Cycle switch is used to bank faders within the Custom 
Fader channels, if there are more channels than can be dis-
played at one time.

While in Custom Fader Plug-in mode, the Bank/Cycle 
switch cycles through the plug-ins on the focused channel, 
displaying their controls on the Custom Fader channels.

When no Custom Fader mode is active, the Bank/Cycle 
switch cycles through the plug-ins on the focused channel, 
displaying their names in the Custom Faders display. 



Automation Mode Controls

The Automation Mode controls are used to display and set au-
tomation modes. These switches light to indicate that at least 
one channel is in that automation mode. If multiple channels 
are selected and set to different automation modes, all appli-
cable mode switches are lit.

These Automation Mode controls mirror the function of the 
on-screen Automation Mode selector for each track, and let 
you change automation modes during playback. 

To set the automation mode of one or more channels:

1  Hold an Automation Mode switch (Write, Touch, Latch, 
Trim, Read, or Off). 

2  Press the Select switches on the channels whose automation 
mode you want to set.

To set the automation mode of one or more selected channels:

1  Press the Do To Selected switch.

2  Press the Select switches on the channels whose automation 
mode you want to set.

3  Press an Automation Mode switch (Write, Touch, Latch, 
Trim, Read, or Off). 

To set the automation mode of all channels:

1  Press the Do To All switch.

2  Press an Automation Mode switch (Write, Touch, Latch, 
Trim, Read, or Off). 

Write Switch

The Write switch indicates or sets the automation mode for 
the selected tracks to Write mode.

Touch Switch

The Touch switch indicates or sets the automation mode for 
the selected tracks to Touch mode. 

Latch Switch

The Latch switch indicates or sets the automation mode for 
the selected tracks to Latch mode. 

Automation Mode controls
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Trim Switch

The Trim switch indicates or sets the automation mode for the 
selected tracks to Trim mode. 

Read Switch

The Read switch indicates or sets the automation mode for the 
selected tracks to Read mode. 

Off Switch

The Off switch indicates or sets the automation mode for the 
selected tracks to Off. 

Talkback Switch

Two Talkback switches, located at the bottom of each Chan-
nel Strip Master section on the Main Unit, provide mirrored 
control of the D-Control Talkback function.

The Talkback switches can follow momentary or latched be-
havior. If held, the switch is active only when pressed down. 

If rapidly double-pressed, the switch latches on and flashes to 
indicate that talkback is active. Press the switch again to turn 
off talkback.

Talkback can be activated automatically. See “Auto Talkback 
Switch” on page 123 for more information.

Talkback level is set with the Talkback controls in the Monitor 
section. See “Talkback/Listen System” on page 122 for more 
information. 

Talkback switch

Talkback switch
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Chapter 7: Plug-in Controls
D-Control lets you assign, display and control plug-ins di-
rectly from the control surface in several ways. 

D-Control provides dedicated Dynamics and EQ sections for 
plug-ins that support Dynamics and EQ plug-in mapping. 
These sections include encoders and switches that map to 
standard controls for each plug-in type. 

Plug-ins of all types can be focused across multiple D-Control 
channels using Custom Fader Plug-ins mode. See “Custom 
Fader Plug-In Mode” on page 153. 

Plug-in Channel Formats

D-Control supports mono, stereo, multichannel and 
multi-mono plug-in channel formats. Multi-mono plug-ins 
comprise up to eight individual mono channels that can be 
linked in any combination. 

With D-Control, you can display, edit, and link specific chan-
nels of multi-mono Dynamics and EQ plug-ins directly from 
the Channel Select switches in the corresponding section.

Assigning and Removing Plug-ins
You can make plug-in assignments directly from D-Control in 
several ways. In Inserts mode, plug-ins can be added on an in-
sert-by-insert basis. In Assign Inserts mode you can assign 
plug-ins to insert positions on multiple tracks.

To assign a plug-in in Inserts mode:

1  Press the Inserts switch to display inserts on the channel 
where you want to assign the plug-in.

2  Do one of the following:

• If the insert location you want to use is empty, press the 
corresponding encoder Select switch.

– or –

• If a plug-in is already present in the insert location you 
want to use, press and hold the corresponding encoder 
Select switch.
3  At the insert position where you want to make the assign-
ment, turn the encoder knob to select from the first level of 
menu choices.

4  Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels. 

5  When the plug-in you want to assign is displayed, press the 
encoder Select switch to confirm your selection.

To assign plug-ins to multiple tracks:

1  Press the Assign Inserts switch to enter Inserts Assign mode. 
The first two send or insert positions will show on the encoder 
displays by default.

2  At the insert position where you want to make the assign-
ment, turn the encoder knob to select from the first level of 
menu choices.

3  Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels. 

4  When the plug-in you want to assign is displayed, press the 
encoder Select switch to confirm your selection.

5  Repeat steps 2–4 to make additional insert assignments.

6  Press the flashing Assign switch to confirm the assignments 
and exit Inserts Assign mode.

To remove a plug-in:

1  Press the Set to Default switch. 

2  Press the encoder Select switch for each plug-in you want to 
remove.

3  Press the flashing Set to Default switch to exit Set to Default 
mode.
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Default Plug-in Preferences

You can set a default EQ plug-in and default Dynamics plug-in 
in Pro Tools, which makes them available for quick assign-
ment from D-Control.

To set a default EQ or Dynamics plug-in:

1  In Pro Tools, choose Setup > Preferences and click Mixing. 

2  Under Setup, choose a plug-in from the Default EQ or De-
fault Dynamics pop-up menu.

3  Click OK to close the Preferences window.

To assign a default EQ or Dynamics plug-in on a D-Control 
channel:

Hold the EQ or Dyn switch on the channel and press the Se-
lect switch where you want to make the assignment. 

– or –

Do the following:

• Press the Inserts switch on the channel to enter Local As-
sign mode.

• Press the Select switch on the encoder where you want to 
make the assignment.

• Press the EQ or Dyn switch on the channel.

Focusing Plug-ins on D-Control
A plug-in is focused when its controls are mapped to the knobs, 
switches or faders on D-Control. Its parameters can then be 
edited and automated from the control surface. D-Control lets 
you focus a plug-in with or without displaying its window 
on-screen.

You can focus a plug-in in several ways: on the encoders of its 
channel; on the encoders of the Focus Channel Strip, and in 
the Custom Faders section. 

With dynamics and EQ plug-ins, you can also focus plug-in 
parameters on the dedicated Dynamics and EQ sections of 
D-Control.

To focus a plug-in on a channel strip:

1  Press the Inserts switch for the channel to display plug-in 
names on the channel’s encoders.

2  Press the encoder Select switch for the plug-in you want to 
focus. 

The controls of the focused plug-in appear on the channel’s 
encoders. You can page through the plug-in’s controls by 
pressing the Page Up and Page Down switches on the channel.
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To focus a plug-in on the Focus Channel Strip:

1  Focus the plug-in’s track on the Focus Channel Strip.

2  Press the Inserts switch on the channel. The plug-in names 
are displayed in the channel’s encoders.

3  Press the Select switch under the name of the plug-in you 
want to focus. The plug-in parameters are displayed in the Fo-
cus Channel Strip’s encoders. 

4  If there is more than one page of parameters for the plug-in, 
the Page Up or Page Down switches light. To move through 
parameter pages, press the corresponding switch.

To focus a plug-in in the Dynamics or EQ section:

1  Focus the plug-in’s track on the Focus Channel Strip by 
pressing the track’s Select switch. The first dynamics and EQ 
plug-ins on that track are automatically focused in the corre-
sponding D-Control section. 

2  Press the Cycle switch in the Dynamics or EQ section to fo-
cus successive dynamics or EQ plug-ins on that channel. (The 
No Insert option is always available.)

To focus a plug-in in the Custom Faders section:

1  Focus the plug-in’s track on the Focus Channel Strip by 
pressing the track’s Select switch. The first plug-in that is not a 
dynamics or EQ plug-in is automatically focused, and its name 
appears in the Custom Faders display. 

2  In the Custom Faders section, press the Bank/Cycle switch 
to cycle through the plug-ins on the focused channel. (The No 
Insert option is always available.)

The plug-in whose name appears in the Custom Faders display 
is then available for Custom Fader Plug-in mode. See “Custom 
Fader Plug-In Mode” on page 153.

Opening Plug-in Windows On-Screen
There are several ways to open plug-in windows on-screen 
from D-Control.

To open a plug-in window from any channel on D-Control:

Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the plug-in. 

To open a plug-in window on a focused track:

1  Focus a track in the Focus Channel Strip by pressing its Se-
lect switch. 

2  In the Custom Faders section, press the Bank/Cycle switch 
to cycle through the plug-ins on the focused track. Plug-in 
names are shown in the Custom Faders display. 

3  In the Custom Faders section, press the Win switch to open 
the plug-in whose name is displayed.



To open a focused Dynamics or EQ plug-in window:

Press the Window switch in the Dynamics or EQ section of 
D-Control.

To open or close all focused plug-in windows:

Press the Plug-in switch in the Window Management sec-
tion. 

To close all open plug-in windows:

Hold Alt (Windows) or Option (Mac) and press the Plug-in 
switch in the Window Management section. This closes all 
real-time and AudioSuite plug-in windows. 

To set D-Control to automatically open plug-in windows:

1  Press the Operation switch in the D-Control Soft Keys sec-
tion repeatedly to display the page that includes the Channel 
Window Display preference (“ChanWn”). 

2  Press the Soft Key that corresponds to “ChanWn” until its 
value is “Yes.”

With this preference set to “Yes,” when you assign a new 
plug-in, press an encoder Select switch to edit a plug-in, or cy-
cle through plug-ins on the focused track, the plug-in window 
will automatically open on-screen.

Managing Multiple Plug-in Windows
D-Control lets you open and swap multiple plug-in windows 
on-screen. This makes it possible keep plug-in windows open 
while focusing on different tracks (for example, in a session 
where several tracks have Dynamics and EQ plug-ins).

Targeting Plug-ins

A plug-in is said to be targeted on-screen when its target icon in 
the plug-in window header is lit red. The first plug-in window 
to be opened is automatically targeted. 

When a plug-in window is targeted, it is replaced when you 
open any new plug-in window. 

When a plug-in window is not targeted (when its target icon 
is grey) the plug-in window will remain on-screen.

To open multiple plug-in windows: 

Hold Shift while opening each new window. The new 
plug-in windows are not targeted.
To swap multiple plug-in windows while changing track focus:

1  Focus a track with multiple plug-ins (for example, dynam-
ics, EQ and Pitch Shift plug-ins) by pressing the track’s Select 
switch.

2  Open multiple plug-in windows on the focused track while 
holding the Shift modifier. 

3  Hold Alt (Windows) or Option (Mac) while changing focus 
to another track with multiple plug-ins by pressing the track’s 
Select switch. 

Focused plug-ins with open windows swap into new plug-in 
windows on-screen, wherever plug-ins are present in the new 
track. 

Making Plug-ins Inactive or Active
You can toggle the active/inactive status of a plug-in directly 
from a channel strip without putting D-Control into Make 
Inactive mode.

To toggle a plug-in active/inactive directly from a channel strip:

1  Press the Inserts switch on a channel strip to display the 
names of the plug-ins on the channel’s encoders.

2  Hold Control+Start (Windows) or Control+ Command 
(Mac) and press the encoder Select switch for the plug-in.

Changing Plug-in Presets from Channel 
Strips
You can activate next or previous settings in the Plug-in Li-
brarian menu directly from any channel strip on D-Control. 
These commands mirror the Next and Previous Setting but-
tons in the plug-in header.

To enable the next or previous plug-in setting from a channel 
strip:

1  Focus the plug-in in a channel strip so its controls are visible 
on the channel strip encoders.

2  Hold Control (Windows) or Command (Mac) and press the 
Page Up (Next) or Page Down (Previous) switch in that chan-
nel strip’s Channel Strip Mode controls.
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Copying and Pasting Plug-in Settings
You can copy plug-in settings from a plug-in and paste them 
into another instance of the same plug-in directly from a 
channel strip on D-Control, from either the top-level view or 
the focused view of the plug-in.

To copy and paste plug-in settings from the top level plug-in view:

1  On channel strips where you want to copy and paste the 
plug-in settings, press the Inserts switches to display the 
names of the plug-ins on the channel encoders. 

2  Copy the settings of a plug-in by holding Shift+Control 
(Windows) or Shift+Command (Mac) and pressing the en-
coder Select switch under the name of the plug-in. 

3  Paste the settings into another instance of the same plug-in 
by holding Shift+Control (Windows) or Shift+Command 
(Mac) and pressing the B/M/P switch under the name of that 
plug-in.

To copy and paste settings from the focused plug-in view:

1  On channel strips where you want to copy and paste the 
plug-in settings, focus the plug-ins on the channels so their 
controls are visible on the channel strip encoders. 

2  Copy the settings of a plug-in by holding Shift+Control 
(Windows) or Shift+Command (Mac) and pressing the en-
coder Select switch under the bottom row of encoders of the 
plug-in’s channel. 

3  Paste the settings into another instance of the same plug-in 
by holding Shift+Control (Windows) or Shift+Command 
(Mac) and pressing the B/M/P switches under the bottom row 
of encoders for that plug-in.

Enabling Plug-in Automation
When plug-in names are displayed in top-level view on a 
D-Control channel strip, you can quickly enable all parame-
ters of a plug-in for automation. 

You can also use the Do To All or Do To Selected switches on 
D-Control to automate multiple plug-ins in the same insert 
position in a session. 

You can use the Do To All and Do To Selected switches 
to copy and paste settings to all plug-ins at the same in-
sert position on all or all selected tracks.
D-Control Guide74
To toggle automation on and off for a parameter of a plug-in:

1  Press the Inserts switch in the Channel Strip Mode controls 
of a track to show the top level Inserts display. Plug-in names 
appear in the encoder displays of that track. 

2  Press an encoder Select switch to display a plug-in’s param-
eters on the rotary encoders. 

3  Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for the 
plug-in parameters you want to enable for automation.

To toggle automation on and off for all parameters of a plug-in:

1  Press the Inserts switch in the Channel Strip Mode controls 
of a track to show the top level Inserts display. Plug-in names 
appear in the encoder displays of that track. 

2  Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for the 
plug-in whose parameters you want to enable for automation.

To toggle automation on and off for all plug-ins in a given Insert 
position:

1  Press the Inserts switch in the Channel Strip Mode controls 
of a track to show the top level Inserts display. Plug-in names 
appear in the encoder displays of that track.

2  Press the Do To All switch in the Global controls section.

3  Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for any 
plug-in at the insert position (Insert 1–5) where you want to 
enable plug-in automation.

To toggle automation on and off for plug-ins in a given Insert 
position on all selected tracks:

1  Select the tracks containing the plug-ins you want to enable 
for automation.

2  Press the Inserts switch in the Channel Strip Mode controls 
of a track to show the top level Inserts display. Plug-in names 
appear in the encoder displays of that track.

3  Press the Do To Selected switch in the Global controls sec-
tion. 

4  Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for any 
plug-in at the insert position (Insert 1–5) where you want to 
enable plug-in automation.



Plug-in Mapping
You can put a plug-in into Learn mode, select parameters for 
mapping, and independently map two sets of plug-in param-
eters to each encoder or its associated B/M/P switch, all di-
rectly from the control surface.

You can map parameters to encoders and B/M/P switches in 
both the Custom Faders and in channel strips. 

When you put a plug-in into Learn mode, its track is focused 
in the Focus Channel strip and it is automatically put into 
Custom Fader Plug-in mode. In Learn mode, encoder displays 
for a focused plug-in are blank, showing that it is ready for 
mapping of parameters to the encoders and B/M/P switches. 

LrnTch (Learn Touch) Console Preference 

The Learn Touch preference (in the Operation Soft Keys) de-
termines whether controls are active when a plug-in is in 
Learn mode. When this preference is enabled, encoders and 
switches will not send commands to Pro Tools while in Learn 
mode, but will only allow Learn mode operations. This lets 
you select parameters for mapping from the control surface.

Plug-in Mapping and Channel Strips

D-Control plug-in map parameters are arranged in Channel 
Strip pages of 6 separately mappable encoders and switches. 
These pages are displayed one full page at a time on the 6 en-
coders in D-Control channel strips. 

Plug-in Mapping and Custom Fader Bank Size

D-Control plug-in map parameters are arranged in Custom 
Fader pages of 8 separately mappable encoders and switches. 

When plug-in mapping is displayed in Plug-in Custom Fader 
banks, the arrangement of plug-in map pages follows the set-
ting for Maximum Custom Fader Bank Size for Plug-Ins (in the 
Operation Soft keys).

By default, the Left Custom Fader Bank is used, unless the Left 
Custom Fader Bank Size (LCF) is set to 0 or the Left Custom 
Faders are locked. In these cases, the Right Custom Fader Bank 
is used. 

For complete instruction on creating and managing 
plug-in maps, see the Pro Tools Reference Guide.

You cannot map controls to the EQ and Dynamics 
sections of D-Control.

When creating and recalling plug-in maps, it is important 
to use the same Custom Fader Bank Size setting, so that 
plug-in maps display consistently. The examples in this 
section are for a Custom Fader Bank Size of 8 channels.
Putting a Plug-in into Learn Mode

You can put a plug-in into Learn mode directly from D-Con-
trol.

To put a plug-in into Learn mode from the control surface:

1  Focus the plug-in in Custom Fader mode.

2  Hold Start (Windows) or Control (Mac) and press the Map 
switch in the Custom Faders section.

To take a plug-in out of Learn mode from the control surface:

Hold Start (Windows) or Control (Mac) and press the flash-
ing Map switch in the Custom Faders section.

– or –

Press the Win switch in the Custom Faders section to close 
the plug-in window.

Creating and Editing Plug-in Maps

To create a custom map of plug-in parameters:

1  Make sure the LrnTch (Learn Touch) preference (in the Op-
eration Soft Keys) is set to On. 

2  Open the plug-in whose mapping you want to customize. 

3  Put the plug-in into Learn mode. The plug-in is focused with 
blank encoders and switches, ready for mapping.

4  On the control surface, do one of the following: 

• For an EQ or Dynamics plug-in, make sure a plug-in of 
the same type is displayed in the EQ or Dynamics section 
of the control surface.

– or –

• For all other plug-in types, display a different instance of 
the same plug-in type in a second location (for example, 
on a channel strip in Normal mode, or in another bank of 
Custom Faders).

5  Touch the encoder or press the switch for the parameter you 
want to map. The encoder’s auto LED or the switch’s Mute 
LED lights. 

6  On the encoder where you want to map the parameter, press 
the encoder Select switch to toggle between the two available 
views on the control.

7  Map the parameter by doing one of the following:

• Touch the encoder to map a continuous or a switched pa-
rameter, or press the B/M/P switch to map a switched pa-
rameter. 

– or –

• If D-Control is in Flip mode, touch the fader to map a 
continuous or a switched parameter, or press the channel 
Select switch to map a switched parameter. 

8  Take the plug-in out of Learn mode.
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To change parameter mapping in a plug-in map:

1  Make sure the LrnTch (Learn Touch) preference (in the Op-
eration Soft Keys) is set to On. 

2  Open the plug-in whose mapping you want to change. 

3  Choose the map you want to change from the Map Preset 
pop-up menu. 

4  Put the plug-in into Learn mode. The plug-in map is focused 
on the control surface.

5  On the control surface, do one of the following: 

• For an EQ or Dynamics plug-in, make sure a plug-in of 
the same type is displayed in the EQ or Dynamics section 
of the control surface.

– or –

• For all other plug-in types, display a different instance of 
the same plug-in type in a second location (for example, 
on a channel strip in Normal mode, or in another bank of 
Custom Faders).

6  Touch the encoder or press the switch for the parameter you 
want to map. The encoder’s auto LED or the switch’s Mute 
LED lights. 

7  Locate the encoder where you want to change the mapping, 
and if necessary, press the encoder Select switch to toggle be-
tween the two available views on the control.

8  Touch the encoder or press the B/M/P switch to map the pa-
rameter.

9  Take the plug-in out of Learn mode.

To remove parameter mapping from a plug-in map:

1  Make sure the LrnTch (Learn Touch) preference (in the Op-
eration Soft Keys) is set to On. 

2  Open the plug-in whose mapping you want to change. 

3  Choose the map you want to change from the Map Preset 
pop-up menu. 

4  Put the plug-in into Learn mode. The plug-in map is focused 
on the control surface.

5  Locate the encoder where you want to change the mapping, 
and if necessary, press the encoder Select switch to toggle be-
tween the two available views on the control.

6  Do one of following for each parameter mapping you want 
to remove:

• If the Parameter menu shows No Control, touch the en-
coder or press the B/M/P switch to remove the parameter 
mapping.

– or –

• If the Parameter menu shows the name of a preset, hold 
Control (Windows) or Command (Mac) and press the 
B/M/P switch to remove the parameter mapping.

7  Take the plug-in out of Learn mode.
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Changing Plug-in Map Presets

You can select the next or previous plug-in map for a plug-in 
directly from D-Control. 

To enable the next or previous plug-in map from a channel strip:

1  Focus the plug-in in the channel strip so its controls are vis-
ible on the channel strip encoders.

2  Hold Start (Windows) or Control (Mac) and press the Page 
Up (Next) or Page Down (Previous) switch in that channel 
strip’s Channel Strip Mode controls. The name of the plug-in 
map preset is shown momentarily in the bottom encoder dis-
play. 

To enable the next or previous plug-in map from the Custom 
Faders:

1  Focus the plug-in in the Custom Faders section. 

2  Hold Start (Windows) or Control (Mac) and press the Page 
Up (Next) or Page Down (Previous) switch in a Custom Fader 
channel. The name of the plug-in map preset is shown mo-
mentarily in the Custom Fader channel displays. 

To select the next or previous plug-in map on multiple 
channels, use the Do To All and Do To Selected switches 
on D-Control.



Displaying Dynamics Plug-in Gain 
Reduction on Channel Meters
You can display gain reduction metering for dynamics 
plug-ins directly on channel meters in Normal mode. When 
this metering mode is active, the D-Control channel meters 
show both track level and compressor gain reduction when 
you display the plug-in’s parameters on the channel encoders. 

Mono Tracks When a mono track is displayed on a D-Control 
channel strip, the channel’s left meter shows track level, and 
the channel’s right meter shows plug-in gain reduction. 

Multichannel Tracks When a multichannel track is displayed 
on a D-Control channel strip, the channel’s left meter shows 
the first channel’s level, and the channel’s right meter shows 
gain reduction. 

Center Meter Display When the 8-channel center meters on 
the D-Control Main Unit is set to display levels for the focused 
track, the center meters show levels for up to two output chan-
nels, plus input, output, gain reduction, and downward ex-
pansion for a dynamics plug-in on the focused track. 

To display dynamics plug-in gain reduction on channel meters:

1  In the Soft Keys section, press the Meter switch.

2  Press the Soft Key that corresponds to “GRChan” to turn on 
display of gain reduction. 

3  Press the Meter switch to exit.

4  On a channel with a dynamics plug-in, press the Dynamics 
switch in the Channel Strip Display controls to display the 
plug-in’s parameters on the channel strip encoders.

The dynamics plug-in gain reduction is displayed in the chan-
nel’s right meter, from the top down. 
To display dynamics plug-in gain reduction on the center meters:

1  In the Soft Keys section, press the Meter Prefs 1 switch.

2  Press the Soft Key that corresponds to “CtrMtr” to toggle the 
display to “Track.”

3  Press the Soft Key that corresponds to “GRChan” to turn on 
display of gain reduction. 

4  Press the Meter Prefs 1 switch to exit.

5  Focus a channel with a dynamics plug-in on the Focus 
Channel Strip.

6  Press the Dynamics switch in the Focus Channel Strip Dis-
play controls to display the plug-in’s parameters on the Focus 
Channel Strip encoders.

The dynamics plug-in input level, output level, gain reduc-
tion, and downward expansion are displayed in the rightmost 
center meters, from the top down. 
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Dynamics Section
The Dynamics section includes standard controls for compressor, gate, and limiter plug-ins, an array of controls for managing the 
display and editing of plug-in parameters, and selecting or linking channels in multi-mono plug-ins.
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D-Control Dynamics section

Knee/Hysteresis Attack Gain/Hold

Ratio/Range Release Threshold Gain Reduction
meters

Input and Output
meters

Low Filter High Filter
Level controls

Channel Select
switches

Dynamics Edit and Display controls

controlscontrolscontrols

control

controlcontrols

controls control
Dynamics Plug-in Support

Dynamics processing plug-ins may have widely varying con-
trols, depending on their applications. The D-Control Dynam-
ics Section provides dedicated knobs and switches to accom-
modate the widest range of plug-ins possible. Not all plug-ins 
will require all the Dynamics controls, while others may have 
more parameters than can be displayed in the Dynamics sec-
tion at one time. To display all controls in any plug-in, you 
can use Custom Fader Plug-ins mode.
Displaying Dynamics Plug-ins

The D-Control Dynamics section automatically focuses the 
first dynamics plug-in on the channel displayed in the Focus 
Channel Strip on the Main Unit. 

To display successive dynamics plug-ins that are on the fo-
cused channel, press the Cycle switch in the Dynamics sec-
tion.



Knee/Hysteresis and Ratio/Range Controls

Knee/Hysteresis Control

The top encoder in this section controls the knee shape or the 
hysteresis value for the current plug-in page, depending on 
which indicator is lit. The Auto indicator under the encoder 
knob lights when the displayed parameter is enabled for auto-
mation. 

Ratio/Range Control

The bottom encoder in this section controls the compression 
ratio or the range value for the current plug-in page, depend-
ing on which indicator is lit. The Auto indicator under the en-
coder knob lights when the displayed parameter is enabled for 
automation.

Knee/Hysteresis and Ratio/Range controls in the Dynamics section

Knee/Hysteresis
encoder

Hysteresis
indicator

Knee
indicator

Ratio/Range
encoder

Ratio
indicator

Range
indicator
Attack and Release Controls

Attack Control

The top encoder in this section controls the attack value for 
the current plug-in. The Auto indicator under the encoder 
knob lights when the parameter is enabled for automation. 

Release Control

The bottom encoder in this section controls the release value 
for the current plug-in. The Auto indicator under the encoder 
knob lights when the parameter is enabled for automation. 

Attack and Release controls in the Dynamics section

Attack
encoder

Release
encoder
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Gain/Hold and Threshold Controls

Gain/Hold Control

The top encoder in this section controls the gain (make-up 
gain) or the hold value for the current plug-in page, depend-
ing on which indicator is lit. The Auto indicator under the en-
coder knob lights when the displayed parameter is enabled for 
automation. 

Threshold Control

The bottom encoder in this section controls the threshold 
value for the current plug-in page. The Auto indicator under 
the encoder knob lights when the parameter is enabled for au-
tomation. 

Gain/Hold and Threshold controls in the Dynamics section

Gain/Hold
encoder

Hold
indicator

Gain
indicator

Threshold
encoder
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Low Filter and High Filter Controls

The Dynamics section includes controls for high- and low-fre-
quency EQ filters available on certain dynamics plug-ins. 

Filter Frequency Encoders

The top encoders in these sections control the filter frequency 
for each filter. When the filter is a notch filter, these encoders 
control the center frequency. When the filter is a high-pass or 
low-pass filter, these encoders control the cutoff frequency. 

Q/Slope Encoders

The bottom encoders in these sections control the Q value (for 
notch filters) or the slope of the cutoff (for high-pass or 
low-pass filters). 

Notch/Shelf Switch and Indicators

The Notch/Shelf switches in these sections let you switch be-
tween the two filter types when they are available. The indica-
tors above the switch light to show which type of filter is ac-
tive. 

Filter In Switches

The Filter In switches in these sections let you engage or by-
pass each filter independently. 

Low Filter and High Filter controls in the Dynamics section

Filter Frequency
encoders
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Dynamics Channel Select Controls
Channel Select controls in the Dynamics section

Dynamics displays

Master Link switch

Bypass indicator

Select/Link/Bypass Mode switch

Channel Select switches
Dynamics Displays

The LED displays in the Dynamics section show the name of 
the focused plug-in by default. When any rotary encoder is 
touched, these displays show the corresponding parameter 
name and value. 

Channel Select Switches

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem and the Channel Select switches 
have no effect. 

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the con-
trols for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels 
of a multi-mono plug-in by using the Channel Select switches 
to unlink all of the channels, or to link specific channels.

There are Channel Select switches for the following channels: 

• L (Left)

• Lc (Left Center)

• C (Center)

• Rc (Right Center)

• R (Right)

• Ls (Left Surround)

• Cs (Center Surround)

• Rs (Right Surround)

• LFE

These choices support all possible channel configurations in 
Pro Tools. A maximum of eight channels (7.1 surround) may 
be in use at any time.
Master Link Switch

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem, and the Master Link switch has 
no effect.

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the Master 
Link switch toggles the Master Link button in the plug-in win-
dow, which links or unlinks all channels of the plug-in. When 
the Master Link button is enabled, the Link switch is lit.

Select/Link/Bypass Mode Switch

The Select/Link/Bypass Mode switch determines the function 
of the Channel Select switches with multi-mono plug-ins. 

Select Mode In this mode, the Channel Select switches deter-
mine which channel of a multi-mono plug-in is the focus of 
the plug-in controls. When a channel is selected, its switch is 
lit. If any channels are linked, their switches follow linked be-
havior.

In Select mode, if the D-Control Channel Window Display 
preference is set to Yes, the Channel Select switches also 
change the channel display in the plug-in window.

Bypass Mode In this mode, the Channel Select switches deter-
mine which channels of a multi-mono plug-in are bypassed. 
When a channel is bypassed, its switch is lit. If any channels 
are linked, their switches follow linked behavior.

Link Mode In this mode, the Channel Select switches deter-
mine which individual channels of a multi-mono plug-in are 
linked together. Linked channels are indicated by switches 
that are lit.
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Dynamics Edit and Display Controls
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Edit and Display controls in the Dynamics section

Page switch

External Key switch

Compare switch

Cycle switch

Bypass switch

Key Listen
switch

Save As
switch

Lock
switch

Automation switch

Automation Safe switch

Window switch
Page Switch

With plug-ins that have more than one page of controls, the 
Page switch lights. Pressing this switch steps through the 
pages for the currently displayed plug-in.

Active paged controls are shown in the plug-in window by col-
ored outlines.

External Key Switch

The External Key switch turns the Key Input on or off for 
plug-ins that support side-chain processing with external in-
put. This switch lights when Key Input is on.

Key Listen Switch

The Key Listen switch turns the Key Listen function on or off 
for plug-ins that support auditioning the Key Input. This 
switch lights when Key Listen is on.
Save As Switch

The Save As switch performs the Save As command in the 
Plug-in settings menu.

To save a Dynamics plug-in setting from D-Control:

1  Press the Save As switch in the Edit and Display controls of 
the Dynamics section. The Save As switch flashes while the 
Save Settings dialog is open.

2  Type a name for the plug-in setting.

3  Do one of the following:

• Click OK to save the settings and close the dialog. 

• Press the flashing Save As switch to save the settings and 
close the dialog.

• Press the Escape switch to exit the dialog without saving 
the settings.



Lock Switch

The Lock switch is used to lock the focus of the Dynamics sec-
tion on the current plug-in. When the plug-in focus is locked, 
the current plug-in remains in the Dynamics section, even 
when a different track is focused on D-Control. This switch 
lights when the plug-in focus is locked. 

Compare Switch

The Compare switch toggles the Compare button in the 
plug-in window, which alternates between the currently saved 
plug-in setting and any changes you have made.

Automation Switch

The Automation switch lets you enable Dynamics parameters 
for automation by touching or pressing their controls in the 
Dynamics section only. 

In Automation mode, the Auto switch is lit. While in this 
mode, the Auto LED for any rotary encoder enabled for auto-
mation is lit red, and the switch for any parameter enabled for 
automation is lit. 

To toggle automation on and off for individual Dynamics 
parameters:

1  Press the Automation switch.

2  Touch the rotary encoders or press the switches in the Dy-
namics section for which you want to toggle automation. 

3  Press the Automation switch again to exit Automation 
mode. 

To toggle automation on and off for all parameters of a Dynamics 
plug-in:

1  Press the Automation switch.

2  Do one of the following:

• Hold Alt (Windows) or Option (Mac).

– or –

• Hold Do to All.

3  Touch any rotary encoder or press any switches in the Dy-
namics section. 

4  Press the Automation switch again to exit Automation 
mode. 
Safe Switch

The Safe switch toggles the Safe button in the plug-in window, 
which protects existing automation for that plug-in from be-
ing overwritten. 

Cycle Switch

The Cycle switch steps through all available Dynamics 
plug-ins on the focused channel. 

Bypass Switch

The Bypass switch bypasses the plug-in. 

Window Switch

The Window switch is used to open and close the on-screen 
window for the currently focused plug-in. 
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Dynamics Gain Controls and Meters
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Input and Output Gain Encoders

The Input and Output Gain encoders control the input gain and output gain for the current plug-in. The Auto indicator under 
each encoder knob lights when the parameter is enabled for automation. 

Input and Output Meters and Clip Indicator

The Input and Output meters show the input and output levels for the current plug-in. The Clip indicator lights when a clip is 
reported by the plug-in, and can be cleared by pressing the Clear Clip switch in the Session Management section. 

Gain Reduction Meters

The Gain Reduction meters show the amount of gain reduction for Compressor/Limiter functions (on the left) and Ex-
pander/Gate functions (on the right). 

You can also display gain reduction metering for dynamics plug-ins directly on channel meters in Normal mode. See “Displaying 
Dynamics Plug-in Gain Reduction on Channel Meters” on page 77.

Level controls (left) and meters (right) in the Dynamics section

Input Gain encoder

Output Gain encoder

Clip indicator

Input meter Output meter
Compressor/Limiter

Gain Reduction
meter

Expander/Gate
Gain Reduction
meter



EQ Section
The EQ section includes standard controls for a variety of multi-band plug-ins, an array of controls for managing the display and 
editing of plug-in parameters, and controls for selecting or linking channels in multi-mono plug-ins.
D-Control EQ section

High-Pass
Filter

Low
Filter

Low-Mid
Filter

Mid
Filter

High-Mid
Filter

High
Filter

Low-Pass
Filter Level

controls
Channel Select

switches

Input and Output metersEQ Edit and Display controls

controls controls controlscontrolscontrolscontrolscontrols
EQ Plug-in Support

EQ processing plug-ins may have widely varying controls, de-
pending on their applications. The D-Control EQ Section pro-
vides dedicated knobs and switches to accommodate the wid-
est range of plug-ins possible. Not all plug-ins will require all 
the EQ controls, while others may have more parameters than 
can be displayed in the EQ section at one time. 

To simultaneously display all controls in any plug-in, you can 
use Custom Fader Plug-ins mode.
Displaying EQ Plug-ins

The D-Control EQ section automatically displays the first EQ 
plug-in on the channel that is focused in the Focus Channel 
Strip on the Main Unit. 

To display successive EQ plug-ins that are on the focused 
channel, press the Cycle switch in the EQ section.
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High-Pass Filter and Low-Pass Filter 
Controls

There are similar controls for high-pass and low-pass filters on 
the extreme left and right sides of the EQ section.

Q Encoders

The top encoders for these EQ bands control the Q of each fil-
ter. The Auto indicator under each encoder knob lights when 
the parameter is enabled for automation.

Notch/Shelf Switches and Indicators

The Notch/Shelf switches in these EQ bands let you switch be-
tween the two filter types when they are available. The indica-
tors on either side of the switch light to show which type of fil-
ter is active.

Frequency Encoders

The bottom encoders in these EQ bands control the filter fre-
quency for each filter. When the filter is a notch filter, these 
encoders control the center frequency. When the filter is a 
high-pass or low-pass filter, these encoders control the cutoff 
frequency. The Auto indicator under each encoder knob lights 
when the parameter is enabled for automation.

Band In Switches

The Band In switches in these EQ bands let you engage or by-
pass their corresponding EQ band in the plug-in. 

High-Pass Filter and Low-Pass Filter controls in the EQ section

Q encoders

Notch/Shelf switches
and indicators

Frequency encoders

Filter In switches
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Low Shelf/Peak and High Shelf/Peak 
EQ Controls

There are similar controls for the low and high shelf/peak EQ 
bands on the left and right sides of the EQ section, just inside 
the high-pass and low-pass filter controls.

Q Encoders

The top encoders for these EQ bands control the Q of each 
band. The Auto indicator under each encoder knob lights 
when the parameter is enabled for automation.

Notch/Shape Switch and Indicators

The Notch/Shape switches in these EQ bands let you switch 
between the two EQ types when they are available. The indi-
cators on either side of the switch light to show which type of 
EQ is active.

Frequency Encoders

The middle encoders in these EQ bands control the frequency 
for each band. When the EQ is a peaking type, these encoders 
control the center frequency. When the EQ is a high- or 
low-shelf type, these encoders control the cutoff frequency. 
The Auto indicator under each encoder knob lights when the 
parameter is enabled for automation.

Gain Encoders

The bottom encoders in these EQ bands control the gain for 
each band. The Auto indicator under each encoder knob lights 
when the parameter is enabled for automation.

Band In Switches

The Band In switches in these EQ bands let you engage or by-
pass their corresponding EQ band in the plug-in. 

Low Filter and High Filter controls in the EQ section

Q encoders

Notch/Shape switches
and indicators

Frequency encoders

Band In switches

Gain encoders



Low-Mid, Mid, and High-Mid EQ Band Controls

There are similar controls for low-mid, mid, and high-mid EQ bands in the center of the EQ section.
Q Encoders

The top encoders for these EQ bands control Q values for each band. The Auto indicator under each encoder knob lights when 
the parameter is enabled for automation.

Frequency Encoders

The middle encoders in these EQ bands control the center frequency for each band. The Auto indicator under each encoder knob 
lights when the parameter is enabled for automation.

Gain Encoders

The bottom encoders in these EQ bands control the gain for each band. The Auto indicator under each encoder knob lights when 
the parameter is enabled for automation.

Band In Switches

The Band In switches in these EQ bands let you engage or bypass the corresponding EQ band in the plug-in. 

Low-Mid, Mid and High-Mid EQ band controls in the EQ section

Q encoders

Frequency encoders

Gain encoders

Band In switches
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EQ Channel Select Controls
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Channel Select controls in the EQ section

EQ displays

Link switch

Select/Link/Bypass Mode switch

Channel Select switches

Bypass indicator
EQ Displays

The LED displays in the EQ section show the name of the fo-
cused plug-in by default. When any rotary encoder is touched, 
these displays show the corresponding parameter name and 
value. 

Channel Select Switches

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem and the Channel Select switches 
have no effect, except with multichannel plug-ins (such as 
Focusrite d2) that directly support channel selection.

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the con-
trols for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels 
of a multi-mono plug-in by unlinking all of the channels, or 
by using the Channel Select switches to link specific channels.

There are Channel Select switches for the following channels: 

• L (Left)

• Lc (Left Center)

• C (Center)

• Rc (Right Center)

• R (Right)

• Ls (Left Surround)

• Cs (Center Surround)

• Rs (Right Surround)

• LFE

These choices support all possible channel configurations in 
Pro Tools. A maximum of eight channels (7.1 surround) may 
be in use at any time.
Master Link Switch

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem, so the Master Link switch has 
no effect, except with multichannel plug-ins (such as 
Focusrite d2) that directly support channel linking.

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the Master 
Link switch toggles the Master Link button in the plug-in win-
dow, which links or unlinks all channels of the plug-in. When 
the Master Link button is enabled, the Link switch is lit.

Select/Link/Bypass Mode Switch

The Select/Link/Bypass Mode switch determines the function 
of the Channel Select switches with multi-mono plug-ins. 

Select Mode In this mode, the Channel Select switches deter-
mine which channel of a multi-mono plug-in is the focus of 
the plug-in controls. When a channel is selected, its switch is 
lit. If any channels are linked, their switches follow linked be-
havior.

In Select mode, if the D-Control Channel Window Display 
preference is set to Yes, the Channel Select switches also 
change the channel display in the plug-in window.

Bypass Mode In this mode, the Channel Select switches deter-
mine which channels of a multi-mono plug-in are bypassed. 
When a channel is bypassed, its switch is lit. If any channels 
are linked, their switches follow linked behavior.

Link Mode In this mode, the Channel Select switches deter-
mine which individual channels of a multi-mono plug-in are 
linked together. Linked channels are indicated by switches 
that are lit.



EQ Edit and Display Controls
Edit and Display controls in the EQ section

Compare switch

Cycle switch

Master Bypass switch

Save As
switch

Lock
switch

Automation switch

Automation Safe switch

Window switch
Save As Switch

The Save As switch performs the Save As command in the 
Plug-in settings menu, which saves a new settings file for the 
plug-in.

To save an EQ plug-in setting from D-Control:

1  Press the Save As switch in the Edit and Display controls of 
the Dynamics section. The Save As switch flashes while the 
Save Settings dialog is open.

2  Type a name for the plug-in setting.

3  Do one of the following:

• Click OK to save the settings and close the dialog. 

• Press the flashing Save As switch to save the settings and 
close the dialog.

• Press the Escape switch to exit the dialog without saving 
the settings.

Lock Switch

The Lock switch is used to lock the focus of the EQ section on 
the current plug-in. When the plug-in focus is locked, the cur-
rent plug-in remains in the EQ section, even when a different 
track is focused on D-Control. This switch lights when the 
plug-in focus is locked. 

Compare Switch

The Compare switch toggles the Compare button in the 
plug-in window, which alternates between the currently saved 
plug-in setting and any changes you have made.
Automation Switch

The Automation switch lets you enable EQ parameters for au-
tomation by touching or pressing their controls in the EQ sec-
tion only. 

In Automation mode, the Auto switch is lit. While in this 
mode, the Auto indicator for any rotary encoder enabled for 
automation is lit red, and the switch for any parameter en-
abled for automation is lit. 

To toggle automation on and off for individual EQ parameters:

1  Press the Automation switch.

2  Touch the rotary encoders or press the switches in the EQ 
section for which you want to toggle automation. 

3  Press the Automation switch again to exit Automation 
mode. 

To toggle automation on and off for all parameters of an EQ 
plug-in:

1  Press the Automation switch.

2  Do one of the following:

• Hold Alt (Windows) or Option (Mac).

– or –

• Hold Do to All.

3  Touch any rotary encoder or press any switches in the EQ 
section. 

4  Press the Automation switch again to exit Automation 
mode. 
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Safe Switch

The Safe switch toggles the Safe button in the plug-in window, 
which protects existing automation for that plug-in from be-
ing overwritten. 

Cycle Switch

The Cycle switch steps through all available EQ plug-ins on 
the focused channel. 

Bypass Switch

The Bypass switch bypasses the plug-in. 

Window Switch

The Window switch is used to open and close the on-screen 
window for the currently focused plug-in. 
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EQ Level Controls and Meters

Input and Output Gain Encoders

The Input and Output Gain encoders control the input gain 
and output gain for the current plug-in. The Auto indicator 
under each encoder knob lights when the parameter is en-
abled for automation. 

Input and Output Meters and Clip Indicator

The Input and Output meters show the input and output lev-
els for the current plug-in. The Clip indicator lights when a 
clip is reported by the plug-in, and can be cleared by pressing 
the Clear Clip switch in the Session Management section. 

Level controls and meters in the EQ section

Input Gain encoder

Output Gain encoder

Clip indicator

Input meter Output meter



Chapter 8: Transport and Navigation Controls

Transport Section
The D-Control Transport section includes two complete sets of transport switches, switches for setting the transport mode, 
scrub/shuttle switches and controls, and advanced audition and locate switches. 
D-Control Transport Section

Scrub/Shuttle
switches and controlsMachine Transport

switches

Pro Tools Transport
switches

External Machines
switches

Online switches

Transport Mode switchesAudition switches

Locate switches

Master Record Mode
switches
Transport Switches

D-Control has two sets of transport switches, one for 
Pro Tools, and the other reserved for external machines con-
trolled with Digidesign MachineControl. 

Pro Tools Transport

The D-Control Pro Tools Transport switches correspond to the 
controls in the Pro Tools Transport window.

Rewind Switch Moves backward through the Pro Tools session 
beginning from the current cursor position. 

Pro Tools Transport switches

Rewind Fast
Forward

Stop Play Record

MIDI Merge
indicator
Fast Forward Switch Moves forward through the Pro Tools ses-
sion beginning from the current cursor position. 

Stop Switch Stops playback of the Pro Tools session.

Play Switch Begins playback of the Pro Tools session from the 
current cursor position. 

Record Switch Arms Pro Tools for recording. Exact function 
depends on current Pro Tools record mode (QuickPunch, 
TrackPunch, Wait for Note, Pause). 

MIDI Merge Indicator Shows when MIDI Merge is activated.

Machine Transport

With Digidesign MachineControl, you can place D-Control in 
Dual Transport mode, which activates the Machine Transport 
switches. These switches can then be assigned to control an 
external 9-pin or MMC device.
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Scrub/Shuttle Controls

The Scrub/Shuttle controls are used for the following:

• Edit cursor operations, including scrubbing, scrubbing 
while trimming, shuttling, and making selections.

• Zooming, Pro Tools window navigation, and banking faders 
on D-Control. 

Scrub/Shuttle Wheel

The Scrub/Shuttle wheel is used to control cursor position in 
Pro Tools, and for zooming, window navigation, and banking 
faders. 

Scrolling and Locating in Pro Tools Windows

To horizontally scroll the contents of the Edit window or Mix 
window:

1  Focus the window you want to scroll by clicking in it or by 
pressing the corresponding window key in the Window Man-
agement section.

2  Hold Alt (Windows) or Option (Mac) while turning the 
Scrub/Shuttle Wheel. 

To vertically scroll the contents of the Edit window or Mix 
window:

1  Focus the window you want to scroll by clicking in it or by 
pressing the corresponding window key in the Window Man-
agement section.

2  Hold Shift while turning the Scrub/Shuttle Wheel. 

To locate the cursor in the Edit window while in Continuous Scroll 
Mode:

Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and press the Mark In or Mark Out switch 
in the Audition section. 

Scrub/Shuttle controls

Scrub
switch

Trim
switch

Shuttle
switch

Scrub/Shuttle
Wheel
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Selecting with the Scrub/Shuttle Wheel

To create selections with the Scrub/Shuttle wheel:

1  Locate the cursor in a track. 

2  Press the Scrub switch or the Shuttle switch.

3  Do one of the following:

• Hold the Mark In switch and turn the Scrub/Shuttle 
wheel counter-clockwise to create or extend the selection 
to the left. 

– or –

• Hold the Mark Out switch and turn the Scrub/Shuttle 
wheel clockwise to create or extend the selection to the 
right. 

To scrub while adding to the front of a selection:

Hold Start+Shift (Windows) or Control + Shift (Mac) while 
scrubbing the front of the selection.

To scrub while adding to the end of a selection:

Hold Start+Shift+Alt (Windows) or Control+Shift+Option 
(Mac) while scrubbing the end of the selection.

To scrub with fine resolution while adding to the front of a 
selection:

Hold Start+Shift+Control (Windows) or Con-
trol+Shift+Command (Mac) while scrubbing the front of the 
selection.

To scrub with fine resolution while adding to the end of a 
selection:

Hold Start+Shift+Alt+Control (Windows) or Con-
trol+Shift+Option+Command (Mac) while scrubbing the end 
of the selection.

Continuous Zooming in the Edit Window

To horizontally zoom continuously in the Edit window:

Hold Control (Windows) or Command (Mac) while turning 
the Scrub/Shuttle Wheel.

To vertically zoom continuously in the Edit window:

Hold Control+Alt (Windows) or Command+Option (Mac) 
while turning the Scrub/Shuttle Wheel.

Moving Windows On-Screen with the Scrub/Shuttle Wheel

To move a Pro Tools window horizontally on-screen:

In the Window Management section, hold the switch for 
the window and turn the Scrub/Shuttle wheel. 



To move a Pro Tools window vertically on-screen:

In the Window Management section, hold the switch for 
the window, hold Shift, and turn the Scrub/Shuttle wheel. 

Nudging Track Position or Focus on D-Control with the
Scrub/Shuttle Wheel

To nudge the position of tracks on D-Control in Normal mode:

Hold any of the Nudge/Bank switches and turn the 
Scrub/Shuttle wheel.

To nudge the position of tracks on D-Control in Custom Faders:

Hold the Bank/Cycle switch in the Custom Faders section 
and turn the Scrub/Shuttle wheel.

To nudge the track focused in the Focus Channel Strip:

1  Hold Control (Windows) or Command (Mac) and press the 
left or right Nudge 1 switch. 

2  While holding the Nudge1 switch, turn the Scrub/Shuttle 
wheel.

Scrub Switch

The Scrub switch places the transport in Scrub mode, which 
lets you scrub from the cursor position or across a selection. 

To scrub audio in Scrub mode:

1  While Pro Tools is stopped, press the Scrub switch.

2  Rotate the Scrub/Shuttle wheel clockwise to scrub audio for-
ward, or counter-clockwise to scrub audio backward.

3  To exit, press the Scrub switch again.

Scrubbing Without Entering Scrub Mode

You can use the Scrub/Shuttle Wheel to scrub while the trans-
port is stopped or during playback, without entering Scrub 
mode. 

To scrub during playback:

1  Click in a track you want to scrub.

2  Hold Start (Windows) or Control (Mac) while turning the 
Scrub/Shuttle Wheel.

To latch the Scrub/Shuttle Wheel in scrub:

Press Start (Windows) or Control (Mac) momentarily (less 
than 1/2 second) while turning the Scrub/Shuttle Wheel.

To scrub with fine resolution:

Hold Start+Control (Windows) or Control+Command 
(Mac) while turning the Scrub/Shuttle Wheel.
Trim Switch

The Trim switch places the transport in Trim/Scrub mode, 
which lets you scrub to locate an edit point, then trim to that 
point.

To scrub while trimming:

1  Navigate to a region or selection you want to trim.

2  Press the Trim switch.

3  Press the Scrub switch.

4  Rotate the Scrub/Shuttle wheel to move the cursor to the 
trim location.

5  To trim to the cursor location or to the beginning of the se-
lection, press the Trim switch again. 

Shuttle Switch

The Shuttle switch places the transport in Shuttle mode, 
which lets you locate the cursor in the Edit window 

To use Shuttle mode:

1  While Pro Tools is stopped, press the Shuttle switch.

2  Rotate the Scrub/Shuttle wheel clockwise to shuttle forward, 
or counter-clockwise to shuttle backward. 

3  To exit, press the Shuttle switch again.

Scrub, Trim/Scrub and Shuttle modes can be used to create se-
lections and define regions in the Pro Tools Edit window. 

To trim to the end of a selection, hold Alt (Windows) or 
Option (Mac) while pressing the Trim switch.
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Master Record Mode Switches

The Master Record Mode switches are used to change the 
record enable and the input monitoring mode of all channels 
in a session. 

Master Record Enable Switch

The Master Record Enable switch toggles record enable status 
for all applicable audio tracks in a session. This switch flashes 
when channels are record-enabled and the Pro Tools transport 
is stopped, and lights continuously during recording.

If any tracks in the session are record-enabled, pressing the 
Master Record Enable switch takes them out of their enabled 
state. If no channels are record-enabled, pressing the Master 
Record Enable switch places all applicable audio tracks into 
record-enabled state.

Master Input Monitor Mode Switch

The Master Input Monitor Mode switch toggles the input 
monitoring mode for all record-enabled audio tracks in a ses-
sion. (This is the same as choosing the “Change Record En-
abled Tracks to Auto Input” or “Input Only” in Pro Tools.) 
This switch lights only when there are record-enabled tracks 
in Input Only mode.

To toggle the input monitoring mode of all audio tracks in a 
session, hold Alt (Windows) or Option (Mac) while pressing 
the Master Input Monitor Mode switch.

Master Record Mode switches

Master Record Enable switch

Master Input Monitor Mode switch
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Transport Mode Switches

The Transport Mode switches are used to put the Pro Tools 
transport in the various playback and record modes. 

Pro Tools Online Switch

The Pro Tools Online switch toggles the Pro Tools online 
state. The online state is mirrored in the Online button in the 
Pro Tools Transport window.

While Pro Tools is online and waiting for time code, this 
switch flashes. When time code is received, this switch lights 
continuously. 

9-Pin Remote Switch

The 9-Pin Remote switch enables 9-pin Remote Deck Emula-
tion mode with Digidesign MachineControl. 

Machine Online Switch

With Digidesign MachineControl, the Machine Online switch 
toggles the external machine online status. You can cycle the 
Pro Tools Transport Master by holding Start (Windows) or 
Control (Mac) and pressing the Machine Online switch. 

Loop Playback Switch

The Loop Playback switch toggles Loop Playback mode in 
Pro Tools. When Loop Playback mode is active, this switch 
lights. The Loop Playback state is mirrored in the Play button 
in the Pro Tools Transport window.

QuickPunch Switch

The QuickPunch switch toggles QuickPunch record mode in 
Pro Tools. When QuickPunch mode is active, this switch 
lights. The QuickPunch state is mirrored in the Record button 
in the Pro Tools Transport window.

TrackPunch Switch

The TrackPunch switch toggles TrackPunch record mode in 
Pro Tools. When TrackPunch mode is active, this switch 
lights. The TrackPunch state is mirrored in the Record button 
in the Pro Tools Transport window.

Transport Mode switches

Pro Tools Online
switch

9-Pin Remote
switch

Loop Playback
switch

Machine Online
switch

TrackPunch
switch

QuickPunch
switch



Audition Switches

The Audition switches are used to activate pre-roll and 
post-roll in playback, define selection in and out points, and 
trigger automatic playback of ranges. 

Audition Switch

The Audition switch toggles Audition mode on and off. When 
Audition mode is on, this switch lights. 

When Audition mode is on, you can quickly listen to either 
the start or end of a selection, with or without pre-roll or 
post-roll, by pressing the following switches:

Pre-Roll Switch Plays audio starting at the pre-roll point up to 
the beginning of the selection. 

Mark In Switch Plays audio starting at the selection start 
through the length of the post-roll amount.

Mark Out Switch Plays audio back-timed from the selection 
end by the pre-roll amount.

Post-Roll Switch Plays audio starting at the end of a selection 
through the post-roll amount. 

Pre-Roll and Post-Roll Switches

When Audition mode is off, the Pre-Roll and Post-Roll 
switches toggle pre-roll and post-roll playback on and off in 
Pro Tools. When pre-roll or post-roll is active, the correspond-
ing switch lights.

When Audition mode is on, the Pre-Roll and Post-Roll 
switches play a range of audio around the current Edit selec-
tion.

Audition switches

Audition
switch

Pre-Roll
switch

Mark In
switch

Mark Out
switch

Post-Roll
switch
Mark In and Mark Out Switches

When Audition mode is off, the Mark In and Mark Out 
switches are used to define selection start and end during play-
back, or when using the Scrub/Shuttle wheel. 

When Audition mode is on, the Mark In and Mark Out 
switches play a range of audio around the current Edit selec-
tion. 

To move the selection start: 

With the transport stopped, hold the Mark In switch and turn 
the Scrub/Shuttle wheel. 

To move the selection end:

With the transport stopped, hold the Mark In switch and turn 
the Scrub/Shuttle wheel. 

To move the entire selection:

With the transport stopped, hold both the Mark In and Mark 
Out switches and turn the Scrub/Shuttle wheel. 

Locate Switches

The Locate switches move the Pro Tools transport to the des-
ignated location. 

Go To Start Switch

The Go To Start switch returns the playback cursor to the be-
ginning of the session. 

Go to End Switch

The Go To End switch moves the playback cursor to the end of 
the session.

Back Switch

The Back switch moves the playback location backward by the 
Back/Forward Amount.

To move the playback location forward:

Hold Alt (Windows) or Option (Mac) and press the Back 
switch in the Transport section.

Locate switches

Go To Start
switch

Go To End
switch

Back
switch

Back and Play
switch

Instant
Playback
switch
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Back & Play Switch

The Back and Play switch moves the current playback location 
backward by the Back/Forward Amount and automatically be-
gins playback.

Forward & Play Mode

Forward & Play mode can be invoked by doing the following:

To move the playback location forward and begin playback:

Hold Alt (Windows) or Option (Mac) and press the Back and 
Play switch in the Transport section.

Instant Playback

The Instant Playback switch primes Pro Tools for playback, so 
that pressing Play will begin playback instantaneously. This 
switch can also be used during recording to put Pro Tools in 
Record Pause mode.

External Machines Switches

The External Machines switches allow direct access to remote 
machine track arming functions of Digidesign MachineCon-
trol™. These functions are available when MachineControl is 
enabled and a track arming profile is declared. For details on 
remote track arming functions and record modes, refer to the 
MachineControl Guide. 

Track Arm from Channel Strips Switch

The Track Arm from Channel Strips switch displays track arm-
ing controls for the currently enabled external machine on 
Custom Fader channels. Track names appear in the Custom 
Fader channel displays and the tracks can be record enabled 
with the corresponding Record Enable switch. 

If more machine tracks are available for arming than can be 
displayed, the Bank/Cycle switch allows banking of the chan-
nels. 

Machine Insert Switch

The Machine Insert switch toggles the “Machine Follows Edit 
Insertion/Scrub” Machine Control preference in the Pro Tools 
Operation Preferences.

External Machines switches

Track Arm
from

Channel Strips
switch

Machine
Insert
switch

Auto
Insert/Punch

switch

Insert/
Assemble

switch
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Auto Insert/Punch Switch

The Auto Insert/Punch switch toggles the MachineControl 
record protocol between Auto Edit and Punch In/Out modes, 
as displayed in the Pro Tools Track Arming window.

Insert/Assemble Switch

The Insert/Assemble switch toggles the MachineControl 
record mode between Insert and Assemble modes, as dis-
played in the Pro Tools Track Arming window. 

External Machine Online Switches

Machine Online Switches

The Machine Online switches (Mach 1, Mach 2, Mach 3, and 
Mach 4) are used in D-Control Multi-mode to switch worksur-
face control between connected Pro Tools systems. 

When a Pro Tools system is indicated as available, you can 
switch control to that system by pressing the corresponding 
Machine Online switch. 

See “D-Control Multi-Mode” on page 100.

External Machine Online switches
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Zoom/Navigate Section
The Zoom/Navigate section is used to control navigation, dis-
play, and selections in the Pro Tools Edit window. 

Zoom Mode Switch 

The Zoom Mode switch puts the arrow switches in Zoom 
mode.

Navigate Mode Switch

The Navigate Mode switch puts the arrow switches in Navi-
gate mode.

Arrow Switches (Up, Down, Previous, Next)

The function of the Arrow switches depends on the current 
mode.

Zoom Mode When set to Zoom Mode, the Up and Down Ar-
row switches change the vertical zoom and the Previous (Left) 
and Next (Right) Arrow switches change the horizontal zoom.

Navigate Mode In Navigate mode, the Up and Down Arrow 
switches move the edit cursor up and down among tracks, and 
the Previous (Left) and Next (Right) Arrow switches move the 
edit cursor left and right among region boundaries or tran-
sients (according to the Tab to Transients setting). 

Pro Tools Window Text Entry In both Zoom or Navigate modes, 
the Arrow switches can be used to navigate on-screen text 
fields. The Previous (Left) and Next (Right) Arrow switches 
move the cursor one character at a time, and the Up and 
Down Arrow switches move the cursor to the beginning and 
end of the text field.

D-Control Zoom/Navigate Section

Zoom Mode Navigate Mode

Arrow
switches

switch switch

Zoom Preset switches
The Arrow switches can be used to enter numerical values in 
the on-screen Main and Sub Counters, Start/End/Length 
fields, and Pre/Post Roll fields in the Edit and Transport win-
dows. The Previous (Left) and Next (Right) Arrow switches 
move between fields, and the Up and Down Arrow switches 
change the value.

Dialog Box Navigation In Pro Tools, the Arrow switches can be 
used to navigate through folders in dialog boxes such the 
Open Session dialog. 

In the New Track dialog, the Arrow switches do the following:

• Up and Down Arrows: increase and decrease the number 
of tracks

• Control (Windows) or Command (Mac)+Up and Down 
Arrows: scroll through track types

• Control (Windows) or Command (Mac)+Previous (Left) 
and Next (Right) Arrows: scroll through track formats

• Control+Alt (Windows) or Command+Option 
(Mac)+Previous (Left) and Next (Right) Arrows: toggle the 
timebase menu

In the Name Tracks dialog, the Arrow switches do the follow-
ing:

• Control (Windows) or Command (Mac)+Previous (Left) 
and Next (Right) Arrows: move to previous or next track’s 
name

Edit Window Navigation In the Edit window, the Arrow 
switches do the following:

Control (Windows) or Command (Mac)+Previous (Left) and 
Next (Right) Arrows: scroll the Edit window

Zoom Preset Switches

The Zoom Preset switches recall the five horizontal Zoom pre-
sets in Pro Tools. 

To store a Zoom Preset:

1  Using either the Horizontal Zoom buttons or the Zoomer 
tool, set the zoom level that you want to store.

2  While pressing Control (Windows) or Command (Mac), 
press a Zoom Preset switch. 

To recall a Zoom Preset:

Press the corresponding Zoom preset switch.
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Bank/Nudge Section
The Bank/Nudge section controls the display of any channels 
in Normal mode on the D-Control surface. They are also used 
to nudge the display of the Focus Channel Strip forward or 
backward in 1-channel or 8-channel increments.

If any channels are in any of the Custom Fader modes, they 
are not affected by Bank or Nudge commands, and the other 
channels move around them.

Nudge 1 Switches

The Nudge 1 switches move the display of tracks on the con-
trol surface to the left or right, one channel at a time. 

To nudge the track focus forward or backward by one channel:

With a track focused in the Focus Channel Strip, hold Con-
trol (Windows) or Command (Mac) and press the left or right 
Nudge 1 switch in the Bank/Nudge section.

Nudge 8 Switches

The Nudge 8 switches move the display of tracks on the con-
trols surface to the left or right in eight-channel increments. 

To nudge the track focus forward or backward by eight channels:

With a track focused in the Focus Channel Strip, hold Con-
trol (Windows) or Command (Mac) and press the left or right 
Nudge 8 switch in the Bank/Nudge section.

Bank Switches

The Bank switches move the display of tracks on the control 
surface to the left or right by the number of available channels 
on the control surface. 

Home Switch

The Home switch moves the display of tracks so that the first 
track in the session is shown on the leftmost channel of the 
control surface. 

D-Control Bank/Nudge Section

Nudge by 1 Track Left and Right

Nudge by 8 Tracks Left and Right

Bank Left and Right switches

Home switch

switches

switches
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Bank Select Matrix
The Bank Select matrix is used in Custom Fader modes to cre-
ate and select Custom Groups and Mix/Edit Groups, to select 
Track Types for display in the Custom Faders, and to select 
Custom Fader Plug-in parameter pages.

See Chapter 13, “Custom Fader Modes” for complete informa-
tion on the use of Bank Select matrix in Custom Fader modes 

Bank Select Edit Switch

The Bank Select Edit switch is used when creating Mix/Edit 
Groups or Custom Groups from D-Control. After you press 
this switch, you can then select the tracks you want to add to 
the group. 

You can also create new Mix/Edit Groups by selecting the 
tracks you want in the group and double-pressing the Bank Se-
lect Edit switch. 

Bank Select Switches

The Bank Select switches are used when assigning or recalling 
Custom Groups or Mix/Edit Groups, and selecting Track 
Types or plug-in parameter pages from D-Control.

D-Control Bank Select Section

Bank Select switches 1–12

Bank Select Edit switch



Dual Transport Mode
(Digidesign MachineControl with a 9-pin or MMC Device)

Dual Transport mode assigns the upper set of transport con-
trols to a 9-pin or MMC device using MachineControl. 

In Dual Transport mode, you can toggle the transport mas-
ter between “Transport=Pro Tools” and “Transport = Ma-
chine,” “Transport=MMC,” or “Transport=Remote” directly 
from the D-Control Transport switches. 

In Single Transport mode, you toggle the transport master 
between “Transport=Pro Tools” and “Transport = Machine,” 
“Transport=MMC,” or “Transport=Remote” using the Ma-
chine Online switch in the Transport Mode controls. 

To toggle between Dual Transport mode and Single Transport 
mode:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes “Transpt.”

2  Press the Soft Key that corresponds to “Transpt” to toggle 
the Transport mode between “Dual” and “Single.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Selecting the Transport Master in 
Dual Transport Mode

In Dual Transport mode, either set of transport controls can be 
active. The transport switches light to indicate the current 
Transport Master:

• If the Pro Tools Transport switches are lit, 
Transport = Pro Tools. 

• If the Machine Transport switches are lit, the Transport Mas-
ter is one of the following:

• Transport = Machine

• Transport=MMC

• Transport=Remote
To select the Transport Master in Dual Transport mode:

Press the Machine Online switch in the Transport Mode 
controls. 

– or –

Do one of the following:

• When Transport = Pro Tools, press any unlit switch 
(Rewind, Fast Forward, Stop, Play, or Record) in the Ma-
chine Transport section. 

• When Transport = Machine, MMC, or Remote, press any 
unlit switch (Rewind, Fast Forward, Stop, Play, or Record) 
in the Pro Tools Transport section. 

The first press of an unlit transport switch changes the Trans-
port Master and does not send a transport command. The sec-
ond press sends the transport command. 

Selecting the Transport Master in 
Single Transport Mode

In Single Transport mode, only the Pro Tools Transport con-
trols are active, and control the currently selected Transport 
Master.

To select the Transport Master in Single Transport mode:

Press the Machine Online switch in the Transport Mode 
controls. 

Cycling through the Transport Master Choices

In both Single and Dual Transport modes, the 
Machine Online switch is used to cycle the Transport Master 
through the available choices (Pro Tools, Machine, MMC, and 
Remote) from D-Control. 

To cycle through available Transport Master choices:

Hold Start (Win) or Control (Mac) and repeatedly press the 
Machine Online switch in the Transport Mode controls.
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D-Control Multi-Mode
D-Control Multi-mode lets you use a single D-Control console 
to access up to four Pro Tools|HD systems on a network. 
Multi-mode lets you quickly switch worksurface control from 
one Pro Tools system to another by pressing a single switch on 
the console.

Enabling Multi-Mode

To enable a D-Control console to be declared on multiple 
Pro Tools|HD systems, the D-Control Main Unit and Fader 
Modules must first be placed in Multi-mode. 

To toggle a D-Control unit in or out of Multi-mode:

1  If the unit is declared on a system, do one of the following:

• Quit Pro Tools. 

– or –

• Undeclare the unit in the Pro Tools Peripherals dialog.

2  Press and hold the Solo switch in the Focus Channel Strip 
(on a Main Unit) or on the leftmost channel strip (on a Fader 
Module) for approximately three seconds.

When in Multi-mode, the unit displays “D-Control 
Multi-Mode” in the Soft Keys (on a Main Unit) or in the Chan-
nel Displays (on a Fader Module). 

Declaring Multi-Mode Enabled D-Control Units

When a D-Control unit is in Multi-mode, it appears in the Pe-
ripherals dialog multiple times, with the numbers “1” through 
“4” appended to its name. These multiple listings can then be 
declared on different Pro Tools systems on the network. 

To declare D-Control units in Multi-mode:

1  On the first Pro Tools system, choose Setups > Peripherals, 
and click Ethernet Controllers.

2  In the Ethernet Controllers page, select Enable. Pro Tools 
scans the Ethernet connection and finds the Multi-mode en-
abled D-Control units.

3  Declare the Main Unit and Fader Modules that end in the 
suffix “1,” in the order you want the units arranged from left 
to right.

4  Click OK to close the Peripherals window.

5  On the second Pro Tools system, repeat the above steps, de-
claring the Main Unit and Fader Modules that appear with the 
suffix “2,” in the same order from left to right as you declared 
them on the first Pro Tools system.

6  If you have additional Pro Tools systems, declare the D-Con-
trol units that appear with “3” and “4” on subsequent sys-
tems, in the same order from left to right as above.
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As you declare the D-Control units from each Pro Tools sys-
tem, the Machine Online switches (Mach 1 through Mach 4) 
in the Online section of the Transport controls flash to indi-
cate that system is available.

Using D-Control Multi-Mode

When multiple Pro Tools systems are available, you can view 
their transport synchronization status and instantly switch 
between them using the Machine Online switches (Mach 1 
through Mach 4) in the Online section of the Transport con-
trols.

Pro Tools System Status Indication

When the Pro Tools Transport Master is set to Transport=Ma-
chine or Transport=MMC, the Machine Online switches 
(Mach 1 through Mach 4) show the status of available 
Pro Tools systems as follows:

When the Pro Tools Transport Master is set to Transport=Re-
mote, the Machine Online switches (Mach 1 through Mach 4) 
show only the following states:

Switching Control Between Pro Tools Systems

When a Pro Tools system is indicated as available, you can 
switch control to that system by pressing the corresponding 
Machine Online switch (Mach 1 through Mach 4).

Pro Tools system status indications (Transport=Machine or MMC)

Mach switch state Indication

Off No Pro Tools system available

Flashing (slow) Active Pro Tools system on D-Control

Flashing (fast) Available Pro Tools system, stopped or 
not locked to time code

On (solid) Available Pro Tools system, locked to 
time code

Pro Tools system status indications (Transport=Remote)

Mach switch state Indication

Off No Pro Tools system available

Flashing (slow) Active Pro Tools system on D-Control

On (solid) Available Pro Tools system, online

When Transport=Remote, the Pro Tools Online switch and 
the Transport controls (Rewind, Fast Forward, Stop, Play, 
and Record) flash, and do not accurately report the 
Pro Tools transport status.



Chapter 9: Management and Soft Key Sections

Window Management Section
The Window Management section includes controls for opening and closing Pro Tools windows on-screen. When a window is 
open, its corresponding switch is lit. Where applicable, you can hold Alt (Windows) or Option (Mac) when pressing a switch to 
maximize a window, and hold Control (Windows) or Command (Mac) when pressing a switch to minimize a window.
D-Control Window Management section

MIDI Operations window

Transport window

Big Counter window

Edit window

Mic Pre window

Pan window

Plug-in window

Beat Detective windowMIDI Event window

Workspace Browser window

Memory Locations window

Mix window
MIDI Event Window Switch

The MIDI Event Window switch opens and closes the MIDI 
Event window or brings it to the front. 

MIDI Operations Window Switch

The MIDI Operations Window switch opens and closes the 
MIDI Operations window.

Beat Detective Window Switch

The Beat Detective Window switch opens and closes the Beat 
Detective window.

Workspace Browser Switch

The Workspace Browser switch opens and closes the DigiBase 
Workspace Browser. Hold Alt (Windows) or Option (Mac) and 
press this switch to close all DigiBase windows.

Big Counter Switch

The Big Counter switch opens and closes the Big Counter win-
dow. 
Mic Pre Window Switch

The Mic Pre Window switch opens and closes the Mic Pre win-
dow for the focused track.

Memory Locations Window Switch

The Memory Locations Window switch opens and closes the 
Memory Locations window.

Transport Window Switch

The Transport Window switch opens and closes the Transport 
window. Hold the following keys and press this switch to 
show/hide Transport controls: 

• Alt (Windows) or Option (Mac): MIDI controls and 
counters

• Control (Windows) or Command (Mac): MIDI controls 
only

• Start (Windows) or Control (Mac): counters only

Pan Window Switch

The Pan Window switch opens and closes the Pan window for 
the focused track. Hold Alt (Windows) or Option (Mac) to 
close all Pan windows.
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Mix Window Switch

The Mix Window switch opens the Mix Window or brings it 
to the front. 

Edit Window Switch

The Edit Window switch opens the Edit Window or brings it 
to the front.

Plug-in Window Switch

The Plug-in Window switch opens and closes windows for any 
currently targeted plug-ins in the session. Hold Alt (Windows) 
or Option (Mac) to close all plug-in windows.

Session Management Section
The Session Management section includes controls for ses-
sion-wide management and save operations. 

Clear Clip Switch and Plug-in Clip Indicator

D-Control indicates occurrences of signal clipping on audio 
tracks, sends, and plug-ins. (Clip indication on D-Control fol-
lows the clip settings in the Pro Tools Display preferences.)

• If an audio track clips, its fader display lights red. 

• If a send clips, the Send switch flashes in the channel’s Dis-
play Controls section. In addition, if the channel strip is dis-
playing sends, the corresponding encoder display lights red. 

• If a plug-in clips, the Insert switch flashes in the channel’s 
Display Controls section. In addition, if the channel strip is 
in top-level Inserts view, the corresponding encoder display 
lights red. 

The Clear Clip switch lights if a clip occurs on an audio track 
or on a send anywhere in the session. The Plug-in Clip indica-
tor lights if a clip occurs on a plug-in anywhere in the session. 

Pressing the Clear Clip switch clears all peaks and clips in the 
session.

D-Control Session Management section

All Notes Off
switch

Utility Mode
switch

Redo
switch

Undo
switch

Clear Clip
switch

QWERTY

Publish
switch

Save
switch

Keyboard
switch

Plug-in Clip
indicator
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All Notes Off Switch

The All Notes Off switch can be used to silence stuck notes 
with MIDI devices. It sends an All Notes Off message to each 
channel for all connected MIDI devices. 

QWERTY Disable Switch

The QWERTY Disable switch temporarily disables the com-
puter keyboard on D-Control, to prevent the possibility of ac-
cidental key presses. When the keyboard is disabled, this 
switch lights. 

The QWERTY Disable switch does not affect D-Control track-
ball operation. 

Utility Switch

The Utility switch places D-Control in Utility mode. When 
D-Control is in Utility mode, this switch flashes.

Utility mode lets you view D-Control system information, 
name D-Control units, run D-Control diagnostic tests, and set 
certain D-Control hardware preferences. For complete infor-
mation on Utility mode, see Appendix A, “Utility Mode.”

Publish Switch

The Publish switch executes the Send Session Via DigiDelivery 
command in Pro Tools, opening the Send To DigiDelivery di-
alog on-screen.

Save Switch

The Save switch executes the Save Session command in 
Pro Tools. Whenever a change is made in a session and the 
Save command is available, this switch lights. 

To save the current session:

1  Press the Save switch. The switch flashes, prompting confir-
mation of the Save command. 

2  Do one of the following:

• To confirm the Save command, press the Save switch 
again. 

• To cancel the Save command, press Escape. 

Redo Switch

The Redo switch executes the Redo command in Pro Tools. 

Undo Switch

The Undo switch executes the Undo command in Pro Tools. 



Soft Keys Section
The Soft Keys section provides access to a wide range of Pro Tools commands directly from the control surface. It also provides 
access to preferences and settings specific to D-Control. The section consists of six variable-function soft keys and displays, along 
with a matrix of mode switches that change the functions shown in the displays. When a function is shown in a Soft Key display, 
pressing the corresponding Soft Key switch activates that function. 
D-Control Soft Keys section

Bank Sel
switch

Mem Loc
switch

MIDI
switch

User
switch

Meter
switch

Operation
switch

Edit Function
switches

Edit Modes
switch

AutoMatch
switch

Join
switch

Auto Join
switch

Actions
switch

Modes
switch

Prefs
switch

Soft Key switches
and

displays

Snap
switch

Group
switch

Track
switch

Playlist
switch

Window
switch

Audio Files
switch

Show/Hide
switch

Edit Tools
switch
Default Soft Key Display

When a session is first opened, the Soft Key displays show ba-
sic information about the session:

• Session Name

• Bit: Session Bit Depth

• Sampl: Session Sample Rate

• File: Session File Type

• Tcode: Session Time Code Rate

• Delay Compensation On/Off Status

Delay Compensation can be toggled on and off from this dis-
play. The other settings shown above cannot be changed from 
the Soft Keys section. 

Soft Keys Display with Pro Tools Dialogs

When Pro Tools has a dialog on-screen, the two lower Soft 
Keys temporarily display “Escape” and “Enter,” letting you 
cancel or confirm the dialog from the control surface.

Exiting from Soft Key Modes

You can exit a Soft Key mode and return to the default Soft 
Key display by holding Control (Windows) or Command 
(Mac) and pressing the currently lit Soft Key switch.
Management Controls

Snap Switch

The Snap switch displays the following commands:

Page 1

• Captre: Capture

• Punch Captre: Punch Capture

• Snap 1–4: Snapshots 1–4

Pages 2–12 

• Snap 5–48: Snapshots 5–48 (in groups of 4)

Group Switch

Page 1

The Group switch displays the following commands:

• Create Edit: Create Edit Groups

• Suspnd: Suspend Groups

• Create Mix: Create Mix Groups

• Modify: Modify Groups

• Create Both: Create Mix and Edit Groups

Page 2

• Preset 1–6: Group Dialog Presets 1–6
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Track Switch

The Track switch displays the following commands:

• New Track: Track > New

• Dup Track: Track > Duplicate

• Delete Selectd: Track > Delete

• Make Act/In: Track > Make Active/Inactive

• Bounce: File > Bounce To > Disk

• Split Mono: Track > Split into Mono

Playlist Switch

The Playlist switch displays the following playlist commands:

• New: New Playlist

• Duplicate: Duplicate Playlist

• Delete Audio: Delete Unused Audio Playlists

• Delete MIDI: Delete Unused MIDI Playlists

• Prev Plylst: Show Previous Playlist

• Next Plylst: Show Next Playlist

Window Switch

No Session When no session is open, the Window switch dis-
plays the following commands:

Page 1

• Task Managr: Window > Task Manager

• Disk Space: Window > Disk Space

• System Usage: Window > System Usage

Page 2

• I/O Setup: Setup > I/O

• HW Setup: Setup > Hardware

• PB Engine: Setup > Playback Engine

• Preferences: Setup > Preferences

• Peripherals: Setup > Peripherals
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Open Session When a session is open, the Window switch dis-
plays the following commands:

Page 1

• Auto Enabls: Window > Automation

• Track Arm: Window > Machine Track Arming

• Strip Silnce: Edit > Strip Silence

• Sessn Setup: Setup > Session

• Task Managr: Window > Task Manager

• Projct Browsr: Window > Project Browser

Page 2

• Color Pallet: Window > Color Palette

• Big Countr: Window > Big Counter

• Undo Histry: Window > Undo History

• Disk Space: Window > Disk Space

• Video Window: Window > Video

• System Usage: Window > System Usage

Page 3

• I/O Setup: Setup > I/O

• HW Setup: Setup > Hardware

• PB Engine: Setup > Playback Engine

• Disk Alloc: Setup > Disk Allocation

• Preferences: Setup > Preferences

• Peripherals: Setup > Peripherals

Page 4

• Window Confgs: Window > Configurations > Window 
Configuration List

• MIDI Editor: Window > MIDI Editor

• Score Editor: Window > Score Editor

Page 5

• Tile Windws: Window > Arrange > Tile

• Tile Hrzntl: Window > Arrange > Tile Horizontal

• Tile Vertcl: Window > Arrange > Tile Vertical

• Cascde Windws: Window > Arrange > Cascade



Edit Controls

Edit Function 1 Switch (Basic Edit Commands)

The Edit Function 1 switch displays the following commands:

Page 1

• Cut: Edit > Cut

• Copy: Edit > Copy

• Paste: Edit > Paste

• Clear: Edit > Clear

• TCE To TLSel: Edit > TCE Edit to Timeline Selection

Page 2

• CutSP AllAut: Edit > Cut Special > All Automation 

• CopySP AllAut: Edit > Copy Special > All Automation 

• CutSP PanAut: Edit > Cut Special > Pan Automation 

• CopySP PanAut: Edit > Copy Special > Pan Automation

• CutSP PI Aut: Edit > Cut Special > Plug-in Automation 

• CopySP PI Aut: Edit > Copy Special > Plug-in Automation 

Page 3

• PsteSP Merge: Edit > Paste Special > Merge

• ClrSP AllAut: Edit > Clear Special > All Automation 

• PsteSP RepFil: Edit > Paste Special > Repeat to Fill Selec-
tion

• ClrSP PanAut: Edit > Clear Special > Pan Automation

• PsteSP ToCurr: Edit > Paste Special > To Current Automa-
tion Type

• ClrSP PI Aut: Edit > Clear Special > Plug-in Automation 

Edit Function 2 Switch

The Edit Function 2 switch displays the following commands:
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• Trim To Sel: Edit > Trim > To Selection

• Cpture Region: Edit > Capture Region

• Seprte: Edit > Separate Region

• Heal Seprtn: Edit > Heal Separation

• Consolidate: Edit > Consolidate Selection

• Time Stamp: Audio Regions List > Time Stamp Selected

Page 2

• SendTo Back: Region > Send to Back

• SendTo Front: Region > Bring to Front

• Group Region: Region > Group

• Ungrp Region: Region > Ungroup

• Ungrp All: Region > Ungroup All

• Regrp Region: Region > Regroup
Edit Function 3 Switch

The Edit Function 3 switch displays the following commands:

Page 1

• Duplicate: Edit > Duplicate

• Repeat: Edit > Repeat

• Shift: Edit > Shift

• Insert Silnce: Edit > Insert Silence

• Lock Region: Region > Lock/Unlock

• Mute Region: Region > Mute/Unmute

Page 2

• Loop Region: Region > Loop Region

• Unloop Region: Region > Unloop Region

• ID/Rem SyncPT: Region > Identify/Remove Sync Point

• Rename Rgns: Region > Rename Regions

• Quantz ToGrid: Region > Quantize to Grid

• RgnDrp: Region List > Timeline Drop Order > 
L to R/Top to Bottom

Edit Modes Switch

The Edit Modes switch displays the Pro Tools Edit modes:

Page 1

• Shuffl: Shuffle Mode

• Spot: Spot Mode

• Slip: Slip Mode

• Grid Rel: Relative Grid Mode

• Grid Abs: Absolute Grid Mode

Page 2

• Tab Trnsnt: Tab to Transients

• Dynamc Trnspt: Options > Dynamic Transport

• Loop Plybck: Options > Loop Playback

• Loop Record: Options > Loop Record

Edit Tools Switch

The Edit Tools switch displays the Pro Tools Edit Tools. To 
cycle through multiple versions of the same tool, repeatedly 
press the corresponding Soft Key.

• Zoom: Normal/Single Zoomer tools

• Trim: Standard/Scrub/TCE Trimmer tools

• Select: Selector tool

• Grabbr: Time/Separation/Object Grabber tools

• Scrub: Scrubber tool

• Pencil: Square, Random, Free, Line, Triangle, Arc, S-Curve

To select the Smart Tool, press any two buttons for the 
Trimmer, Selector or Grabber simultaneously. 
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Select/MIDI Controls

Bank Select Switch

The Bank Select switch (“Bank Sel”) sets the Soft Keys to mir-
ror the selection in the Bank Select Matrix. When Bank Select 
is enabled, the Soft Keys show the names of the Mix/Edit 
Groups, Custom Groups, track types, or plug-in page numbers 
being controlled by the Bank Select Matrix.

Because the Bank Select Matrix has 12 switches, the Soft Keys 
display each bank of twelve in two pages of six. The Soft Key 
display is paged by repeatedly pressing the Bank Select switch 
in the Soft Keys section.

To page through the currently displayed bank in the Soft Keys:

Press the Bank Select switch (“Bank Sel”) repeatedly to page 
through the current bank.

Memory Location Switch

The Memory Location switch (“Mem Loc”) displays the names 
of Memory Locations in pages of six. 

For information on viewing and creating Memory Location 
from D-Control, see “Memory Locations” on page 113. 

MIDI Switch

The MIDI switch displays the following commands: 

Page 1

• Wait Note: Transport Window > Wait for Note button

• Count Off: Transport Window > Countoff button

• Merge Record: Transport Window > MIDI Merge button

• Transpose: Event > Event Operations > Transpose

• Veloc: Event > Event Operations > Change Velocity

• Click On/Off: Options > Click

Page 2

• Change Tempo: Change Tempo window

• Change Meter: Change Meter window

• Split Notes: Event > Event Operations > Select/Split Notes

• Quantz: Event > Event Operations > Quantize

• Input Quantz: Event > Event Operations > Input 
Quantize

Page 3

• Write PTProp: Track > Write MIDI Real Time Properties

• Remove DpNote: Event > Remove Duplicate Notes
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User Switch

The User switch lets you assemble a custom set of up to 24 Soft 
Key operations (six on each of four pages), providing quick ac-
cess to frequently used commands or modes. You can add op-
erations to any of the four available pages.

To add a Soft Key operation to the User Soft Key set:

1  In the Soft Keys section, press the User switch repeatedly to 
display the page (Page 1, 2, 3, or 4) where you want to add the 
operation.

2  Press the Soft Keys to display the page containing the oper-
ation you want to add. 

3  Hold Control (Windows) or Command (Mac) and press the 
Soft Key for the operation.

The operation is appended to the list of User Soft Key opera-
tions on the corresponding User page.

To remove a Soft Key operation from the User set:

1  In the Soft Keys section, press the User switch repeatedly to 
display the operation you want to remove.

2  Hold Control (Windows) or Command (Mac) and press the 
Soft Key for the User operation. 



Console Preferences

Meter Switch

Meter Switch (Page 1)

The Meter switch displays the D-Control metering prefer-
ences, in pages of six. The Soft Key display is paged by repeat-
edly pressing the Meter Prefs switch in the Soft Keys section.

The Meter switch control D-Control meters only, and do not 
affect the Pro Tools on-screen display.

SndMtr (Send Meters) Toggles send metering on channel ro-
tary encoders on and off. 

InsMtr (Insert Meters) Toggles plug-in metering on channel 
rotary encoders on and off. 

VCAMtr (VCA Meters) Toggles metering of VCA slaves on 
channel rotary encoders on and off.

Meters Toggles channel metering between pre- and post-fader 
modes.

CtrMtr (Center Meters) Toggles the 8-channel meter display 
on the Main Unit meter bridge between main output levels 
and the focused track.

GrChan (Gain Reduction Channel Display) Sets channel meters 
to display dynamics plug-in gain reduction when the plug-in 
is focused on a channel strip.

Meter Switch (Page 2)

RefLvl (Reference Level) Lets you change the D-Control meter 
display to help monitor program material with respect to dif-
ferent reference levels.

GRPrio (Gain Reduction Priority) When a multi-function Com-
pressor/Limiter or Expander/Gate plug-in is used, this prefer-
ence determines which function (“CompLm” or “ExpGat”) 
has metering priority when encoder LED rings and channel 
meters are set to display dynamics plug-in gain reduction.

Operation Switch

The Operation switch controls behaviors that are specific to 
D-Control, and that do not affect the Pro Tools on-screen dis-
play. D-Control operation preferences are saved with 
Pro Tools application preferences. For details on setting oper-
ation preferences, see “Setting D-Control Preferences” on 
page 40.
Operation Switch (Page 1)

BnkJus (Bank Justification) Determines whether banks of 
channels in Normal mode are justified at the left side, left cen-
ter (to the left of the Main Unit), right center, (to the right of 
the Main Unit) or right side of the control surface. 

Rotary (Rotary Encoder Velocity Mode) Determines respon-
siveness of rotary encoder knobs. Fixed mode is at normal res-
olution. The velocity modes set different rates of encoder ac-
celeration. In Fine mode, response is fixed and at fine 
resolution. 

LCFJst (Left Custom Fader Justification) Determines whether 
the Custom Faders controlled by the Left Custom Faders sec-
tion are placed at the left, left center, right center, or right of 
the Main Unit.

RCFJst (Right Custom Fader Justification) Determines whether 
the Custom Faders controlled by the Right Custom Faders sec-
tion are placed at the left, left center, right center, or right of 
the Main Unit.

LPIDef (Left Plug-in View Definition) Determines the view of 
plug-in parameters on the Custom Faders in the Left Custom 
Fader section (Name view, Expanded view, or Fader view).

RPIDef (Right Plug-in View Definition) Determines the view of 
plug-in parameters on the Custom Faders in the Right Custom 
Fader section (Name view, Expanded view, or Fader view).

Operation Switch (Page 2)

LCFPI (Left CF Bank Size for Plug-ins) Determines the number 
of channels allocated for Custom Fader Plug-in mode in the 
Left Custom Fader section.

RCFPI (Right CF Bank Size for Plug-ins) Determines the num-
ber of channels allocated for Custom Fader Plug-in mode in 
the Right Custom Fader section.

LCFGrp (Left CF Bank Size for Custom Groups and Mix/Edit 
Groups) Determines the number of channels allocated for Cus-
tom Groups mode in the Left Custom Fader section.

RCFGrp (Right CF Bank Size for Custom Groups and Mix/Edit 
Groups) Determines the number of channels allocated for Cus-
tom Groups in the Right Custom Fader section.

LCFTyp (Left CF Bank Size for Track Type) Determines the 
number of channels allocated for Custom Fader Tracks mode 
in the Left Custom Fader section.

RCFTyp (Right CF Bank Size for Track Type) Determines the 
number of channels allocated for Custom Fader Tracks mode 
in the Right Custom Fader section.
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Operation Switch (Page 3)

PanBot (Pan on Lower Encoder) Determines whether Pan con-
trols are displayed on the bottom encoder of each channel, 
even when another type of controls is displayed on the upper 
encoders. 

Encod (Encoder Order) Determines whether inserts, sends, and 
pan controls are displayed in order from top-to-bottom or bot-
tom-to-top on D-Control rotary encoders.

ApTrgt (Target Track from Application) Determines whether se-
lecting an Insert or Send on-screen focuses its track on the 
D-Control Main Unit. 

Faders (Faders On/Off) Temporarily turns off D-Control faders 
to prevent fader movement when monitoring a mix. 

ChanWn (Channel Window Display) Determines whether dis-
playing plug-in or send parameters (by pressing an encoder Se-
lect switch) on D-Control opens the corresponding plug-in or 
send window on-screen in Pro Tools. Also determines whether 
the Channel Select switches (in the Dynamics or EQ sections) 
change the channel display of multi-mono plug-ins. 

When this preference is set to “Yes,” the on-screen display 
of plug-in and send windows changes to reflect the state of the 
control surface. 

When this preference is set to “No,” the on-screen display of 
plug-in and send windows does not change to reflect the state 
of the control surface. 

Select (Select Switch Latch Mode) Determines whether chan-
nel Select buttons follow latching or exclusive-or (non-latch-
ing) behavior when in Select mode. 

Operation Switch (Page 4)

SoloFc (Focused Track Follows Solo) Determines whether a so-
loed track is automatically focused in the Focus Channel Strip 
(this function works in both Select and Focus modes)

2KbPan (Two-Knob Panning) Toggles linking of front and rear 
pan controls in surround panner windows to facilitate 
left-right motion in the surround field.

TchVal (Touch Display of Parameter Values) Determines the 
display of parameter values when faders or encoders are 
touched. This can be set to On, Off, or NoVol, which turns off 
the display of volume values in the main fader only.

CFTrks (Custom Faders Display Hidden Tracks) Determines 
whether tracks that are hidden in Pro Tools are displayed or 
hidden in Custom Fader modes. Tracks that are hidden in 
Pro Tools but shown in Custom Faders cannot be Selected or 
Record enabled. 

For stereo tracks, the encoder shows by default L (left 
channel). To change to the R channel, press Select.
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Brdcst (Broadcast) Determines whether the XMON monitor-
ing system is in Broadcast mode, which prevents AFL and PFL 
solo modes from changing the XMON Control Room Input 
source.

Trk/Ed (Link Track and Edit Selection) Toggles the Options > 
Link Track and Edit Selection option, which automatically se-
lects a track or range of tracks when a selection is made in the 
track’s timeline.

Operation Switch (Page 5)

Import PIMaps (Import Plug-in Maps) Opens “Choose a map-
ping file” dialog in Pro Tools.

Export PIMaps (Export Plug-in Maps) Opens “Save Plug-in 
Mapping As” dialog in Pro Tools. 

SplFcs (Focus VCA Master When Spilled) Causes a VCA Master 
track to be focused in the Focus Channel Strip when its slave 
tracks are “spilled,” or displayed in Custom Faders by pressing 
the Byp/Mute switch on the VCA Master.

FilBnk (Always Fill Channel Strips When Banking)  Toggles the 
preference setting that maximizes the number of channels dis-
played in Normal mode when banking. When selected, bank-
ing follows end stop behavior. 

FillCF (Always Fill Custom Faders When Banking)  Toggles the 
preference setting that maximizes the number of channels dis-
played in Custom Faders when banking. When selected, bank-
ing follows end stop behavior. 

Trnspt (Transport Mode)  Toggles between Dual and Single 
Transport mode. Dual Transport mode activates the second 
set of transport controls in the section labeled “Machine 
Transport.” In Single Transport mode, only the transport con-
trols marked “Pro Tools Transport” are active.

Operation Switch (Page 6)

AsnMtx (Assign Matrix Enable) Determines whether Assign 
Matrix or standard Assign mode operation is used for assign-
ing inputs, outputs, inserts and sends. 

MtxJst (Matrix Select Area Justification) Determines whether 
items in the Assign Matrix Select Area are in order from 
top-to-bottom or bottom-to-top on D-Control rotary encoders

PIClmn (Plug-In Menu Column Width) Determines the number 
of plug-in names displayed per encoder row in the Assign Ma-
trix

IOClmn (I/O Menu Column Width) Determines the number of 
I/O paths displayed per encoder row in the Assign Matrix

MtxRws (Assign Matrix Rows) Determines the number of en-
coder rows used to display elements in the Assign Matrix

MtxLck (Assign Matrix Lock) Determines whether the Assign 
Matrix is locked by default or needs to be locked manually



Operation Switch (Page 7)

ChanPI (Channel Strip Editing for Plug-Ins) Toggles the prefer-
ence setting that enables display of plug-in parameters di-
rectly on D-Control channel encoders. 

EncVCA (VCA Encoder Display) Determines whether VCA slave 
track controls are displayed in the encoders of VCA Master 
channels

LrnTch (Learn Touch)  Determines whether D-Control encod-
ers and switches are active when a plug-in is in Learn mode. 

Lettrs (Show Send/Insert Letters) Determines whether 
D-Control displays Send and Insert letters on send and insert 
positions with no assignments.

Automation Controls

AutoMatch Switch

The AutoMatch switch activates the AutoMatch command in 
Latch or Write automation modes. 

Join Switch

The Join switch is used in Latch mode to manually resume 
writing of automation on all channels that were previously 
writing automation after an interrupted automation pass.

When you stop the transport during an automation pass, the 
Join buffer is loaded with the current values of all controls that 
were actively writing automation. 

When you press the Join switch during playback, writing of 
automation begins at the values stored in the Join buffer.

To clear the Join buffer:

Hold Control+Start (Windows) or Command+Control 
(Mac) and press the Join switch. 

Auto Join Switch

The Auto Join switch is used in Latch mode to automatically 
resume writing of automation after the transport is stopped 
and started again during an automation pass.

Actions Switch

The Actions switch displays the following commands:

Actions Switch (Page 1)

Prview (Preview) Puts Pro Tools in Preview mode

Punch Prview (Punch Preview) Executes the Punch Preview 
command

Prview Suspnd (Preview Suspend) Suspends Preview mode

Captre (Capture) Executes the Capture command
Punch Captre (Punch Capture) Executes the Punch Capture 
command

See “Previewing Automation” on page 136 and “Capturing 
and Recalling Automation” on page 136 for more information 
on these commands.

Actions Switch (Page 2)

Wrt To All (Write to All)  Writes current automation values to 
an entire selection or track while performing an automation 
pass. 

Snap Back Causes all Latch or Write enabled tracks to exit 
their current automation pass and return instantly to the pre-
viously written automation levels. During playback, this com-
mand stops writing of automation without applying any Au-
toMatch ramping.

Wrt To Start (Write To Start) Writes current automation val-
ues from the insertion point backward to the beginning of a 
selection or track while performing an automation pass. 

Wrt To End (Write to End) Writes current automation values 
from the insertion point forward to the end of a selection or 
track while performing an automation pass. 

Wrt To Punch (Write To Punch Point) Writes current automa-
tion values back to the point where writing of automation be-
gan 

Wrt To Next (Write to Next Breakpoint) Writes current auto-
mation values from the insertion point forward to the next 
automation breakpoint while performing an automation pass.

Actions Switch (Page 3)

Wrt To Currnt (Write To Current Parameter) Writes the current 
control value to the currently displayed automation parame-
ter (Edit > Automation > Write To Current).

Wrt To All Ena (Write To All Enabled Parameters) Writes cur-
rent control values to all enabled automation parameters (Edit 
> Automation > Write To All Enabled). 

Trm To Currnt (Trim To Current Parameter) Applies the current 
trim value to the currently displayed automation parameter 
(Edit > Automation > Trim To Current).

Trm To AllEna (Trim To All Enabled Parameters) Applies cur-
rent trim values to all enabled automation parameters (Edit > 
Automation > Trim To All Enabled).

Gld To Currnt (Glide To Current Parameter) Applies a transition 
between automation values to the currently displayed auto-
mation parameter (Edit > Automation > Glide To Current). 

Gld To AllEna (Glide To All Enabled Parameters) Applies a tran-
sition between automation values to all enabled automation 
parameters (Edit > Automation > Glide To All Enabled).
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Actions Switch (Page 4)

Copy To Send Opens the Copy To Send dialog to allow copy-
ing of track control values to each selected track’s send (Edit > 
Automation > Copy To Send). 

Thin Auto (Thin Automation) Performs the Thin Automation 
command. (Edit > Automation > Thin).

Colesc VCAAtm (Coalesce VCA Automation) Executes the 
Track > Coalesce VCA Master Automation command

Colesc TrmAtm (Coalesce Trim Automation) Executes the Track 
> Coalesce Trim Automation Command

Clear TrmAtm (Clear Trim Automation) Executes the Track > 
Clear Trim Automation Command

Suspend TrmAtm (Suspend Trim Automation) Temporarily sus-
pends Trim automation to allow auditioning of Trim moves

Modes Switch

The Modes switch displays the following modes:

AWrtTo All (Auto Write to All on Stop) Writes current automa-
tion values to an entire selection or track when the transport 
is stopped after an automation pass. 

By default, Automatic Write to All on Stop mode is enabled for 
a single automation pass only. To configure the mode to re-
main enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the 
AWrtTo All switch.

AWrtTo Start (Auto Write to Start on Stop) Automatically 
writes current automation values from the insertion point 
backward to the beginning of a selection or track when the 
transport is stopped after an automation pass. 

By default, Automatic Write to Start on Stop mode is enabled 
for a single automation pass only. To configure the mode to 
remain enabled after an automation pass, hold Start+Alt 
(Windows) or Control+Option (Mac) while pressing the 
AWrtTo Strt switch.

AWrtTo End (Auto Write to End on Stop) Writes current auto-
mation values from the insertion point forward to the end of 
a selection or track when the transport is stopped after an au-
tomation pass. 

By default, Automatic Write to End on Stop mode is enabled 
for a single automation pass only. To configure the mode to 
remain enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the 
AWrtTo End switch. 
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AWrtTo Punch (Auto Write to Punch Point on Stop) Writes cur-
rent automation values back to where the current automation 
pass began. 

By default, Automatic Write to Punch Point on Stop mode is 
enabled for a single automation pass only. To configure the 
mode to remain enabled after an automation pass, hold Alt 
(Windows) or Option (Mac) while pressing the AWrtTo Punch 
switch.

AWrtTo Next (Auto Write to Next Breakpoint on Stop) Writes 
current automation values from the insertion point forward to 
the next automation breakpoint when the transport is 
stopped after an automation pass. 

Automatic Write to Next Breakpoint on Stop remains enabled 
after each automation pass, until you disable it by pressing the 
lit AWrtTo Next switch.

Prefs Switch

The Prefs switch displays the following preferences:

Prefs Switch (Page 1)

Match Time Determines the AutoMatch Time, or the amount 
of time it takes for automation values to return to the previ-
ously written values after an automation pass stops.

Glide Time Determines the AutoGlide Time, or the amount of 
time it takes for surround pan values to move between two 
points in an automation pass performed with the optional 
D-Control surround panner. 

LchStp (Allow Latch Prime in Stop) Toggles the Allow Latch 
Prime in Stop preference, which allows tracks in Latch mode 
to be primed for writing automation while the transport is 
stopped. When a track in Latch mode is primed for writing au-
tomation, its Latch mode indicator flashes. 

PlgAut (Plug-In Controls Default to Auto-Enabled)  Toggles the 
preference that enables plug-in controls automatically when 
they are added to a track

AutCls (Coalesce when Removing Slaves from VCA Group) Tog-
gles the preference that automatically coalesces automation to 
slave track when they are removed from a VCA-controlled 
group

TrmCols (Coalesce Trim Automation) Sets the preference that 
determines when Trim automation is coalesced (After Every 
Pass, On Exiting Trim Mode, or Manually)



Prefs Switch (Page 2)

MmtTch (Latching Behavior for Switched Controls in Touch) 

Toggles the preference that determines the behavior of 
switched controls in Touch mode. 

StdVCA (Standard VCA Logic for Group Attributes) Toggles the 
preference that disables normal group linking behavior when 
a VCA is assigned to a group

WrtWrn (Suppress Automation “Write To” Warnings Toggles 
the preference that suppresses dialogs after invoking the Write 
To Start/End/All commands

PanLnk (Use Absolute Pan Linking) Toggles the preference that 
determines the behavior of pan controls in grouped tracks

SndTrm (Include Sends in Trim Mode) Toggles the preferences 
that determines whether Send Faders go into Trim mode 
along with Main Volume

CtlUnd (Include Control Changes in Undo Queue) Toggles the 
preference that determines whether mixer control moves 
(such as fader or pan controls) are included in the Pro Tools 
undo queue. 

Audio Files Switch

Open Recent Session Commands

No Session Open When no session is open, the Audio Files 
switch displays the names of the ten most recent Pro Tools 
sessions in its display pages 1 and 2. 

Open Session When a session is open, the Audio Files switch 
displays the following commands: 

Page 1

• New Sessn: File > New Session

• Open Sessn: File > Open Session

• Close Sessn: File > Close Session

• Revert Sessn: File > Revert to Saved

• Save As: File > Save As

• Save Copy In: File > Save Copy In

Page 2

• Import Audio: File > Import > Audio

• Import MIDI: File > Import > MIDI

• Import SesDat: File > Import > Session Data

• Import RgnGrp: File > Import > Region Groups

• Import Video: File > Import > Video
Page 3

• Export Region: Region List Menu > Export Regions as 
Files

• Export MIDI: File > Export > MIDI

• Export OMFAAF: File > Export > Selected Tracks as New 
AAF/OMF

• Export Text: File > Export > Session Info As Text

Pages 4 and 5

• Recent Sessns: Open recent sessions (listed by name)

Show/Hide Switch

The Show/Hide switch displays commands from the 
Show/Hide Tracks List menu. 

Show/Hide Switch (Page 1)

• Show All: Show All Tracks

• Hide All: Hide All Tracks

• Show Selctd: Show Only Selected Tracks

• Hide Selctd: Hide Only Selected Tracks

• Show Inactv: Show Only Inactive Tracks

• Hide Inactv: Hide Only Inactive Tracks

Show/Hide Switch (Page 2)

• Show Audio: Show Only Audio Tracks

• Hide Audio: Hide Only Audio Tracks

• Show Aux: Show Only Auxiliary Inputs

• Hide Aux: Hide Only Auxiliary Inputs

• Show MIDI: Show Only MIDI Tracks

• Hide MIDI: Hide Only MIDI Tracks

Show/Hide Switch (Page 3)

• Show Instmt: Show Only Instrument Tracks

• Hide Instmt: Hide Only Instrument Tracks

• Show VCA: Show Only VCA Master Tracks

• Hide VCA: Hide Only VCA Master Tracks

• Hide MkInac: Hide and Make Inactive

You can select multiple Show/Hide categories by holding Shift 
while pressing the corresponding Soft Key.
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Miscellaneous Controls Section
The Miscellaneous Controls section includes controls for basic Pro Tools editing and display functions.
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Main and Sub Counter Switches

The Main and Sub Counter switches cycle through the time 
code display modes (Bars:Beats, Min.Secs, Time Code, 
Feet+Frames and Samples) on the corresponding counter. 

Link Edit and Timeline Switch

The Link Edit and Timeline switch toggles the Link Edit and 
Timeline Selection command on and off. The switch is lit 
when the selections are linked. 

Location Start/End/Length Switches

The Start/End/Length switches select the corresponding val-
ues in the Selection indicators. New values can be typed and 
confirmed by pressing Return. 

Edit/Timeline Switch and Indicators

The Edit/Timeline switch toggles the Selection indicator val-
ues and the D-Control transport function between the edit se-
lection and the timeline selection. The indicators above the 
switch light to show which is displayed. If Edit and Timeline 
Selections are linked, these values will be the same. 
Edit Modes

The Edit Mode switches place Pro Tools directly in the corre-
sponding Edit mode. The switch lights to indicate the current 
mode. 

Shuffle Switch Places Pro Tools in Shuffle mode.

Spot Switch Places Pro Tools in Spot mode. 

Slip Switch Places Pro Tools in Slip mode. 

Grid Switch Toggles Pro Tools between Absolute and Relative 
Grid mode. 

Shuffle Lock Mode

Shuffle Lock Mode prevents you from inadvertently entering 
Shuffle mode.

To lock out Shuffle mode:

While in any Edit mode other than Shuffle mode, hold Con-
trol (Windows) or Command (Mac) and press the Shuffle 
switch.

To unlock Shuffle mode:

Control-click (Windows) or Command-click (Mac) the 
Shuffle button on-screen.



Edit Functions

The Edit Function switches directly execute the corresponding 
command in Pro Tools. The switches light to indicate which 
functions are available. 

Cut Switch Cuts the current edit selection. 

Copy Switch Copies the current edit selection to the Clip-
board. 

Paste Switch Pastes the current Clipboard contents. 

Repeat Switch Pastes the current Clipboard contents 
end-to-end the specified number of times. 

Track Size Switches

The Track Size Up and Down switches increase and decrease 
the height of all tracks where a selection or edit cursor is 
present. 

Explode Switch

The Explode switch invokes the Zoom Toggle command in 
Pro Tools, which zooms in on the current edit selection and 
sets the track height to the size specified in the Pro Tools Dis-
play preferences. 

Go To Switch

The Go To switch is used to focus a specific track onto the Fo-
cus Channel Strip on the Main Unit. 

To go to a specific track:

1  Press the Go To switch.

2  Enter the track position number for the track and press En-
ter.
Memory Locations
You can view and create Pro Tools Memory Locations from 
the D-Control Soft Keys.

To view Memory Locations in the Soft Keys, do one of the 
following:

Repeatedly press the Mem Loc switch in the Soft Keys sec-
tion to page the display of Memory Locations.

– or –

Hold Shift and repeatedly press the Mem Loc switch in the 
Soft Keys section to page backward. 

To create a new Memory Location from the Soft Keys:

1  Press the Mem Loc switch in the Soft Keys section. The Mem 
Loc switch lights to indicate Memory Location display. 

2  Press any Soft Key that corresponds to a blank display.

3  Set the properties of the new Memory Location in the New 
Memory Location dialog. 

4  Press the Soft Key that corresponds to Enter to save the 
Memory Location.

To edit a Memory Location from the Soft Keys:

1  Press the Mem Loc switch in the Soft Keys section. The Mem 
Loc switch lights to indicate Memory Location display. 

2  If there are more than six Memory Locations, press the Soft 
Keys that correspond to Page Up and Page Down to view ad-
ditional locations.

3  Hold the Start key (Windows) or Control key (Mac) and 
press the Soft Key that corresponds to the Memory Location 
you want to edit.

4  Change the properties of the Memory Location in the Edit 
Memory Location dialog. 

5  Press the Soft Key that corresponds to Enter to save the 
Memory Location.

To delete a Memory Location from the Soft Keys:

1  Press the Mem Loc switch in the Select/MIDI Soft Keys sec-
tion.

2  Hold the Alt key (Windows) or Option key (Mac) and press 
the Soft Key that corresponds to the Memory Location you 
want to delete.
Chapter 9: Management and Soft Key Sections 113



1

Window Configurations
You can view, create, and edit Window Configurations from 
the D-Control Soft Keys.

To display Window Configurations in the Soft Keys:

1  Hold the Start key (Windows) or Control key (Mac) and 
press the Mem Loc switch in the Select/MIDI Soft Keys section. 
The Mem Loc switch flashes to indicate Window Configura-
tion display. 

2  If there are more than six Window Configurations, press the 
Soft Keys that correspond to Page Up and Page Down to view 
additional configurations.

To recall a Window Configuration from the Soft Keys:

1  Hold the Start key (Windows) or Control key (Mac) and 
press the Mem Loc switch in the Select/MIDI Soft Keys section. 

2  Press the Soft Key that corresponds to the Window Config-
uration you want to recall.

To create a Window Configuration from the Soft Keys:

1  Hold the Start key (Windows) or Control key (Mac) and 
press the Mem Loc switch in the Select/MIDI Soft Keys section. 

2  Press any Soft Key that corresponds to a blank display.

3  Set the properties of the new Window Configuration in the 
New Window Configuration dialog. 

4  Press the Soft Key that corresponds to Enter to save the Win-
dow Configuration.

To edit a Window Configuration from the Soft Keys:

1  Hold the Start key (Windows) or Control key (Mac) and 
press the Mem Loc switch in the Select/MIDI Soft Keys section.

2  Hold the Start key (Windows) or Control key (Mac) and 
press the Soft Key that corresponds to the Window Configura-
tion you want to edit.

3  Change the properties of the Window Configuration in the 
Edit Window Configuration dialog. 

4  Press the Soft Key that corresponds to Enter to save the Win-
dow Configuration.

To delete a Window Configuration from the Soft Keys:

1  Hold the Start key (Windows) or Control key (Mac) and 
press the Mem Loc switch in the Select/MIDI Soft Keys section.

2  Hold the Alt key (Windows) or Option key (Mac) and press 
the Soft Key that corresponds to the Window Configuration 
you want to delete.
D-Control Guide14



Chapter 10: Monitor and Meter Sections

Monitor Section Controls
The Monitor section includes a full set of controls for the control room monitoring, headphone/cue, and talkback/listenback
sections of D-Control. All input and output connections to the D-Control monitoring system are made on the XMON interface, 
which is connected to the D-Control console with the XMON cable, and remotely controlled from this section. 
D-Control Monitor section
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Control Room Monitoring System
The Control Room Monitoring system is an 8-channel system 
with six input sources (two 8-channel surround, four stereo), 
and three available outputs (two 8-channel surround, one ste-
reo).

Input sources are selected with dedicated switches, and can be 
combined in a special sum mode to allow monitoring of mul-
tiple inputs at the same time. 

Control Room outputs are activated with dedicated switches 
and level controls, including a Dim function for momentary 
level reduction. 

Control Room Input Source Selectors

Input Source Switches

The Control Room monitor system has six input sources: 

• Main Inputs (8 channels)

• Surround Inputs (8 channels)

• Stereo 1 Inputs (2 channels)

• Stereo 2 Inputs (2 channels)

• Stereo 3 Inputs (2 channels)

• Stereo 4 Inputs (2 channels)

These sources are selected by pressing their corresponding In-
put switches, which light when the source is activated.

Control Room Input Source selectors

Sum switch

Stereo Input
switches

Surround switch

Main switch
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Input Level Trim Mode

Each input source can be trimmed independently, to allow for 
setting of different reference levels or to compensate for differ-
ences in gain structure. Available trim values range from 
–20 dB to +10 dB in 0.5 dB steps. 

To trim input levels:

1  Press and hold the Input Source Selector switch for the input 
you want to trim, until the switch flashes. 

2  Turn the Main Output Level encoder knob to set the trim 
value. The monitor section display shows “Trim” and the trim 
value in dB.

3  Press the flashing Input Source Selector switch to exit Trim 
mode. 

Sum Switch

In normal operation, the Control Room Input Source switches 
follow exclusive-or (non-latching) behavior, allowing only 
one source to be monitored at a time.

However, D-Control has a Sum mode that allows multiple in-
put sources to be monitored at the same time. When Sum 
mode is on, multiple input source switches can be active.

Sum mode ignores any input trim values when it is active. 

To add or remove inputs in Sum mode:

1  Press the Sum switch. The switch lights to indicate Sum 
mode is on. 

2  Press any number of Input Source switches to toggle their 
corresponding inputs on or off. It is possible to turn all inputs 
off in this mode.

To exit Sum mode:

Press the Sum switch again. Monitoring reverts to the input 
that was selected when you entered Sum mode.



Control Room Output Controls

Output On/Off Switches

The Control Room monitor system has three outputs:

• Main Control Room Outputs (8 channels)

• Alt Control Room Outputs (8 channels)

• Mini Control Room Outputs (2 channels)

Only one output can be active at a time. The Output On/Off 
switches follow exclusive-or (non-latching) behavior. When 
you activate an output, its name and gain value (in dB) are 
shown in the monitor section display. 

Output Level Controls

Each of the three Control Room Outputs has a touch-sensitive 
rotary encoder for control of output level. When any of these 
encoder knobs is touched, the monitor section display shows 
the output name and its current level in dB. Gain ranges from 
a minimum level of –INF to a maximum level of +10 dB, in 
1 dB steps. 

Output Level Trim Mode

Each output level control can be trimmed independently, to 
allow for setting of different reference levels or to compensate 
for differences in gain structure. Available trim values range 
from –20 dB to +10 dB, in 0.5 dB steps. 

To trim output levels:

1  Press and hold the On/Off switch for the output you want to 
trim, until the switch flashes. 

2  Turn the corresponding encoder knob to set the trim value. 
The monitor display shows “Trim” and the trim value in dB.

3  Press the flashing On/Off switch to exit Trim mode. 

Control Room Output controls

Mini Output
Level control

Mini Output
On/Off switch

Main Output
On/Off switch

Main Output
Level control

Alt Output
On/Off switch

Alt Output
Level control

Dim
Level control
Dim Level Control

The Dim Level control lets you adjust the amount of level re-
duction applied by the Dim switch, located at the bottom of 
the Monitor section. Level reduction ranges from –30 dB to 
0 dB, in 1 dB steps. 

When the Dim encoder knob is touched, the monitor section 
display shows “Dim” and the gain reduction in dB.

Linking Monitor Output Levels

You can link the Output Level controls so that the Main, Alt, 
and Mini levels adjust in tandem, allowing you to maintain 
relative levels when you adjust output gain and switch be-
tween speaker systems.

When you link the Output Level controls, all output trim set-
tings are preserved, as well as any offsets between the current 
Main, Alt, and Mini Output Level control settings. 

To link D-Control Output Level controls:

1  Do one of the following:

• Set the Main, Alt and Mini levels independently. Any off-
sets between these controls will be preserved after they 
are linked. 

– or –

• Turn the Main, Alt and Mini levels all the way down (to 
-INF). This ensures there will be no offset between these 
controls after they are linked.

2  Hold the Setup switch in the Monitor Output Mode controls 
and press the Main Output On/Off switch. The Monitor Sec-
tion displays show “Output Lk On” to indicate that linking is 
active. 

To unlink D-Control Output Level controls:

Hold the Setup switch in the Monitor Output Mode controls 
and press the Main Output On/Off switch. The Monitor Sec-
tion displays show “Output Lk Off.”
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Monitor Output Mode Controls

Setup Switch

This function is currently not implemented for D-Control.

Calibration Mode Switch

The Calibration Mode switch invokes a mode that changes the 
output value displayed by the Monitor section display from 
gain (expressed in dB) to sound pressure level (expressed in 
dB SPL) for each of the control room outputs. This switch 
lights when an SPL value is shown for the active output.

To display output levels in dB SPL, you must first calibrate 
each output. This SPL calibration requires the use of a pink 
noise source (or other reference material) and a sound pressure 
level meter to measure the output of individual control room 
speakers.

To calibrate Control Room outputs to display SPL:

1  Send the reference material to the Main Control Room Out-
puts, and set the output level in Pro Tools to your studio refer-
ence level (for example, –18 dBFS). 

2  Pan the signal to center (so that equal level is sent to all 
Main Control Room Output speakers).

3  Set the speaker-to-speaker balance for all speakers in the sys-
tem using Output Trim mode for each channel, using the 
sound pressure level meter to measure SPL at the mix position. 
See “Individual Output Trim Mode” on page 119.

4  Solo the Center speaker, and adjust the Main Control Room 
Output level encoder until the sound pressure level meter 
measures the target reference level (for example, 85 dB) at the 
mix position. You can Output Level Trim mode for fine adjust-
ment of the output level. See “Output Level Trim Mode” on 
page 117.

5  Press and hold the Calibration Mode switch until it flashes. 

6  Adjust the Main Control Room Output level encoder until 
the target reference level is displayed in the Monitor Section 
display. 

7  Press the flashing Cal switch.

8  Repeat steps 4–7 for the Alt and Mini outputs. 

Monitor Output Mode controls

Setup switch

Calibration Mode
switch

Dim switch

Mono switch

Mute switch
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To toggle the output display between dB and dB SPL:

1  Select the output whose display you want to toggle (Main, 
Alt, or Mini). 

2  Do one of the following:

• To display output in dB SPL, press the Calibration Mode 
switch so that it is lit.

– or –

• To display output in dB, press the Calibration Mode 
switch so that it is unlit.

Mono Switch

The Mono switch mixes the Left and Right signals of any of 
the output modes (any surround channels are not affected) to 
provide mono output, useful for checking phase and balance 
relationships. The Mono switch lights to indicate that it is ac-
tive.

Mono Trim Mode

Mono output can be trimmed to adjust its reference level in 
comparison to other outputs. Available trim values range from 
–12 dB to 0 dB, in 0.5 dB steps. 

To trim mono output:

1  Press and hold the Mono switch until it flashes. 

2  Turn Alt Output encoder knob to set the Mono trim value. 
The monitor display shows “Trim” and the trim value in dB.

3  Press the flashing Mono switch to exit Trim mode.

Dim Switch

The Dim function applies an adjustable gain reduction to the 
Control Room outputs. This function affects all three output 
destinations. The Dim switch toggles the dim function on and 
off, and lights to indicate that it is active. 

The amount of gain reduction is set with the Dim Level con-
trol, located at the top right of the Control Room Output sec-
tion. 

Mute Switch

The Mute switch toggles the mute state for all Control Room 
outputs. Mute operates globally on all three output destina-
tions. The Mute switch lights to indicate that it is active. 

If the Mute switch on the XMON interface front panel is acti-
vated, the Mute switch on D-Control must be used to unmute 
the monitor system. (Outputs cannot be unmuted from 
XMON front panel.)



Monitor Displays

When any rotary encoder knob in the Monitor section is 
touched, the LED displays show the name of the control and 
its value.

Output Channel Select Controls

Channel Select Switches

The Channel Select switches let you solo or mute individual 
channels of the Control Room outputs. The function of the 
Channel Select switches depends on the mode of the 
Solo/Mute switch. 

• When the mode is set to Solo, each Channel Select switch 
solos the corresponding output channel.

• When the mode is set to Mute, each Channel Select switch 
mutes the corresponding output channel.

In both modes, the Channel Select switches follow latched be-
havior, allowing multiple outputs to be soloed or muted. The 
Channel Select switches light to indicate that they are active. 

There are Channel Select switches for the following channels: 

• L (Left)

• Lc (Left Center)

• C (Center)

• Rc (Right Center)

• R (Right)

• Ls (Left Surround)

• Cs (Center Surround)

• Rs (Right Surround)

• LFE

These choices support all possible channel configurations in 
Pro Tools. A maximum of eight channels (7.1 surround) may 
be in use at any time.

Monitor Section displays

Output Channel Select controls

Monitor displays

Channel Select switches

Solo/Mute switch
and indicators
Individual Output Trim Mode

Each output channel can be trimmed individually for each of 
the three control room outputs (Main, Alt, and Mini), allow-
ing you adjust the channel balance for each set of control 
room speakers. Trim values are stored for each of the three 
outputs. Available trim values range from –30 dB to +10 dB, in 
0.5 dB steps.

To trim the output level for an individual output channel:

1  Activate the control room output (Main, Alt, or Mini) whose 
channel levels you want to trim. 

2  Press and hold the Channel Select switch for the output 
channel you want to trim, until the switch flashes.

3  Turn the Main Output encoder knob to set the trim value for 
the channel. The monitor display shows “Trim” and the trim 
value in dB.

4  Press the flashing Channel Select switch to exit Trim mode. 

5  Repeat the above steps for each output channel and each set 
of outputs (Main, Alt, or Mini) you want to trim.

Solo/Mute Switch and Indicators

The Solo/Mute switch toggles the function of the Channel Se-
lect switches between Solo and Mute modes. The indicators 
light to indicate which mode is active. 
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Solo Mode Controls

The Solo function has three available modes: Solo in Place 
(SIP), After-Fader Listen (AFL) and Pre-Fader Listen (PFL). 

SIP mode mutes all unsoloed tracks, causing the soloed 
tracks to be auditioned alone in the main mix. The XMON 
Control Room Input source remains unchanged, so you can 
monitor the soloed channels in the Main control room mon-
itors. 

AFL and PFL modes send signal to a separate output path 
with independently adjustable levels for each mode. The 
XMON Control Room Input source is automatically changed 
to monitor the AFL/PFL input, unless you put D-Control in 
Broadcast mode (see “Broadcast Mode for AFL and PFL Moni-
toring” on page 120). This lets you monitor the soloed chan-
nels in the Main control room monitors (with Broadcast mode 
off) or in a dedicated solo monitoring system (with Broadcast 
mode on).

To select the Solo mode:

Press the SIP, AFL, or PFL switch in the D-Control Monitor 
section to select the corresponding Solo mode.

Setting AFL and PFL Levels

Levels can be set separately for AFL and PFL modes from the 
D-Control Monitor section.

To set the AFL or PFL level:

1  Press the AFL or PFL switch in the D-Control Monitor sec-
tion. 

2  Turn the AFL/PFL rotary encoder. The AFL/PFL level is 
shown in the Monitor displays.

Solo Mode controls in the D-Control Monitor section

AFL and PFL Solo modes require the use of the Surround 
Mixer plug-in. 

AFL or PFL levels can be adjusted even if no 
channels are currently soloed.

AFL/PFL
Level control

AFL switch

PFL switch

SIP switch

Latch switch

Momentary switch

X-OR switch
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To set the AFL or PFL level to its default setting:

1  Press the AFL or PFL switch in the D-Control Monitor sec-
tion. 

2  Hold Alt (Windows) or Option (Mac) and touch the AFL/PFL 
rotary encoder. 

Broadcast Mode for AFL and PFL Monitoring

You can put the D-Control monitoring system in Broadcast 
mode, which prevents AFL and PFL solo modes from changing 
the XMON Control Room Input source. This lets you solo 
channels while preserving the main monitor mix.

You can then use the AFL/PFL path selector in the I/O Setup 
dialog to route the AFL/PFL solo signal to a separate set of 
speakers or headphones. 

To put the XMON monitoring system in Broadcast mode:

1  Press the Operation switch in the Soft Key section.

2  Press the Soft Key that corresponds to “Broadcast” to set the 
option to “On.”

While in Broadcast mode, any channels soloed while in AFL or 
PFL are still sent to the AFL/PFL path, but XMON does not 
switch the Control Room Input source to monitor that path.

While in Broadcast mode, any channels soloed while in SIP 
mode will still cause all other tracks to be muted.

Solo Latch Options

The three solo latch options can be selected directly from the 
D-Control Monitor section. These options apply to all three 
Solo modes (SIP, AFL and PFL). 

Latch When this option is selected, pressing subsequent chan-
nel Solo switches adds the channels to the Solo output.

X–OR When this option is selected, pressing subsequent Solo 
switches cancels previous solos.

Momentary When this option is selected, you can temporarily 
solo any number of channels by holding a single channel Solo 
switch and pressing any additional channel Solo switches. 
When you release the held Solo switch, all solos are cleared.

To override X–OR mode and solo more than one track at a 
time, press and hold the Solo button on the first track. Sub-
sequently pressed Solo switches will latch.



Headphone/Cue System
The Headphone/Cue system is a two-channel system with four stereo input sources and five available stereo outputs. 

Headphone/Cue Output Controls
Cue/Headphone Output controls

Headphone

Headphone
On/Off switch

Cue Output
Level controls

Studio Loudspeaker
Level control

Studio Loudspeaker
On/Off switch

Level control

Cue Output
On/Off switches
Headphone/Cue Output On/Off Switches

The Headphone/Cue system has five available outputs:

• Cue 1 (2 channels)

• Cue 2 (2 channels)

• Cue 3 (2 channels)

• Headphone (2 channels)

• Studio Loudspeaker (2 channels)

The three Cue Outputs, Headphone Output, and Studio Loud-
speaker Output can be active in any combination, including 
all on or all off. The On/Off switches light to indicate that an 
output is active. 

You have the option of adding talkback signal to any of these 
cue outputs independently. 

Headphone/Cue Level Controls

Each of the five outputs in the Headphone/Cue system has a 
touch-sensitive rotary encoder for control of output level. 
When any of these encoder knobs is touched, the monitor sec-
tion display shows the name of the output and its current 
level in dB. Gain ranges from a minimum level of –INF to a 
maximum level of +10 dB, in 1 dB steps.

In addition, when any of these encoder knobs is touched, the 
Cue Input Source Selectors display the current input source 
and talkback assignment for the corresponding output. You 
can then edit the input source and talkback assignment for 
the displayed output. The output does not need to be active to 
display or change these assignments.
Headphone/Cue Talkback Dim Function

When talkback is engaged, an independent Dim function is 
automatically applied to the Headphone/Cue outputs. The 
amount of gain reduction is set from this section. 

To set the gain reduction value for the Headphone/Cue Dim 
Function:

1  Press and hold the Talkback Assign switch until it flashes.

2  Turn the Main Output encoder knob to set the Dim value for 
the channel. The monitor display shows “TB Dim” and the 
gain reduction value in dB.

3  Press the flashing Talkback Assign switch.

4  Repeat the above steps for each output channel and each set 
of outputs (Main, Alt, or Mini) you want to trim.
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Cue Input Source Selectors

Cue Input Source Switches

The Headphone/Cue monitor system has four input sources: 

• Cue 1 Input (2 channels)

• Cue 2 Input (2 channels)

• Cue 3 Input (2 channels)

• Main Monitor Input (2 channels)

These input sources are routed to applicable outputs with the 
Cue Input Source switches, which light when the correspond-
ing input source is active for a given output. 

The table below shows possible outputs for each input source. 
(Talkback can be added to each of the outputs.)

Assign Talkback Switch

The Assign Talkback switch lets you add the talkback signal to 
any of the Headphone/Cue system outputs. The Assign Talk-
back switch lights to indicate that talkback is active for a given 
output.

Headphone Outputs

A Headphone output is located on the underside of the 
D-Control Main Unit, near the front right side. The other four 
pairs of headphone outputs are available on the XMON inter-
face.

Cue Input Source selectors

Input Possible Outputs

Cue 1 Cue 1, HP, Studio LS

Cue 2 Cue 2, HP, Studio LS

Cue 3 Cue 3, HP, Studio LS

Main Monitor Cue 1, Cue 2, Cue 3, HP, Studio LS

Assign Talkback switch

Cue Input Source
switches
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Talkback/Listen System

The Talkback/Listen system has two talkback microphone in-
puts with independent level controls, and two Listen micro-
phone inputs with a shared level control.

Talkback Controls

The Talkback system has two talkback microphone inputs 
(one external, one built-in) each with a touch-sensitive rotary 
encoder for control of output volume. When either of these 
encoders is touched, the monitor section display shows the 
name of the input and its current volume level in dB. Level 
control on each ranges from a minimum level of –INF to a 
maximum level of +30 dB.

External Talkback Level Control

The External Talkback Level control adjusts the volume for 
the external talkback microphone. When this encoder knob is 
touched, the monitor section display shows “Ext TB” and the 
level in dB.

Talkback Level Control

The Talkback Level control adjusts the volume of the built-in 
(Internal) microphone, located on the meter bridge of the 
D-Control Main Unit. When this encoder knob is touched, 
the monitor section display shows “Int TB” and the level in 
dB.

Talkback and Listen controls

External Talkback
Level control

Built-in Talkback
Level control

Listen Mic
Level control

Auto Talkback
switch

Listen Mic
Select switches



Talkback Dim Function

When Talkback is engaged, the Dim function (as set by the 
Dim Level control in the Control Room Output section) is au-
tomatically applied to the Main outputs. Any adjustment of 
the Dim Level control affects both the Talkback Dim function 
and the Control Room Output Dim function. When Talkback 
is engaged, the Dim switch in the Monitor Output Mode sec-
tion lights. 

Auto Talkback Switch

The Auto Talkback switch activates a mode in which the talk-
back and listen microphones are automatically turned on 
whenever the Pro Tools transport is not in Play or Record. 
When Auto Talkback is active, the Auto Talkback switch 
lights, and the Talkback switches flash. 

While in Auto Talkback mode, you can temporarily disable 
and re-enable talkback, while staying in Auto Talkback mode. 

To temporarily disable Talkback while in Auto Talkback mode:

Press either of the flashing Talkback switches.

To re-enable talkback while in Auto Talkback mode:

Double-press either Talkback switch so it flashes again.

Talkback Switch

Two Talkback switches, located at the bottom of each Chan-
nel Strip Master section on the Main Unit, provide control of 
the D-Control Talkback function.

The Talkback switches can follow momentary or latched be-
havior. If held, the switch is active only when pressed down. 

If rapidly double-pressed, the switch latches on and flashes to 
indicate that talkback is active. Press the switch again to turn 
off talkback.

Talkback switch

Talkback switch
Listen Controls

The Listen system has two selectable microphone inputs, with 
a shared touch-sensitive rotary encoder for level control.

Listen Mic Level Control

The Listen Mic Level control adjusts the volume for the se-
lected listen microphone input, Mic 1 or Mic 2. When this en-
coder knob is touched, the monitor section display shows the 
input name “Lstn 1” or “Lstn2” and the level in dB. When 
both inputs are active, the monitor section display shows both 
input names and levels. 

When one input is active, the encoder controls the level of 
that input independently. When both inputs are active, the 
encoder controls both levels simultaneously, maintaining any 
relative offset between the two. 

Level control ranges from a minimum level of –INF to a max-
imum level of +30 dB.

Listen Mic Select Switches

There are two Listen Mic Select switches for the external listen 
microphone inputs:

• Mic 1

• Mic 2

Either or both of these inputs can be active at any time. If nei-
ther input is active, the Listen Mic Level control can still be ad-
justed, to prepare for the next time an input is activated.
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Meter and Time Code Displays (Main Unit)
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Meter and Time Code displays (Main Unit)

Meter displays
Main Time Scale

Sub Time Scale

Start indicator

End indicator

Length indicator

Talkback Microphone

Time Code display format indicators
Meters
The meter bridge on the Main Unit includes eight 32-segment LED bar graphs for displaying output levels or the level of the track 
focused in the Focus Channel Strip, depending on the D-Control Meter Preferences setting. The top LED is red and indicates clip-
ping on the corresponding channel. 

For details on setting meter preferences, see “Meter Preferences” on page 44. 
Time Scale and Location Displays
The five displays on the Main Unit mirror the Main and Sub Time Scales, and the Selection Start, End and Length indicators in 
Pro Tools. 
Time Code Display Format Indicators
The indicators to the left of the Time Code displays show the currently displayed Time Code format for both the Main Time Scale 
and the Sub Time Scale. Formats include:

• Hours:Minutes:Seconds:Milliseconds

• Hours:Minutes:Seconds:Frames

• Feet+Frames

• Bars|Beats
Talkback Microphone
The built-in D-Control talkback microphone is located between the Meters and the Time Scale displays. 



Meter Displays (Fader Module)
The meter displays on each Fader Module feature dual 32-segment LED bar graphs for each channel, and can display pre- or 
post-fader levels depending on the D-Control Meter Preferences setting. In Custom Fader mode, these meter displays can show 
plug-in input and output meters, gain reduction meters for Dynamics plug-ins, and other parameters. The top LED is red and in-
dicates clipping on the corresponding channel or parameter.

Setting D-Control Meters for Different Reference Levels
The Pro Tools Reference Level meter preference lets you change the D-Control meter display to help monitor program material 
with respect to different reference levels.

At each setting except 0 dB, a single LED lights continuously across the meter bridge at a fixed point to indicate that reference 
level. You can then compare the peaks of the program material to the indicated level. 

The following reference level settings are available:

0 dB This is the normal setting used for referencing material to a 0 dB (full code) reference level.

–14 dB This reference level setting lights a single amber LED at –14 dB across the meter bridge. 

–18 dB This reference level setting lights a single amber LED at –18 dB across the meter bridge. 

–20 dB This reference level setting lights a single amber LED at –20 dB across the meter bridge.

B–20 dB This reference level is designed specifically for broadcast applications, with a lower threshold for the change to amber. 
The settings lights a single amber LED at –20 dB across the D-Control meter bridge. This mode also changes the meter LED colors: 
LEDs above –20 dB through –13 dB are green, and the LEDs from –12 dB to 0 dB are amber, with 0 dB remaining red.

To set a D-Control meter reference level:

1  In the Soft Keys section, press the Meter switch. 

2  Press the Soft Key that corresponds to “RefLvl” to cycle among the meter reference level settings.

3  Press the Meter Prefs 1 switch to exit. 

Meter displays (Fader Module)
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Chapter 11: Normal Mode Operations and 
Commands
The power and flexibility of D-Control lies in its different op-
erating modes, which let you customize the behavior of its 
channel strip controls to fit your workflow. 

The main D-Control operating modes are Normal mode and 
the four Custom Fader modes.

In Normal mode, Pro Tools tracks are displayed on D-Control 
in a standard console format. In this mode, each channel strip 
corresponds to a track in the session, and most of the channel 
strip controls correspond directly to on-screen controls or 
views in Pro Tools:

Channel Fader controls channel volume

Channel Display shows track name, and track volume when 
fader is touched

Pan switch shows Pan values on encoders (this is the default 
view when a new track is created) 

Inserts switch shows name of each Insert on encoders

Sends switch shows name of Send and Send level on encod-
ers

Pre switch shows controls for the channel’s Pre on encoders

Dyn switch cycles through dynamics plug-ins on the track

EQ switch cycles through EQ plug-ins on the track

Assigning Elements to Tracks
You can assign Inputs, Outputs, Inserts, and Sends to tracks di-
rectly from D-Control by entering a temporary Assign mode. 

To assign an input, output, insert or send:

1  Press an Assign switch (Input, Output, Insert, or Send) to en-
ter the corresponding Assign mode. 

2  On the channel where you want to make the assignment, 
turn an encoder knob to select from the first level of menu 
choices.

3  Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels. 

For more information on Custom Fader mode, see 
Chapter 13, “Custom Fader Modes.”
4  Press the flashing encoder Select switch or press the flashing 
Assign switch to confirm the assignment. 

To assign multiple inputs, outputs, inserts, or sends:

1  Press an Assign switch (Input, Output, Insert, or Send) to en-
ter the corresponding Assign mode. 

2  Turn the encoder knobs and use the encoder Select and By-
pass/Mute/Pre switches to select each assignment.

3  Press the flashing Assign switch to confirm all the assign-
ments at once.

To remove an input, output, insert or send:

1  Press an Assign switch (Input, Output, Insert, or Send) to en-
ter the corresponding Assign mode. 

2  For the assignment you want to remove, press the encoder 
Bypass/Mute/Pre switch repeatedly until you reach the top 
level menu for the assignment. 

3  Turn the encoder knob counter-clockwise until no assign-
ment is visible. 

4  Do one of the following:

• Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the removal. 

– or –

• Press the flashing Escape switch to cancel the removal 
and restore the assignment.

To quickly remove an output or send assignment:

1  Press the Output Assign or Send Assign switch. 

2  Hold Start (Windows) or Control (Mac) and press the Select 
switch for each output or send assignment you want to re-
move.

3  Press the flashing Assign switch to exit Assign mode.
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Assigning Inputs in Sessions with Multiple 
Plug-in Outputs

In sessions with plug-ins that have multiple outputs, the aux-
iliary outputs of those plug-ins are available as inputs in other 
audio and Auxiliary Input tracks. These appear as a third cate-
gory of inputs, labelled plug-ins, in the track input menu. 

When assigning inputs from D-Control, this third category of 
inputs appears as a top-level menu choice. 

To assign an input from a plug-in output:

1  Press the Assign Inputs switch.

2  On the channel where you want to make the assignment, 
turn an encoder knob to select Plug-in from the first level of 
menu choices.

3  Press the encoder Select switch to move down to the indi-
vidual plug-in level.

4  Turn the encoder knob to select the plug-in whose auxiliary 
output you want to select.

5  Press the encoder Select switch to move down to the list of 
plug-in auxiliary outputs.

6  Do one of the following:

• Press the flashing encoder Select switch or press the flash-
ing Assign Inputs switch to confirm the assignment.

– or –

• Press the flashing Escape switch to cancel the assign-
ment.

Assigning Inserts and Sends Directly from a 
Channel

You can assign Inserts or Sends directly to individual channels 
without entering global Assign mode.

To assign an individual insert or send:

1  On the channel where you want to make the assignment, 
press the Inserts or Sends switch to display the corresponding 
elements on the channel’s encoders.

2  Press the Select switch on the encoder where you want to 
make the assignment. The encoder scribble strip shows a right 
arrow (“> – –”) to indicate the encoder is in Assign mode. 

3  Turn the corresponding encoder knob to select from the first 
level of menu choices.

4  Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels. 
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5  Do one of the following:

• Press the flashing encoder Select switch to confirm the 
assignment. 

– or –

• Press the flashing Escape switch to cancel the assign-
ment.

To change a previously assigned insert or send:

1  On the channel where you want to change the assignment, 
press the Inserts or Sends switch to display the corresponding 
elements on the channel’s encoders. 

2  Press and hold the encoder Select switch for the insert or 
send you want to change, until the encoder scribble strip 
shows a right arrow (“>”) next to the assignment to indicate 
the encoder is in Assign mode. 

3  Do one of the following to select a new insert or send:

• Turn the corresponding encoder knob to select from the 
current level of menu choices.

– or –

• Press the encoder Select switch to move down and the 
Bypass/Mute/Pre switch to move up through menu lev-
els.

4  When the new insert or send is displayed in the encoder 
scribble strip, do one of the following:

• Press the flashing encoder Select switch to confirm the 
assignment. 

– or –

• Press the flashing Escape switch to cancel the assign-
ment.

To remove an individual insert or send:

1  On the channel where you want to remove the assignment, 
press the Inserts or Sends switch to display the corresponding 
elements on the channel’s encoders. 

2  Press and hold the encoder Select switch for the insert or 
send you want to remove, until the encoder scribble strip 
shows a right arrow (“>”) next to the assignment to indicate 
the encoder is in assign mode.

3  Press the encoder Bypass/Mute/Pre switch repeatedly until 
you reach the top level menu for the assignment. 

4  Turn the encoder knob counter-clockwise until no assign-
ment is visible. 

5  Do one of the following:

• Press the flashing encoder Select switch to confirm the re-
moval. 

– or –

• Press the flashing Escape switch to cancel the removal 
and restore the assignment.



Viewing Assignments

Display of I/O Assignments

You can view the I/O assignments for individual channels in a 
momentary I/O view. I/O assignments are displayed at the of 
bottom the channel’s encoders, according to track type. As-
signments are displayed from top to bottom as follows: 

• Audio and Auxiliary Input tracks

• Input

• Output

• Instrument tracks

• MIDI input

• MIDI output

• Aux input

• Aux output

• MIDI tracks

• MIDI input

• MIDI output

• Master Fader tracks

• Output

• VCA Master tracks

• Group assignment

To view the I/O assignments on a track:

Press and hold the Sends switch on the track. The Sends 
switch lights to indicate I/O view. 

Display of Multiple Output Assignments

Audio and MIDI Tracks

For audio or MIDI tracks that have multiple output assign-
ments, a Plus (+) sign precedes the output name.

To view the names of multiple output assignments:

1  Press and hold the Sends switch on a track with multiple 
output assignments. The Sends switch lights to indicate I/O 
view.

2  Press the B/M/P switch under any output name preceded by 
a plus (+) sign. The names of output paths “spill” onto the 
track’s encoder displays. 

3  To exit output “spill” view, press any of the lit output path 
B/M/P switches. 
To rename an I/O path on an audio track:

1  Press and hold the Sends switch on the track. The Sends 
switch lights to indicate display of I/O assignments.

2  If you have multiple I/O assignments on the track, press the 
B/M/P switch under any output name preceded by a plus (+) 
sign. The names of output paths “spill” onto the track’s en-
coder displays. 

3  Hold Start (Windows) or Control (Mac) and press the B/M/P 
switch under the I/O path you want to rename.

4  Enter a new name for the path.

5  Click OK. 

Display of Multiple Send Assignments

For sends that have multiple assignments, a Plus (+) sign pre-
cedes the send name.

To view the names of multiple send assignments:

1  Press the Sends switch on a track with multiple send assign-
ments.

2  Hold Control (Windows) or Command (Mac) and press the 
B/M/P switch under any Send name preceded by a plus (+) 
sign. The names of send paths “spill” onto the track’s encoder 
displays.

3  To exit send “spill” view, press any of the lit send path B/M/P 
switches. 

To rename a Send path:

1  Press the Sends switch on the track with the Send you want 
to rename.

2  If you have multiple sends on the track, hold Control (Win-
dows) or Command (Mac) and press the B/M/P switch under 
any Send name preceded by a plus (+) sign,. The names of send 
paths “spill” onto the track’s encoder displays.

3  Hold Start (Windows) or Control (Mac) and press the B/M/P 
switch under the send path name.

4  Enter a new name for the path.

5  Click OK. 
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Interrogating Bus and I/O Assignments

Momentary and Latching Operation

When interrogating bus assignments or I/O assignments, you 
can display them momentarily or latch them on. Latching the 
display of assignments is useful when banking faders to locate 
off-bank indications.

To display bus and I/O assignments momentarily: 

Touch the encoder showing the assignment.

To latch display of bus and I/O assignments:

Double-tap the encoder showing the assignment. 

To exit latched display of bus and I/O assignments:

Press the flashing Escape switch. 

Off-Bank Indications

When interrogating bus assignments (in either momentary or 
latched display), any off-bank assignment are indicated by 
flashing Bank/Nudge switches. Slow flashing indicates that an 
assignment is one button press away; Fast flashing indicates 
that an assignment is multiple presses away. The Soft Key dis-
play shows “Nudge 1,” “Nudge 8” and “Bank.” The left and 
right Soft Keys flash to indicate the presence of off-bank as-
signments. 

Interrogating Bus Assignments

D-Control allows both forward interrogation of outputs to bus 
paths and reverse interrogation of inputs from bus paths on 
Audio tracks or Auxiliary Input tracks. 

To interrogate a track output to a bus (forward bus 
interrogation):

1  Press and hold the Sends switch on a track that has the bus 
as an output assignment. The channel goes into I/O view, 
showing the input and output for the track in its channel strip 
encoders.

2  Touch (or double-tap) the encoder showing the bus assign-
ment on the output. The channel Select switch flashes on 
tracks with that bus assigned as an input.

To interrogate a send to a bus (forward bus interrogation):

1  Press the Sends switch on a track that has the bus as a Send 
assignment. 

2  Hold Control (Windows) or Command (Mac) and press the 
B/M/P switch under the send. All sends on the track spill to 
the track’s encoders.

3  Touch (or double-tap) the encoder showing the bus assign-
ment on the send. The channel Select switch flashes on tracks 
with that bus assigned as an input.
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To interrogate a track input from a bus (reverse bus 
interrogation): 

1  Press and hold the Sends switch on a track that has the bus 
as an input assignment. The channel goes into I/O view, show-
ing the input and output for the track in its channel strip en-
coders.

2  Touch (or double-tap) the encoder showing the bus assign-
ment on the input. The channel Select switch flashes on tracks 
with that bus as an output. Both the channel Select switch and 
the channel Send switch flash on tracks with that bus as a send 
assignment. 

Interrogating I/O Assignments

D-Control allows interrogation of matching input or output 
assignments (including interface, bus, or MIDI paths) on Au-
dio, Auxiliary Input, MIDI, Instrument, or Master Fader tracks.

To interrogate a track input or output: 

1  Press and hold the Sends switch on a track that has the input 
or output assignment. The channel goes into I/O view, show-
ing the input and output for the track in its channel strip en-
coders.

2  Hold Shift and touch (or double-tap) the encoder showing 
the input or output assignment. The channel Select switch 
flashes on all tracks that have the same input or output. 

Making Elements Active or Inactive
You can make Inputs, Outputs, Inserts, Sends, and entire 
tracks active or inactive directly from D-Control by entering a 
temporary Make Inactive mode. 

To toggle an input, output, send, or plug-in active/inactive:

1  Make sure the channel is showing the top-level view for the 
element you want to make active/inactive.

2  Press a Make Inactive switch to enter the appropriate Make 
Inactive mode. 

3  Press the Bypass/Mute/Pre switches on encoders to deacti-
vate or reactivate their corresponding track elements.

4  Press the flashing Make Inactive switch to exit Inactive 
mode.

To toggle a track inactive/active:

1  Press any of the Make Inactive switches.

2  Press channel strip Select buttons to deactivate or reactivate 
the corresponding tracks. 

3  Press the flashing Make Inactive switch to exit Inactive 
mode.



Working with Tracks

Selecting a Track

You can select tracks in Pro Tools directly from D-Control. In 
Select mode, Select switches can follow latching or non-latch-
ing behavior. For details on setting the latch mode for the Se-
lect switch, see “Select Switch Latch Mode” on page 42. 

To select a track from D-Control:

1  Make sure the Select/Focus switch mode is set to Select.

2  Press the channel Select switch for the track you want to se-
lect.

To select a range of tracks:

1  Press the Select switch on the channel at the start of the 
range you want to select.

2  Hold Shift and press the Select switch on channel at the end 
range you want to select.

All tracks between the first channel and last channel (inclu-
sive) are selected.

To select or deselect multiple, non-contiguous tracks, do one of 
the following:

If the Select Switch Latch Mode is set to latch, press addi-
tional Select switches.

– or –

Hold Control (Windows) or Command (Mac) and press the 
Select switches on multiple channels.

Focusing a Track

You can focus any track in a session on the D-Control Focus 
Channel Strip. This mirrors the track controls in the channel 
strip on the D-Control main unit, bringing them to the center 
mix position. Focusing a track also focuses the first EQ and 
Dynamics plug-ins in the center EQ and Dynamics section, 
and makes the Custom Fader plug-in mode available.
See “Focusing a Plug-In” on page 132.

To focus a track on the Focus Channel Strip from D-Control:

1  Make sure the Select/Focus switch mode is set to Focus.

2  Press the channel Select switch for the track you want to fo-
cus.

To focus a track on the Focus Channel Strip while staying in 
Select mode:

Hold Start+Shift (Windows) or Control+Shift (Mac) and 
press the channel Select switch for the track you want to focus.
To focus a track on the Focus Channel Strip from Pro Tools:

1  Make sure the Target Track from Application preference is 
set to Yes. For details on this preference, see “Target Track from 
Application” on page 44. 

2  On-screen in Pro Tools, click the plug-in state plate, send 
window, panner window, or mic pre pane for the track you 
want to focus. 

To focus a specific track number:

1  Do one of the following:

• Press the Go To switch on D-Control.

– or –

• Choose Operations > Scroll to Track Number in 
Pro Tools.

2  Enter the track position number for the track and press En-
ter.

To nudge the track focus left or right by one channel:

Hold Control (Windows) or Command (Macintosh) and 
press the left or right Nudge 1 switch in the Bank/Nudge sec-
tion.

To nudge the track focus left or right by eight channels:

Hold Control (Windows) or Command (Mac) and press the 
left or right Nudge 8 switch in the Bank/Nudge section.

To nudge the track focus with the Scrub/Shuttle wheel:

1  Hold Control (Windows) or Command (Mac) and press the 
left or right Nudge 1 switch. 

2  While holding the Nudge1 switch, turn the Scrub/Shuttle 
wheel.

Focusing Tracks when Soloing

To set D-Control to automatically focus a track when it is soloed:

1  Press the Operation switch repeatedly to display the page 
that includes the Focused Track Follows Solo preference (So-
loFc).

2  Press the Soft Key that corresponds to “SoloFc” until its 
value is “Yes.”
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Assigning Playlists on Tracks

You can toggle through available playlists on the focused track 
from D-Control. 

To cycle through playlists on a track:

1  Focus the track.

2  In the Management section, press the Playlist switch.

3  In the Soft Keys section, do one of the following:

• Press the Soft Key that corresponds to “Prevs Plylst” to se-
lect the previous playlist in that track’s Playlist menu.

• Press the Soft Key that corresponds to “Next Plylst” to se-
lect the select the next playlist in that track’s Playlist 
menu.

Working with Plug-Ins and Sends

Focusing a Plug-In

Focusing a plug-in on D-Control brings the plug-in’s controls 
to channel strip encoders and faders for convenient editing. 
You can focus a plug-in in several ways: on the encoders of its 
channel; on the encoders of the Focus Channel Strip, and in 
the Custom Faders section. 

With dynamics and EQ plug-ins, you can also focus plug-in 
parameters on the dedicated Dynamics and EQ sections of 
D-Control.

To focus a plug-in on a channel strip:

1  Press the Inserts switch on the channel. The plug-in names 
are displayed in the channel’s encoders.

2  Press the Select switch under the name of the plug-in you 
want to focus. The plug-in parameters are displayed in the 
channel’s encoders. 

3  If there is more than one page of parameters for the plug-in, 
the Page Up or Page Down switches light. To move through 
parameter pages, press the corresponding switch.

To focus a plug-in on the Focus Channel Strip:

1  Focus the plug-in’s track on the Focus Channel Strip.

2  Press the Inserts switch on the channel. The plug-in names 
are displayed in the channel’s encoders.

3  Press the Select switch under the name of the plug-in you 
want to focus. The plug-in parameters are displayed in the Fo-
cus Channel Strip’s encoders. 

4  If there is more than one page of parameters for the plug-in, 
the Page Up or Page Down switches light. To move through 
parameter pages, press the corresponding switch.
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To focus a plug-in in the Dynamics or EQ section:

1  Focus the plug-in’s track on the Focus Channel Strip by 
pressing the track’s Select switch. The first dynamics and EQ 
plug-ins on that track are automatically focused in the corre-
sponding D-Control section. 

2  Press the Cycle switch in the Dynamics or EQ section to fo-
cus successive dynamics or EQ plug-ins on that channel. (The 
No Insert option is always available.)

To focus a plug-in in the Custom Faders section:

1  Focus the plug-in’s track on the Focus Channel Strip by 
pressing the track’s Select switch. The first plug-in that is not a 
dynamics or EQ plug-in is automatically focused, and its name 
appears in the Custom Faders display. 

2  In the Custom Faders section, press the Bank/Cycle switch 
to cycle through the plug-ins on the focused channel. (The No 
Insert option is always available.)

The plug-in whose name appears in the Custom Faders display 
is then available for Custom Fader Plug-In mode. (See “Cus-
tom Fader Plug-In Mode” on page 153.)

Automation Safe Mode

The Automation Safe switch invokes a mode in which the By-
pass/Mute/Pre switch for each encoder and the channel Select 
switch become Automation Safe switches. While in this mode, 
pressing a Bypass/Mute/Pre switch on a plug-in or send pro-
tects any automation on that plug-in or send from being over-
written. Pressing a channel Select switch protects any auto-
mated parameters on that track from being overwritten. 

In Automation Safe mode, the Automation Safe switch is lit. 
While in this mode, the Bypass/Mute/Pre switch for any pro-
tected insert or send is lit, and the channel Select switch for 
any protected channel is lit.

To toggle Automation Safe mode on and off:

1  Press the Automation Safe switch.

2  Press the channel Select switch on the tracks for which you 
want to toggle automation safe status.

3  Press the Bypass/Mute/Pre switch for the plug-ins or sends 
for which you want to toggle automation safe status.

4  Press the Automation Safe switch again to exit Automation 
Safe mode.



Bypassing Plug-Ins

When a plug-in name is displayed on an encoder (in the top 
level Inserts display), the encoder’s Bypass/Mute/Pre (B/M/P) 
switch bypasses the corresponding plug-in. The B/M/P switch 
lights when the insert or plug-in is bypassed.

To bypass a Plug-In:

1  Press the Inserts switch on the plug-in’s channel to display 
the Insert names on the channel’s encoders. 

2  Press the B/M/P switch that corresponds to the plug-in you 
want to bypass. The B/M/P switch lights when the plug-in is 
bypassed.

Making Plug-Ins Active/Inactive

When a plug-in name is displayed on an encoder (in the top 
level Inserts display), it can be made inactive without entering 
Make Inactive mode.

To toggle a plug-in active/inactive:

1  Press the Inserts switch on a channel strip to display the 
names of the plug-ins on the channel’s encoders.

2  If the insert location for the plug-in that you want to make 
active/inactive is not showing, press the Page Up or Page 
Down switches on the channel where you want to make the 
assignment until the appropriate location is displayed.

3  Hold Control+Start (Windows) or Control+ Command 
(Macintosh) and press the encoder Select switch for the 
plug-in.

Muting Sends

You can mute sends directly from D-Control by setting the ap-
propriate mode for the Bypass/Mute/Pre switch.

To mute sends:

1  Press the Sends switch on the track to display Send names in 
the channel encoders.

2  Press the Switch Mode switch to set the mode to Mute.

3  Press the B/M/P switch for the send you want to mute. The 
red Mute LED lights to indicate that the send is muted. 

Setting Send Pre-/Post-Fader Operation

You can set sends to pre-fader or post-fader operation directly 
from D-Control, by setting the appropriate mode for the By-
pass/Mute/Pre switch.
To toggle sends between pre-fader and post-fader operation:

1  Press the Sends switch on the track to display Send names in 
the channel encoders.

2  Press the Switch Mode switch to set the mode to Pre.

3  Press the B/M/P switch for the send you want to toggle. The 
green Pre LED lights to indicate that the send is set for 
pre-fader operation. 

Flip Mode and Flop Mode

Flip Mode

Channels in Normal mode can use Flip Mode, which transfers 
controls from a row of encoders to the channel faders. 

In Flip mode, the rotary encoder control swaps with the chan-
nel fader; the encoder Select switch swaps with the channel 
Select switch; the encoder Bypass/Mute/Pre switch swaps with 
the channel Mute switch; and the encoder display swaps with 
the channel display. 

In Flip mode, the Flip switch for the affected row of encoders 
lights, and the affected encoder displays appear in yellow.

To transfer controls from a row of rotary encoders to the channel 
faders:

Press the Flip switch that corresponds to the encoder row 
that you want to transfer.

To exit Flip mode:

Press a lighted Flip switch.

Flop Mode

Channels in Normal mode can use Flop mode, which transfers 
controls between any two rows of rotary encoders, allowing 
you to bring any encoder control within easy reach from the 
mix position. 

To transfer controls between any two rows of rotary encoders:

Hold Start (Windows) or Control (Macintosh) and repeat-
edly press the Flip switch on row of encoders where you want 
to transfer the controls. The Flip switches on each row light to 
indicate which controls are being transferred.

The transferred (or “flopped”) controls are indicated by yellow 
text in their encoder displays.

To return flopped controls to their original positions:

Press either of the lit Flip switches.
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Assigning Inserts and Sends While in Flip 
Mode

You can assign Inserts or Sends directly to an encoder even 
when its controls are flipped to the channel fader. 

When an encoder’s controls are flipped to the channel fader, 
the channel Select switch replaces the encoder Select switch, 
the channel Mute switch replaces the Bypass/Mute/Pre switch, 
and the channel Fader replaces the encoder knob. 

To assign an individual insert or send to a flipped encoder:

1  On the channel where you want to make the assignment, 
press the Inserts or Sends switch to display the corresponding 
elements on the channel. The controls for the flipped encoder 
appear on the channel fader. 

2  Press and hold the channel Select switch on the channel 
where you want to assign the insert or send. The channel 
scribble strip shows a right arrow (“>– –”) to indicate the chan-
nel is in assign mode. 

3  Move the channel fader to select from the first level of menu 
choices.

4  Press the channel Select switch to move down and the chan-
nel Mute switch to move up through menu levels. 

5  Do one of the following:

• Press the flashing channel Select switch to confirm the 
assignment. 

– or –

• Press the flashing Escape switch to cancel the assign-
ment.
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To change a previously assigned insert or send on a flipped 
encoder:

1  On the channel where you want to change the assignment, 
press the Inserts or Sends switch to display the corresponding 
elements on the channel. 

2  Press and hold the channel Select switch for the flipped in-
sert or send you want to change, until the channel scribble 
strip shows a right arrow (“>”) next to the assignment to indi-
cate the channel is in assign mode.

3  Do one of the following to select a new insert or send:

• Move the channel fader to select from the current level of 
menu choices.

– or –

• Press the channel Select switch to move down and the 
channel Mute switch to move up through menu levels.

4  When the new insert or send is displayed in the channel 
scribble strip, do one of the following:

• Press the flashing channel Select switch to confirm the 
assignment. 

– or –

• Press the flashing Escape switch to cancel the assign-
ment.

To remove an individual insert or send on a flipped encoder:

1  On the channel where you want to remove the assignment, 
press the Inserts or Sends switch to display the corresponding 
elements on the channel. 

2  Press and hold the channel Select switch for the flipped in-
sert or send you want to remove, until the channel scribble 
strip shows a right arrow (“>”) next to the assignment to indi-
cate the channel is in assign mode.

3  Press the encoder Bypass/Mute/Pre switch repeatedly until 
you reach the top level menu for the assignment. 

4  Move the channel fader until no assignment is visible. 

5  Do one of the following:

• Press the flashing channel Select switch to confirm the 
removal. 

– or –

• Press the flashing Escape switch to cancel the removal 
and restore the assignment.



Inline Console Mode
With Inline mode, you can control an input channel and its 
corresponding monitor channel from a single channel strip 
on D-Control.

An input signal (for example, from a Digidesign PRE) is 
brought into an Auxiliary Input track, and routed to an Audio 
track for recording and monitoring. Inline mode on D-Con-
trol is then used to control each of these elements from a sin-
gle channel strip: the PRE and Auxiliary Input level controls 
are controlled with the channel strip encoders, and the record 
track levels are controlled with the channel strip fader.

To control an Auxiliary Input track and Audio track from a single 
D-Control channel strip:

1  Assign the output of a Digidesign PRE (optional) or other au-
dio source to an Auxiliary Input track.

2  Assign the output of the Auxiliary Input track to an Audio 
track.

3  On D-Control, press the Input switch in the Channel Strip 
Mode controls for the Audio channel.

4  On the Audio channel, press the encoder Select switch on 
the lowest row of encoders and turn the encoder knob to se-
lect the Auxiliary Input track.

5  Press Select to confirm the choice. 

The controls for the PRE and the Auxiliary Input appear on the 
Audio channel’s rotary encoders as follows, from top to bot-
tom:

• Encoder 1 Knob/Switch: PRE Phantom Power 

• Encoder 2 Knob/Switch: PRE Polarity

• Encoder 3 Knob/Switch: PRE Impedance/Pad

• Encoder 4 Knob/Switch: PRE Source/Insert

• Encoder 5 Knob/Switch: PRE Gain/HPF 

• Encoder 6 Knob/Switch: Aux Gain/Aux Mute

6  (Optional) Hide the Auxiliary Input channels using the 
Show/Hide Soft Keys.

7  Adjust the PRE gain using Encoder 5.

8  Fine tune the input gain by adjusting the Auxiliary Input 
level using Encoder 6 (the bottom encoder). 

9  Press the Sends switch in the Channel Strip Mode controls 
and configure any cue mixes or effects sends for the channel.

10  Adjust the monitoring level with the Audio channel fader.

To view a hidden Auxiliary Input channel while in Inline mode:

Press Control (Windows) or Command (Macintosh) and 
press the encoder Select switch on Encoder 6.

The Auxiliary Input channel is focused in the Focus Channel 
strip.
Working with Automation

Setting the Automation Mode of Channels

To cycle a channel forward through the automation modes:

Press the Automation Mode switch on the channel.

To cycle a channel backward through the automation modes: 

Hold the Shift (add) Modifier switch and press the Automa-
tion Mode switch on the channel.

To toggle a channel in and out of Trim mode:

Press the Trim switch on the channel. 

To set the automation mode of one or more channels:

1  Hold an Automation Mode switch (Write, Touch, Latch, 
Trim, Read, or Off). 

2  Press the Select switches or Auto switches on the channels 
whose automation mode you want to set.

To set the automation mode of all or all selected channels:

1  Press the Do To All or Do To Selected switch.

2  Press an Automation Mode switch (Write, Touch, Latch, 
Trim, Read, or Off). 

To toggle the write enable status of an automation type across 
all channels:

Press the switch for the corresponding automation type 
(Volume, Pan, Mute, Send Level, Send Pan, Send Mute, or 
Plug-In) in the Automation Enable section.

To suspend automation for all tracks:

Press the Auto Suspend switch in the Channel Strip Master 
Function controls. 
Chapter 11: Normal Mode Operations and Commands 135



1

Displaying the Automation Playlist for a 
Control

To display the automation playlist on-screen for a fader:

Hold Control+Start (Windows) or Command+Control 
(Mac) and touch the fader.

To display the automation playlist on-screen for an encoder:

Hold Control+Start (Windows) or Command+Control 
(Mac) and touch the encoder.

Previewing Automation

To preview a new automation value for a control:

1  Enable the track for automation by cycling its Automation 
Mode switch to enable Touch, Latch, or Touch/Latch mode.

2  Enable the automation type by pressing its switch in the Au-
tomation Enable section.

3  Do one of the following:

• Press the Preview Soft Key in the Actions Soft Keys Page. 

– or –

• Hold Control (Win) or Command (Mac) and press the 
Off switch in the Automation Mode controls. The Off 
switch flashes to indicate Preview mode.

4  Isolate a control by moving it.

5  Start playback and adjust the isolated control to audition 
the new automation value.

To suspend Preview mode;

Do one of the following:

• Press the Suspend Preview Soft Key in the Actions Soft 
Keys Page. 

– or –

• Hold Control (Win) or Command (Mac) and press the 
Read switch in the Automation Mode controls.

To punch a preview value to the automation playlist:

Do one of the following:

• Press the Punch Preview Soft Key in the Actions Page. 

– or –

• Hold Control (Win) or Command (Mac) and press the 
flashing Off switch in the Automation Mode controls.
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Capturing and Recalling Automation

You can capture the current automation values of actively 
writing controls and store them as snapshots. On D-Control, 
up to 48 snapshots can be stored and recalled. These stored 
snapshots are saved with the Pro Tools session.

Capturing Automation Values

Before you can store automation values as a snapshot preset, 
they must be loaded into the Capture buffer.

To capture automation values:

1  In the Channel Strip Function controls, press the Auto 
switch on each channel whose automation values you want to 
capture so that it is in a write-enabled state (Write, Touch, 
Latch, Touch/Latch or Latch).

2  In the Automation Enable controls, press the corresponding 
switch to enable each automation type you want to capture 
(Volume, Pan, Mute, Send level, Send pan, Send mute, or 
Plug-in).

3  In the Management section, press the Snap key to display 
the Capture commands in the Soft Keys section. 

4  Start playback, and if necessary, touch a write-enabled con-
trol to start writing automation. The Capture switch in the 
Soft Keys section lights to indicate that a capture is possible.

5  When the currently writing controls reach a value you want 
to capture, press the Capture switch in the Soft Keys section.

The Punch Capture switch lights in the Soft Keys section lights 
to indicate captured values are available to punch.

Storing and Recalling Captured Automation Values

After automation values are captured, the captured state can 
be stored in any of 48 available snapshot presets. These can 
then be recalled to the Capture buffer, where they are avail-
able to punch.

To store a snapshot:

1  Capture the automation values you want to store. (See “Cap-
turing Automation Values” on page 136.)

2  In the Management section, press the Snap key repeatedly 
until the desired snapshot preset number appears. The bottom 
four Soft Keys show four snapshot presets at a time (1–4, 5–8, 
etc.). 

3  Hold the Soft Key that corresponds to the preset you want 
save for more than one second. 

The automation values currently in the Capture buffer are 
stored in the preset. Any previously saved preset is overwrit-
ten. 



To name a snapshot:

1  In the Management section, press the Snap key repeatedly 
until the desired snapshot preset number appears. 

2  Double-press the Soft Key that corresponds to the snapshot 
you want to name. 

3  Type the name of the snapshot and press the Soft Key that 
corresponds to Enter. 

To recall a snapshot:

1  In the Management section, press the Snap key repeatedly 
until the desired snapshot preset number appears. The bottom 
four Soft Keys show four snapshot presets at a time (1–4, 5–8, 
etc.). 

2  Press the Soft Key that corresponds to the snapshot preset 
you want to recall. The switch flashes to indicate that the pre-
set is loaded into the Capture buffer, and available to punch.

To clear a stored snapshot:

Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and press the Soft Key that corresponds to 
the snapshot you want to clear. 

Punching Recalled Automation Values

To punch a recalled snapshot:

1  Move to a location where you want to apply the captured 
automation states. You can do this during playback or while 
the transport is stopped.

2  Press the Punch Capture switch in the Soft Keys section to 
apply the captured automation states. The captured states are 
applied to all automation types that are currently enabled in 
the Automation window.

Joining Automation Values 

To Join automation values:

1  Make sure the controls you want to join are in a write-en-
abled state.

2  Stop playback during an automation pass.

3  Start playback.

4  When you want to resume automation writing at the previ-
ous values, press the Join switch in the Automation area of the 
Soft Keys section. 
AutoMatching Automation Values

To AutoMatch all currently writing controls:

1  Make sure the automation types you want to AutoMatch are 
write-enabled.

2  Start playback.

3  When you reach a point in the session where you want to re-
turn controls to their previously written values, press the Au-
toMatch switch in the Automation area of the Soft Keys 
section.

AutoMatching Individual Controls

On D-Control, you can invoke AutoMatch on individual con-
trols or control types on single channels.

To AutoMatch all controls of a type on a channel:

Hold Control (Windows) or Command (Mac) and press any 
of the following in the Channel Strip Mode controls for the 
track whose controls you want to AutoMatch:

• Inserts

• Sends

• Pan

• Dyn

• EQ

To AutoMatch the volume fader on a channel:

Hold Control (Windows) or Command (Mac) and press the 
Auto switch in the Channel Strip Function controls for the 
channel.

To AutoMatch a pan control or the controls for an individual 
insert or send on a channel:

1  Press the switch in the Channel Strip Mode controls to dis-
play the Pan controls or the top level of Inserts or Sends for the 
channel. 

2  Hold Control (Windows) or Command (Mac) and press the 
Rotary Encoder Select switch for the control you want to Au-
toMatch:

• For Sends, the Send level, pan, and mute will AutoMatch. 

• For Inserts, all automated controls will AutoMatch. 

• For Pan, all pan sliders on the channel will AutoMatch. 

To AutoMatch all controls for a plug-in displayed in the Dynamics 
or EQ section:

Hold Control (Windows) or Command (Mac) and press the 
Auto switch in the Dyn or EQ section of the console. 
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Chapter 12: Assigning Inserts, Sends and I/O with 
the Assign Matrix
D-Control provides a means of quickly assigning inserts, 
sends, and I/O routing to tracks in a session. Instead of making 
assignments by drilling down multiple levels on a single en-
coder, the Assign Matrix feature temporarily uses a 6 x 8 sec-
tion of encoders to show multiple layers of navigation at one 
time.

Enabling Assign Matrix Operation

The Assign Matrix Enable (“AsnMtx”) console preference de-
termines whether standard Assign mode behavior (which uses 
a single encoder for assignments) or the Assign Matrix is used 
for assigning Inserts, Sends, or I/O routing on the control sur-
face.

When this preference is enabled, the Assign Matrix is used 
for making assignments.

When the preference is not enabled, standard Global and 
local Assign modes are used for making assignments. 

To toggle Assign Matrix operation on and off:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Assign Matrix pref-
erence (“AsnMtx”). 

2  Press the Soft Key that corresponds to “AsnMtx” to toggle 
the setting between “On” and “Off.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.
Assign Matrix Preferences

The following settings and preferences affect the appearance 
and operation of the D-Control Assign Matrix.

Assign Matrix Select Area Justification

The Assign Matrix Select Area Justification preference deter-
mines whether the items in the Assign Matrix Select area are 
displayed in order from top-to-bottom or bottom-to-top on 
D-Control rotary encoders. 

This preference does not affect the display order of items in 
the Menu area. (Display of Inserts and Sends in the Menu area 
follow the Encoder Order preference.)

To set the Assign Matrix Select area justification:

1  In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes Matrix Select Area Justi-
fication (“MtxJst”).

2  Press the Soft Key that corresponds to “MtxJst” to choose be-
tween “Bot-Tp” (bottom-to-top ordering) and “Tp-Bot” 
(top-to-bottom ordering). 

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.
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Assign Matrix Column Width

The Assign Matrix Column Width preferences determine how 
many items appear in each row of the Assign Matrix Select 
Area. 

Assign Matrix Column Width is set independently for I/O as-
signments (I/O paths and Sends) and Plug-Ins. 

Options include 6 items (one Encoder display for each item), 
3 items (two displays per item), 2 items (three displays per 
item) or 1 item (six displays per item) per row. When you 
choose more items, the displayed names are more abbrevi-
ated; when you choose fewer items, names are more fully 
spelled out. 

To set the Assign Matrix Column Width preferences:

1  In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes I/O Column Width 
(“IOClms”) and Plug-In Column Width (“PIClms”).

2  Do any of the following:

• Press the Soft Key that corresponds to “IOClms” to decre-
ment the number of I/O assignments or Send positions to 
display per row. (Hold Shift to increment the number.)

– or –

• Press the Soft Key that corresponds to “PIClms” to decre-
ment the number of Insert positions to display per row. 
(Hold Shift to increment the number.)

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.
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Assign Matrix Rows

The Assign Matrix Rows preference lets you set the number of 
encoder rows used in the Assign Matrix Select Area. 

To set the Assign Matrix Rows preference:

1  In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes Matrix Rows preference 
(“MtxRws”).

2  Press the Soft Key that corresponds to “MtxRws” to decre-
ment the number of rows to display. (Hold Shift to increment 
the number.)

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.

Assign Matrix Lock

The Assign Matrix Lock Enable preference lets you set the As-
sign Matrix to automatically be in Lock mode whenever it is 
opened. 

When this preference is set to “On,” the Assign Matrix al-
ways opens in Lock mode, so that it remains open after assign-
ments are made. The Assign Matrix remains in Lock mode 
until you unlock it.

When this preference is set to “Off,” the Assign Matrix must 
be put into Lock mode manually. 

To set the Assign Matrix Lock Enable preference:

1  In the Soft Keys section, press the Operations switch repeat-
edly to display the page that includes Matrix Lock Enable 
(“MtxLck”).

2  Press the Soft Key that corresponds to “MtxLck” to toggle 
the setting On an Off. 

3  Hold Control (Windows) or Command (Mac) and press the 
Operations switch to exit.



Overview of the Assign Matrix
The Assign Matrix is divided into three main areas: the Menu area, Select area, and Navigation area. 
Arrangement of controls in the Assign Matrix

Select Area

Menu Area Navigation
Area

Track
Name

Back/
Exit

Inserts,
Sends,
or I/O
assignments

Page
Left/Right

Lock/
Unlock
Menu Area

The Menu area is a single column of encoders that shows the 
insert, send, or I/O assignments on the track where you are 
making the assignment. These encoders let you select the in-
sert position, send position, or I/O path you want to assign, as 
well as select different tracks for assignment. 

Select Area

The Select area consists of six columns of encoders that show 
the names of available inserts, sends or I/O paths. These en-
coders let you navigate quickly through submenus and indi-
vidual inserts, sends, and I/O paths. 

Navigation Area

The Navigation area is a single column of encoders that dis-
plays the current menu location in the Assign Matrix, and pro-
vides commands for navigating in the Select area. These en-
coders let you page through available items, go back to 
previous menu levels, lock the display of the Select area, and 
exit Assign mode. 
Assign Matrix Lock Mode

In normal operation, the Assign Matrix closes after you make 
or remove an assignment. You can set the Assign Matrix to re-
main open after an assignment is made or removed, so you 
can make additional assignments.

To set the Assign Matrix to remain open after an assignment is 
made (“Lock mode”):

1  Display an Insert, Send, or I/O assignment in the Assign Ma-
trix.

2  In the Assign Matrix Navigation area, press the encoder Se-
lect switch labeled “Lock.”

The “Lock” switch lights and the encoder display turns red to 
indicate locked status.

To take the Assign Matrix out of Lock mode:

In the Assign Matrix Navigation area, press the lit “Lock” 
switch. 
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Assign Matrix Multi-Assign Mode

(Sends and Outputs Only)

In normal operation, the Assign Matrix lets you make one as-
signment at a time, toggling the previous assignment off. You 
can set the Assign Matrix to allow multiple output assign-
ments. 

To set the Assign Matrix to allow multiple assignments:

1  Display an Insert, Send, or I/O assignment in the Assign Ma-
trix.

2  In the Assign Matrix Navigation area, press the B/M/P 
switch labeled “+” (below the “Lock” encoder”) to latch out-
put assignments.

Insert Assign Matrix
The Insert Assign Matrix lets you display, assign, change, and 
remove inserts from a session. The Insert Assign Matrix shows 
insert positions (A-J), Insert type (such as TDM, RTAS, HW In-
sert), plug-in categories (such as EQ or DYN), plug-in manu-
facturer, and insert or plug-in names in the Assign Matrix Se-
lect area.

Displaying Inserts

To display an Insert in the Assign Matrix:

1  Press the Inserts switch on the channel with the insert you 
want to display. Insert positions are displayed on the channel 
encoders. 

2  Do one of the following at the Insert position you want to 
display: 

• If no insert is present at the Insert position, press the en-
coder Select switch.

– or –

• If an insert is already present at the Insert position, press 
and hold the encoder Select switch. 

The Assign Matrix opens, showing Insert positions in the top 
5 encoders (in yellow) and the track name in the bottom en-
coder (in green) in the Menu Area. The encoder Select switch 
lights for the Insert position that is currently displayed in the 
Select Area. 

If no insert is present at the Insert position, the Select Area 
shows the top level Insert menu items (Insert types such as 
TDM, RTAS, and HW Insert) along with any default or favor-
ites plug-ins on the top level.

If an insert is already present at the Insert position, the Se-
lect Area shows bottom level Insert menu items, with the cur-
rent insert indicated by yellow text and a lit Select switch.
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To page through options in the Assign Matrix Select area: 

Press the Select switch (marked “<“) or BMP switch (marked 
“>“) on the encoder labeled “PG” in the Assign Matrix Navi-
gation area. To page continuously, press and hold the 
switches. 

To scroll through options in the Assign Matrix Select area: 

Turn the encoder knob labeled “PG” in the Assign Matrix 
Navigation area.

To move down through Insert menu levels:

Press the encoder Select switch for a menu item in the As-
sign Matrix Select area. 

To move up through Insert menu levels, do one of the following:

In the Assign Matrix Navigation area, press the bottom en-
coder Select switch (labeled “Back”). 

– or –

In the Assign Matrix Navigation area, press the encoder Se-
lect switch for a menu level (such as TDM, RTAS, or HW Insert) 
on the top encoders, to return to that level.

To momentarily display the full name of a menu item or insert in 
the encoder displays:

Touch the encoder knob for the item.

To open/close the window for an insert:

Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Insert position in the Assign Matrix 
Menu area. 

Changing Insert Display for a Track in the Assign 
Matrix

To display a different Insert in the Assign Matrix by paging 
through inserts:

1  In the Assign Matrix Menu Area, do one of the following to 
toggle the Menu Area view between Inserts A-E and Inserts F-J:

• Press the lit Page Up or Page Down switch in the Assign 
Matrix Menu area. 

– or –

• Turn any encoder in the Assign Matrix Menu area. 

2  Press the encoder Select switch for the Insert position you 
want to display. 



To display a different Insert in the Assign Matrix by displaying 
insert names:

1  In the Assign Matrix Menu Area, press the B/M/P switch for 
any insert. The Insert positions are displayed in the Assign Ma-
trix Select area.

2  Press the encoder Select switch for the Insert position you 
want to display. 

Changing Track Display in the Assign Matrix

To display inserts for a different track in the Assign Matrix by 
scrolling through track names:

1  In the Assign Matrix Menu Area, press the bottom encoder 
(track name) Select switch. 

2  Turn the bottom encoder to scroll through the tracks in the 
session. 

3  Press the flashing Select switch to display the inserts for that 
track in the Assign Matrix. 

To display inserts for a different track in the Assign Matrix by 
displaying track names:

1  In the Assign Matrix Menu Area, press the bottom encoder 
(track name) B/M/P switch. The track names are displayed in 
the Assign Matrix Select area. 

2  If necessary, use the “PG” encoder or switches in the Assign 
Matrix Navigation area to locate the track you want to display.

3  Press the encoder Select switch for the track you want to dis-
play. 

Closing the Assign Matrix

To close the Assign Matrix, do any of the following:

Press the bottom encoder Select switch (when labeled 
“Exit”) in the Assign Matrix Navigation Area. This exits the As-
sign Matrix even when the Matrix is locked.

Hold Control (Windows) or Command (Mac) and press the 
bottom encoder Select switch (when labeled “Back”) in the As-
sign Matrix Navigation Area. This exits the Assign Matrix even 
when the Matrix is locked.

Press the flashing Escape switch. This works only when the 
Assign Matrix is not locked.
Assigning Inserts

To assign an Insert (where no insert is present):

1  Press the Inserts switch on the channel where you want to 
assign the insert. Insert positions are displayed on the channel 
encoders.

2  Press the encoder Select switch at the Insert position where 
you want to make an assignment. The Assign Matrix opens, 
with the top level Insert menu items (Insert types such as 
TDM, RTAS and HW Inserts) displayed in the Select Area.

3  Press the encoder Select switch for the type of insert you 
want to assign. 

4  Press the encoder Select switch for the next level menu 
choice (for example, Plug-In Category or Manufacturer). 

5  Press the encoder Select switch for the insert you want to as-
sign.

To assign a different Insert (where an insert is present):

1  Press the Inserts switch on the channel where you want to 
assign the insert. Insert positions are displayed on the channel 
encoders.

2  Press and hold the encoder Select switch at the Insert posi-
tion where you want to change the assignment. The Assign 
Matrix opens, with the current insert displayed in the Select 
Area, indicated by yellow text and a lit Select switch.

3  If necessary, use the switches in the Assign Matrix Naviga-
tion area to locate the insert you want to assign.

4  Press the encoder Select switch for the insert you want to as-
sign.

To remove an insert:

1  Press the Inserts switch on the channel where you want to 
remove the insert. Insert positions are displayed on the chan-
nel encoders.

2  Press and hold the encoder Select switch at the Insert posi-
tion where you want to remove the assignment. The Assign 
Matrix opens, with the insert displayed in the Select Area, in-
dicated by yellow text and a lit Select switch.

3  Do one of the following:

• Hold the Set to Default switch and press the encoder Se-
lect switch for any insert in the Assign Matrix Select area. 

– or –

• In the Assign Matrix Navigation area, press the encoder 
Select switch labeled “Back” on the bottom encoder until 
you reach the top level of menu items, then press the en-
coder Select switch that corresponds to “--” (No Insert) in 
the Assign Matrix Select area.
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Send Assign Matrix
The Send Assign Matrix lets you display, assign, change, and 
remove sends from a session. The Send Assign Matrix shows 
send positions (A-J), Send type (Interface or Bus), and send 
names in the Assign Matrix Select area.

Displaying Sends

To display a Send in the Assign Matrix:

1  Press the Sends switch on the channel with the send you 
want to display. Send positions are displayed on the channel 
encoders.

2  Do one of the following at the Send position you want to 
display: 

• If no send is present at the Send position, press the en-
coder Select switch.

– or –

• If a send is already present at the Send position, press and 
hold the encoder Select switch. 

The Assign Matrix opens, showing Send positions in the top 5 
encoders (in yellow) and the track name in the bottom en-
coder (in green) in the Menu Area. The encoder Select switch 
lights for the Send position that is currently displayed in the 
Select Area. 

If no send is present at the Send position, the Select Area 
shows the top level Send types (Interface and Bus).

If a send is already present at the Send position, the Select 
Area shows send paths, with the current send path indicated 
by yellow text and a lit Select switch.

To page through options in the Assign Matrix Select area: 

Press the Select switch (marked “<“) or BMP switch (marked 
“>“) on the encoder labeled “PG” in the Assign Matrix Navi-
gation area. To page continuously, press and hold the 
switches. 

To scroll through options in the Assign Matrix Select area: 

Turn the encoder knob labeled “PG” in the Assign Matrix 
Navigation area.

To move down through Send menu levels:

Press the encoder Select switch for Interface (“intrfc”) or Bus 
(“bus”) in the Assign Matrix Select area. 
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To move up to the top Send menu level, do one of the following:

In the Assign Matrix Navigation area, press the bottom en-
coder Select switch (labeled “Back”). 

– or –

In the Assign Matrix Navigation area, press the encoder Se-
lect switch for Interface (“intrfc”) or Bus (“bus”) on the top en-
coder.

To momentarily display the full name of a menu item or send path 
in the encoder displays:

Touch the encoder knob for the item.

To open/close the window for a send:

Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Send position in the Assign Matrix 
Menu area. 

Changing Send Display for a Track in the Assign 
Matrix

To display a different send in the Assign Matrix by paging through 
Sends:

1  In the Assign Matrix Menu Area, do one of the following to 
toggle the Menu Area view between Sends A-E and Sends F-J:

• Press the lit Page Up or Page Down switch in the Assign 
Matrix Menu area. 

– or –

• Turn any encoder in the Assign Matrix Menu area. 

2  Press the encoder Select switch for the Send position you 
want to display. 

To display a different send in the Assign Matrix by displaying 
Send names:

1  In the Assign Matrix Menu Area, press the B/M/P switch for 
any send. The Send positions are displayed in the Assign Ma-
trix Select area.

2  Press the encoder Select switch for the Send position you 
want to display. 

Changing Track Display in the Assign Matrix

To display sends for a different track in the Assign Matrix by 
scrolling through track names:

1  In the Assign Matrix Menu Area, press the bottom encoder 
(track name) Select switch. 

2  Turn the bottom encoder to scroll through the tracks in the 
session. 

3  Press the flashing Select switch to display the sends for that 
track in the Assign Matrix. 



To display sends for a different track in the Assign Matrix by 
displaying track names:

1  In the Assign Matrix Menu Area, press the bottom encoder 
(track name) B/M/P switch. The track names are displayed in 
the Assign Matrix Select area. 

2  If necessary, use the “PG” encoder or switches in the Assign 
Matrix Navigation area to locate the track you want to display.

3  Press the encoder Select switch for the track you want to dis-
play. 

Closing the Assign Matrix

To close the Assign Matrix, do any of the following:

Press the bottom encoder Select switch (when labeled 
“Exit”) in the Assign Matrix Navigation Area. This exits the As-
sign Matrix even when the Matrix is locked.

Hold Control (Windows) or Command (Mac) and press the 
bottom encoder Select switch (when labeled “Back”) in the As-
sign Matrix Navigation Area. This exits the Assign Matrix even 
when the Matrix is locked.

Press the flashing Escape switch. This works only when the 
Assign Matrix is not locked.

Assigning Sends

To assign a send (where no send path assignment is present):

1  Press the Sends switch on the channel where you want to as-
sign the send. Send positions are displayed on the channel en-
coders.

2  Press the encoder Select switch at the Send position where 
you want to make an assignment. The Assign Matrix opens, 
with the top level Send types (Interface and Bus) displayed in 
the Select Area.

3  Press the encoder Select switch for the type of send you want 
to assign. 

4  Press the encoder Select switch for the send path you want 
to assign.

To assign a different send (where a send path assignment is 
present):

1  Press the Sends switch on the channel where you want to as-
sign the send. Send positions are displayed on the channel en-
coders.

2  Press and hold the encoder Select switch at the Send posi-
tion where you want to change the assignment. The Assign 
Matrix opens, with the current send path displayed in the Se-
lect Area, indicated by yellow text and a lit Select switch.

3  If necessary, use the switches in the Assign Matrix Naviga-
tion area to locate the send path you want to assign.
4  Press the encoder Select switch for the send path you want 
to assign.

To assign a send to multiple output paths:

1  Follow the above procedures to use the Assign Matrix to as-
sign or change a send path assignment.

2  If you want to make multiple assignments, enable Assign 
Lock mode by pressing the encoder Select switch labeled 
“Lock” in the Assign Matrix Navigation area. 

3  In the Assign Matrix Navigation area, press the B/M/P 
switch labeled “+” (below the “Lock” encoder) to latch output 
assignments.

4  If necessary, use the switches in the Assign Matrix Naviga-
tion area to locate the send path you want to assign.

5  Press the encoder Select switches for the additional output 
paths you want to assign.

To remove a send:

1  Press the Sends switch on the channel where you want to re-
move the send. Send positions are displayed on the channel 
encoders.

2  Press and hold the encoder Select switch at the Send posi-
tion where you want to remove the assignment. The Assign 
Matrix opens, with the send displayed in the Select Area, indi-
cated by yellow text and a lit Select switch.

3  In the Assign Matrix Navigation area, press the encoder Se-
lect switch labeled “Back” on the bottom encoder until you 
reach the top level of Sends, then press the encoder Select 
switch that corresponds to “--” (No Send) in the Assign Matrix 
Select area.
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I/O Assign Matrix
The I/O Assign Matrix lets you display, assign, change, and re-
move I/O assignments on different types of tracks, as follows:

• Audio tracks and Auxiliary Input tracks: audio input and 
output paths

• MIDI tracks: MIDI input and output channels

• Instrument tracks: MIDI input and output channels, audio 
input and output paths

• VCA Master tracks: Group assignments

• Master Faders: output paths

Displaying I/O Paths

To display an I/O path in the Assign Matrix:

1  Press and hold the Sends switch on the channel whose I/O 
routing you want to display.

2  Press the encoder Select switch for the Input or Output you 
want to display.

The Assign Matrix opens, showing input and output path 
names in the upper encoders (in yellow) and the track name 
in the bottom encoder (in green) in the Menu Area. The en-
coder Select switch lights for the path that is currently dis-
played in the Select Area. 

To page through options in the Assign Matrix Select area: 

Press the Select switch (marked “<“) or BMP switch (marked 
“>“) on the encoder labeled “PG” in the Assign Matrix Navi-
gation area. To page continuously, press and hold the 
switches. 

To scroll through options in the Assign Matrix Select area: 

Turn the encoder knob labeled “PG” in the Assign Matrix 
Navigation area.

To move down through I/O menu levels (for audio paths):

Press the encoder Select switch for Interface (“intrfc”) or Bus 
(“bus”) in the Assign Matrix Select area. 

To move up to the top I/O menu level (for audio paths), do one of 
the following:

In the Assign Matrix Navigation area, press the bottom en-
coder Select switch (labeled “Back”). 

– or –

In the Assign Matrix Navigation area, press the encoder Se-
lect switch for Interface (“intrfc”) or Bus (“bus”) on the top en-
coder.
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To momentarily display the full name of a menu item or I/O path 
in the encoder displays:

Touch the encoder knob for the item.

To open/close a track Output window (for audio paths):

Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the Output in the Assign Matrix Menu 
area. 

Changing i/O Display for a Track in the Assign 
Matrix

To display a different I/O path in the Assign Matrix:

1  In the Assign Matrix Menu Area, press the B/M/P switch for 
any path. The I/O paths are displayed in the Assign Matrix Se-
lect area.

2  Press the encoder Select switch for the I/O path you want to 
display. 

Changing Track Display in the Assign Matrix

To display I/O paths for a different track in the Assign Matrix by 
scrolling through track names:

1  In the Assign Matrix Menu Area, press the bottom encoder 
(track name) Select switch. 

2  Turn the bottom encoder to scroll through the tracks in the 
session. 

3  Press the flashing Select switch to display the I/O paths for 
that track in the Assign Matrix. 

To display I/O paths for a different track in the Assign Matrix by 
displaying track names:

1  In the Assign Matrix Menu Area, press the bottom encoder 
(track name) B/M/P switch. The track names are displayed in 
the Assign Matrix Select area. 

2  If necessary, use the “PG” encoder or switches in the Assign 
Matrix Navigation area to locate the track you want to display.

3  Press the encoder Select switch for the track you want to dis-
play. 



Closing the Assign Matrix

To close the Assign Matrix, do any of the following:

Press the bottom encoder Select switch (when labeled 
“Exit”) in the Assign Matrix Navigation Area. This exits the As-
sign Matrix even when the Matrix is locked.

Hold Control (Windows) or Command (Mac) and press the 
bottom encoder Select switch (when labeled “Back”) in the As-
sign Matrix Navigation Area. This exits the Assign Matrix even 
when the Matrix is locked.

Press the flashing Escape switch. This works only when the 
Assign Matrix is not locked.

Assigning I/O Paths

To assign an I/O path:

1  Press and hold the Sends switch on the channel where you 
want to assign the path. I/O paths are displayed on the chan-
nel encoders.

2  Press the encoder Select switch for the I/O path you want to 
assign. The Assign Matrix opens, with the current path indi-
cated by yellow text and a lit Select switch.

3  If necessary, use the switches in the Assign Matrix Naviga-
tion area to locate the I/O path you want to assign.

4  Press the encoder Select switch for the I/O path you want to 
assign.
To assign multiple output paths (audio or MIDI):

1  Follow the above procedures to use the Assign Matrix to as-
sign or change an output path assignment.

2  If you want to make multiple assignments, enable Assign 
Lock mode by pressing the encoder Select switch labeled 
“Lock” in the Assign Matrix Navigation area. 

3  In the Assign Matrix Navigation area, press the B/M/P 
switch labeled “+” (below the “Lock” encoder) to latch output 
assignments.

4  If necessary, use the switches in the Assign Matrix Naviga-
tion area to locate the output path you want to assign.

5  Press the encoder Select switches for the additional output 
paths you want to assign.

To remove an I/O path:

1  Press and hold the Sends switch on the channel where you 
want to remove the path. I/O paths are displayed on the chan-
nel encoders.

2  Press the encoder Select switch for the I/O path you want to 
remove. The Assign Matrix opens, with the current path indi-
cated by yellow text and a lit Select switch.

3  In the Assign Matrix Navigation area, press the encoder Se-
lect switch labeled “Back” on the bottom encoder until you 
reach the top level of I/O paths, then press the encoder Select 
switch that corresponds to “--” (No I/O) in the Assign Matrix 
Select area.
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Chapter 13: Custom Fader Modes
With the Custom Faders feature, you can temporarily set aside 
channel strips on D-Control and focus them on your own cus-
tomized groups of tracks, on Pro Tools Mix and Edit groups, 
on specific track types, or on plug-in controls. Custom Fader 
modes are only accessible on D-Control, and are not displayed 
on-screen in Pro Tools.

On D-Control, Custom Fader channels are completely sepa-
rate from the surrounding channels on the control surface. All 
tracks in the session bank around the Custom Fader channels, 
and continue to behave normally in Pro Tools and on D-Con-
trol.

All Custom Fader modes essentially duplicate the controls on 
tracks already represented in Normal mode, but let you rear-
range them to fit your workflow. Any control moves per-
formed on a Custom Fader channel are mirrored in the Nor-
mal mode channel if it is present on D-Control.

When channels are in use by any of the Custom Fader modes, 
the blue indicator marked “CF,” located to the left of the 
channel fader, is lit.

The status of Custom Fader modes is saved with the Pro Tools 
session. If you save and close a session with a Custom Fader 
mode active, the session will reopen with the same mode ac-
tive.

Layout of Custom Fader Banks on D-Control

D-Control has available two independent banks of Custom 
Faders (Left Custom Faders and Right Custom Faders), con-
trolled by the Custom Fader Control sections on the left and 
right sides of the Main Unit.

Each of the Custom Fader banks can be controlled from the 
Bank Select Matrix, with the corresponding group, track or 
plug-in information appearing in the Soft Keys. The Custom 
Fader bank currently targeted in the Bank Select Matrix is in-
dicated by yellow text in the Custom Fader display.
Overview of Custom Fader Modes
The four Custom Fader modes are covered in detail later in 
this chapter: 

Custom Groups Mode Lets you create and recall up to 48 cus-
tom arrangements of tracks on D-Control that are indepen-
dent of Mix/Edit groups in Pro Tools.

Mix/Edit Groups Mode Lets you recall Pro Tools Mix or 
Mix/Edit groups and display them on the Custom Fader chan-
nel strips. You can also activate and delete Mix or Mix/Edit 
groups from this mode.

Tracks Mode Lets you bring all tracks of a particular type to the 
Custom Fader channel strips. Track Types include Audio 
tracks, Auxiliary Input tracks, MIDI tracks, Instrument tracks, 
Master Fader tracks, VCA Master tracks, and Hidden tracks.

Plug-In Mode Lets you focus the controls of two separate 
plug-in on the two available Custom Fader channel banks. A 
special expanded Plug-In mode focuses the plug-in header 
controls (such as Bypass, Compare and Safe) on the channel 
strip Mute switches. 

Two additional modes work in conjunction with these Cus-
tom Fader modes:

Custom Fader Flip Mode Lets you flip rows of encoder controls 
to the faders on the Custom Fader channel strips.

Custom Fader Map Mode Lets you map individual encoder 
controls to faders on the Custom Fader channel strips on a 
track-by-track basis.
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Custom Fader Preferences

Setting the Maximum Custom Fader Bank Size

You can independently set the size of each of the two available 
Custom Fader banks for each of the Custom Fader modes. See 
“Maximum Custom Fader Bank Size” on page 42.

Setting the Custom Fader Justification

You can set the location of the two available Custom Fader 
banks on the control surface. See “Custom Fader Bank Justifi-
cation” on page 42.

Displaying Hidden Tracks in Custom Faders

You can set D-Control to show hidden tracks in the Custom 
Fader views. See “Display of Hidden Tracks in Custom Faders” 
on page 43.

Custom Fader Controls

The Custom switch, Groups switch, Master switch, and 
Plug-In switch in the Custom Faders sections light when the 
corresponding Custom Fader mode is active. 

The Map switch and Flip switch work in combination with the 
Custom Fader modes (except Master Faders mode), and have 
no independent effect.

The Lock switch and Window switch function both in the 
Custom Fader modes and independently. See “Lock Switch” 
on page 68. 

Custom Fader controls

Map switch

Flip switch

Lock switch

Window switch

Custom Groups switch

Mix/Edit Groups switch

Tracks switch

Plug-in switch

Bank/Cycle switch

Custom Faders
display
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Custom Groups Mode
Custom Groups mode lets you create a custom collection of 
tracks and arrange them in any order in either of the two avail-
able banks of Custom Fader channels. You can create up to 48 
independent Custom Groups in a session. 

Custom Groups are useful for temporarily associating tracks 
that are not part of a Pro Tools Mix/Edit group. Also, because 
you can add multiple instances of the same track to a Custom 
Group, you can use this mode, in conjunction with Flip mode 
or Map mode, to map multiple parameters from a single track 
onto adjacent channel faders.

Custom Groups are created and recalled entirely on D-Con-
trol, and are independent of Mix/Edit groups in Pro Tools. 
D-Control Custom Groups are not reflected on-screen in 
Pro Tools. Custom Groups are saved in the Pro Tools session 
file, and move with the session to any other system that sup-
ports D-Control operation. 

Displaying Custom Groups

Custom Groups are accessible in the Bank Select Matrix in four 
pages of 12 (1–12, 13–24, 25–36, and 37–48). 

Custom Groups can also be displayed and recalled from the 
Soft Keys section (in pages of six) by repeatedly pressing the 
Bank Select switch in the Soft Keys section.

To create a new Custom Group:

1  Press the Custom switch in the left or right Custom Faders 
section. The switch lights to indicate the mode is active for the 
corresponding Custom Fader bank.

2  Hold Shift and press the Bank/Cycle switch in that Custom 
Faders section to go to the page (1–12, 13–24, 25–36, or 37–48) 
of the Bank Select Matrix where you want to assign the new 
Custom Group.

3  In the Bank Select Matrix, press the Bank Select switch 
(1–12) to which you want to assign the new Custom Group. 
The switch lights to indicate the selection.

4  Press the Edit switch in the Bank Select section. The Edit 
switch flashes to indicate Edit mode.

5  Do one of the following:

• Press the Select switch for each source channel you want 
to add to the Custom Group. 

• Hold Shift while pressing a lit Select switch to put the 
same track on multiple faders.

• To remove a track from the Custom Group, press its Se-
lect switch in the Custom Fader channels.

Tracks are added to the Custom Group in the order you select 
them, and are right-justified in the Custom Fader channels.

6  Press the flashing Edit switch in the Bank Select section 
when you are finished.



To recall a Custom Group from the Bank Select Matrix:

1  Press the Custom switch in the left or right Custom Faders 
section. The switch lights to indicate the mode is active for the 
corresponding Custom Fader bank.

2  Hold Shift and press the Bank/Cycle switch in that Custom 
Faders section to go to the page (1–12, 13–24, 25–36, or 37–48) 
of the Bank Select Matrix containing the Custom Group you 
want to recall.

3  Press the Bank Select switch (1–12) for the Custom Group 
you want to recall.

To recall a Custom Group from the Custom Fader rotary 
encoders: 

1  Hold the Custom switch in either of the Custom Fader sec-
tions until the available Groups appear in the rotary encoder 
displays of the Custom Faders. 

2  Press the encoder Select switch to select the group you want 
to display in the Custom Faders.

To name a Custom Group:

1  Recall the Custom Group you want to name.

2  Double-press the Edit switch in the Bank Select section.

3  Enter a name for the Custom Group and click OK. 

To add channels to a Custom Group:

1  Recall the Custom Group you want to edit.

2  Press the Edit switch in the Bank Select section. The Edit 
switch flashes to indicate Custom Groups Edit mode. 

3  Press the channel Select switch on the Custom Fader chan-
nel strip to the right of the position where you want to insert 
new channels.

4  Press the channel Select switch on each source channel you 
want to add to the Custom Group.

5  Press the flashing Edit switch in the Bank Select section to 
exit.

The new channels are added the Custom Group, located to the 
left of the selected Custom Fader channel strip.

To remove channels from a Custom Group:

1  Recall the Custom Group you want to edit.

2  Do one of the following:

• Press the channel Select switch on the source channels 
you want to remove from the Custom Group.

The Bank Select switches remember their previous mode 
of operation (either Custom Groups or Mix/Edit Groups). 
If you last used the Bank Select switch in Custom Groups 
mode, you can recall a Custom Group directly from the 
Bank Select switches. It is not necessary to press the 
Custom Group switch first. 
• Hold Control+Start (Windows) or Control+Command 
(Macintosh) and press the channel Select switch on the 
Custom Fader channels you want to remove.

• Hold the Set To Default switch and press the channel Se-
lect switch on a Custom Fader channel you want to re-
move.

To delete a Custom Group:

1  Recall the Custom Group you want to delete.

2  Hold Start+Alt+Control (Windows) or Control+Op-
tion+Command (Macintosh) and press the corresponding 
switch in the Bank Select Matrix. 

To exit Custom Groups Mode:

Press the lit Custom Groups switch. 

Custom Fader Mix/Edit Groups Mode
Mix/Edit Groups mode lets you create, display, and edit 
Pro Tools Mix and Mix/Edit groups in either of the two avail-
able banks of Custom Fader channels. Mix/Edit Groups mode 
is useful for quickly calling the members of a group to a set of 
faders for mixing and automation.

To show a Mix/Edit group in the Custom Fader channels:

Press the Groups switch in the left or right Custom Fader 
section. 

The switch lights, the group’s letter and name appear in the 
corresponding Custom Fader display, and the group members 
appear in the Custom Fader channels.

Mix/Edit Groups can also be displayed and recalled from the 
Soft Keys section (in pages of six) by repeatedly pressing the 
Bank Select switch in the Soft Keys section.

To focus different groups, press the corresponding switch in 
the Bank Select Matrix. Groups are recalled in sequence ac-
cording to their group letter:

• Bank Select 1 corresponds to the All group. 

• Bank Select 2–12 correspond to groups a–k.

• Hold Shift and press Bank/Cycle to change Bank Select 
switches 1–12 to correspond to groups l–w.

• Hold Shift and press Bank/Cycle a second time to change 
Bank Select switches 1–3 to correspond to groups x–z. 

The Bank Select switches remember their previous mode 
of operation (either Custom Groups or Mix/Edit 
Groups). If you last used the Bank Select switch in 
Mix/Edit Groups mode, you can recall a Mix/Edit Group 
directly from the Bank Select switches. It is not necessary 
to press the Mix/Edit Group switch first. 
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To activate/deactivate a Mix/Edit group:

While in Mix/Edit Groups mode, do one of the following:

• Hold Start+Control (Windows) or Control+Command 
(Macintosh) and press the group’s corresponding switch 
in the Bank Select section. 

– or –

• Hold the Custom Fader Groups switch until it flashes, 
then press switches in the Bank Select section for the 
groups you want to activate/deactivate. When you are 
finished, press the flashing Groups switch. 

A deactivated group is indicated by inverted text in the Cus-
tom Faders display. 

To show and activate a Mix/Edit Group from the Custom Fader 
rotary encoders: 

1  Hold the Groups switch in either of the Custom Fader sec-
tions until the available Groups appear in the rotary encoder 
displays of the Custom Faders. 

2  Press the encoder Select switch to select the group you want 
to display in the Custom Faders.

3  Press the encoder BMP switch to toggle the corresponding 
group active or inactive. 

To create a Mix/Edit group:

1  Make sure you are in Select mode.

2  Select the tracks you want to group by pressing their Select 
switches.

3  Press the Groups switch to enter Mix/Edit Groups mode.

4  In the Bank Select Matrix, press the Bank Select switch to 
which you want to assign the new Mix/Edit group. 

5  Double-press the Edit switch in the Bank Select section. 

6  Choose the type of group to create: Edit Group, Mix Group, 
or Edit/Mix Group.

7  Enter a name for the Group and press Enter. 

To edit a Mix/Edit group:

1  Make sure you are in Select mode.

2  Press the Groups switch to enter Mix/Edit Groups mode.

3  In the Bank Select Matrix, press the Bank Select switch to re-
call the Mix/Edit group you want to edit.

4  Press the Edit switch in the Bank Select section. 

5  Do any of the following:

• Press the channel Select switch on the source channels 
you want to add or remove from the group.

• Press the lit channel Select switch on the Custom Fader 
channels you want to remove from the group.

6  Press the flashing Edit switch to confirm the group.
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To delete a Mix/Edit group:

In Mix/Edit Groups mode, hold Start+Alt+Control (Win-
dows) or Control+Option+Command (Macintosh) and press 
the switch in the Bank Select section that corresponds to the 
group you want to delete.

To exit Mix/Edit Groups Mode:

Press the lit Groups switch.

Displaying Mix/Edit Group Tracks On-Screen

In the top level of Mix/Edit Groups mode, you can display the 
tracks in a Mix/Edit group and hide all other tracks from 
D-Control. 

To display tracks in a Mix/Edit group on-screen:

Hold Start (Windows) or Control (Mac) and press the Select 
switch for the Mix/Edit group to perform the “Show Only 
Tracks In Group” command. 

Displaying or “Spilling” VCA Slave Tracks to 
Custom Faders

You can display all of the slave tracks for a VCA Master track 
into the Custom Faders. This feature uses Mix/Edit Groups 
mode to replicate a “VCA spill” command.

Whenever a VCA Master track is assigned to group, its By-
pass/Mute switch lights. 

To spill VCA slave tracks in Custom Faders:

Press the lit Bypass/Mute switch on a VCA Master track. The 
Bypass/Mute switch flashes to indicate that the VCA Group is 
spilled.

To exit display of VCA slave tracks in Custom Faders, do one of 
the following:

Press the flashing Bypass/Mute switch in the VCA Master 
track. 

– or –

Press the Groups switch in the Custom Fader controls.



Focusing VCA Masters When Their Slave Tracks Are 
Spilled

You can set D-Control to automatically focus a VCA Master 
track in the Focus Channel Strip when its slave tracks are 
spilled.

To automatically focus VCA tracks when they are spilled:

1  In the Soft Keys section, press the Operation switch repeat-
edly to display the page that includes the Focus VCA Master 
When Spilled preference (“SplFcs”).

2  Press the Soft Key that corresponds to “SplFcs” to toggle the 
setting to “On.”

3  Hold Control (Windows) or Command (Mac) and press the 
Operation switch to exit.

Custom Fader Tracks Mode
Tracks Mode lets you bring all tracks of a particular type to ei-
ther of the two available banks of Custom Fader channels. 
Track type for each bank of Custom Faders can be selected 
from the Bank Select Matrix:

• Bank Select 1 = Master Faders

• Bank Select 2 = Audio Tracks

• Bank Select 3 = Auxiliary Inputs

• Bank Select 4 = MIDI Tracks

• Bank Select 5 = Instrument Tracks

• Bank Select 6 = VCA Master Tracks

• Bank Select 7 = Hidden Tracks

If the number of tracks exceeds the number of Custom Fader 
channel strips, the tracks can be banked with the Bank/Cycle 
switch in the Custom Faders section.

Track types can also be displayed and selected in the Soft Keys 
section by pressing the Bank Select switch.

To bring a Track type to Custom Fader channels:

1  Press the Tracks switch in the left or right Custom Fader
section. 

2  Press the Bank Select switch to display track types in the Soft 
Keys section.

3  Press the Soft Key that corresponds to the track type you 
want to display in the Custom Fader channels.

The name of the Track type appears in the corresponding Cus-
tom Fader display. Tracks of the designated type appear in the 
Custom Fader channels.

To exit Tracks mode:

Press the lit Tracks switch.
Custom Fader Plug-In Mode
Plug-In mode focuses available plug-ins on the focused chan-
nel on the left and right Custom Fader channels. This places 
all of the plug-in’s parameters on the Custom Fader channel 
encoders, and any plug-in meters on the Custom Fader chan-
nel meters.

With plug-ins that have multiple pages of parameters, you can 
select pages from the Bank Select Matrix. If a plug-in has more 
than 12 pages, you can cycle though banks of pages by hold-
ing Shift and pressing the Bank/Cycle switch in the Custom 
Faders section.

The plug-in pages can also be accessed from the Soft Keys sec-
tion by pressing the Bank Select switch in the Soft Keys sec-
tion. 

This mode is useful for controlling plug-ins with a large num-
ber of controls, such as virtual instruments. 

To focus a plug-in on Custom Fader channels: 

1  Focus the plug-in’s track on the Focus Channel Strip by 
pressing the track’s Select switch. The names of available 
plug-ins appear in the left and right Custom Fader displays.

2  Press the Plug-In switch in either of the Custom Fader sec-
tions. The switch lights to indicate the mode is active. The 
plug-in’s parameters appear in the Custom Fader channel en-
coders.

3  In either of the Custom Faders sections, press the Bank/Cy-
cle switch to cycle through the plug-ins on the focused chan-
nel. (The No Insert option is always available.)

To focus a plug-in in Custom Fader mode directly from top-level 
Inserts view:

Hold Control+Alt (Windows) or Command+Option (Mac) 
and press the encoder Select switch for the plug-in you want 
to focus.

Custom Faders and Display of Plug-In Parameters

There are three view options available for display of plug-in 
parameters in the channel displays of the Custom Faders. 
These options, or view definitions, are accessible from the 
D-Control operation preferences. See “Custom Fader Plug-In 
Mode View Definitions” on page 43 for more information. 

Display of Parameter Types in the Rotary Encoders

In general, continuous plug-in parameters map to the Custom 
Fader encoder knobs, and switched parameters functions map 
to the B/M/P (Bypass/Mute/Pre) encoder switches. The pres-
ence of a switched parameter is indicated by the Pre indicator 
above the corresponding B/M/P switch. 
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To display the parameter controlled by the B/M/P switches:

Press the Switch Info switch.

Plug-in meters map to the Custom Fader channel meters. 
Plug-in input and output meters appear as standard level 
meters with green, yellow, and red segments. Any dynamics 
gain reduction meters (for example, in a compressor or limiter 
plug-in) are shown as top-to-bottom meters with yellow seg-
ments. 

Expanded Plug-In View

In Custom Fader Plug-In mode, Expanded Plug-In view lets 
you access additional plug-in controls and manage individual 
channels (also called streams) of a multi-mono plug-in. This 
mode places the following standard header controls in the 
channel displays:

• Plug-In Bypass

• Plug-In Compare

• Plug-In Automation Safe

• Plug-In Automation Enable

To enter Expanded Plug-In view:

Press and hold the Plug-In switch in the Custom Fader sec-
tion until the switch flashes. 

The plug-in header controls are mapped as follows:

Plug-In Bypass To bypass the currently displayed plug-in, press 
the Mute switch that corresponds to “Bypass” in the channel 
displays. This toggles the Effect Bypass button in the Plug-In 
window. 

Plug-In Compare To toggle between the original saved plug-in 
setting and any changes you have made to it, press the Mute 
switch that corresponds to “Comp” in the channel displays. 
This toggles the Compare button in the Plug-In window.

Plug-In Automation Safe To prevent existing plug-in automa-
tion from being overwritten, press the Mute switch that corre-
sponds to “Safe” in the channel displays. This toggles the Safe 
button in the Plug-In window.

Plug-In Automation Enable To enable individual plug-in con-
trols for automation, press the Mute switch that corresponds 
to “AutoEn” in the channel displays. This lists the automat-
able plug-in controls on the Custom Fader encoders. Choose 
the controls to automate by pressing their encoder Select 
switches. This toggles the Auto button in the Plug-In window.

In some cases, the same control may be mapped to both 
an encoder knob and its corresponding switch, allowing 
you to use either control to adjust the parameter.

If the Custom Fader Plug-In Mode View Definition is set 
to Expanded view, then you are automatically in Ex-
panded Plug-In View when you enter Plug-In mode.
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Multi-Mono Plug-Ins and Expanded Plug-In Mode

With multi-mono plug-ins, the following plug-in channel 
controls are also mapped to the Custom Fader channel dis-
plays:

Link To link channels of a multi-mono plug-in, press the Mute 
switch that corresponds to “Link” in the channel displays. 
This toggles the Master Link button in the Plug-In window

Target Stream To target a particular multi-mono plug-in chan-
nel for editing, press the Mute switch that corresponds to 
“TargtS” in the channel displays. This lists the channels of the 
plug-in on the Channel Fader encoders. You can then choose 
a channel by pressing its encoder Select switch. The switch 
lights to indicate the targeted channel. 

Group Stream To group individual multi-mono plug-in chan-
nels for editing, press the Mute switch that corresponds to 
“GroupS” in the channel displays. This lists the channels of 
the plug-in on the Channel Fader encoders. You can then 
group any number of streams by pressing their encoder Select 
switches. The Select switches light to indicate grouped chan-
nels.

Bypass Stream To bypass individual multi-mono plug-in 
streams, press the Mute switch that corresponds to “BypS” in 
the channel displays. This lists the channels of the plug-in on 
the Channel Fader encoders. You can then bypass a stream by 
pressing its encoder B/M/P switch. The B/M/P switch lights to 
indicate the bypassed stream.

To exit Expanded Plug-In mode:

Press the flashing Plug-In switch.

Custom Fader Flip Mode
When in any of the Custom Fader modes, you can flip Custom 
Fader encoder rows to the faders with Custom Fader Flip 
mode. The single Custom Fader Flip switch is used to cycle the 
encoder rows through the faders. The Custom Fader Flip 
switch only affects Custom Fader channels, and has no effect 
on channels in Normal mode.

In Custom Fader Flip mode, the Custom Fader Flip switch is 
lit, and the affected encoder displays appear in yellow.

To enter Custom Fader Flip mode:

1  From any of the Custom Fader modes, press the Custom 
Fader Flip switch. The top row of encoders transfers to the fad-
ers.

2  To flip successive rows, repeatedly press the Custom Fader 
switch.



To exit Custom Fader Flip mode:

Press the Custom Fader Flip switch repeatedly until you exit 
Flip mode. 

– or –

Hold Control (Windows) or Command (Macintosh) and 
press the Custom Fader Flip switch.

Custom Fader Map Modes
When in Custom Groups, Mix/Edit Groups, or Plug-In mode, 
you can map individual encoder controls to faders on a 
track-by-track basis with Custom Fader Map modes.

This mapping feature works differently depending on which 
of the main Custom Fader modes you are in. (Mapping is not 
available in Master Faders mode.)

Custom Groups and Mix/Edit Groups Map Modes

When in Custom Groups or Mix/Edit Groups mode, you can 
map any encoder parameter to the fader on the same Custom 
Fader channel. In these Map modes, the rotary encoder con-
trol swaps with the channel fader, and the encoder By-
pass/Mute/Pre switch swaps with the channel Mute switch.

Mapping while in these modes is vertically restricted to encod-
ers and faders in the same channel strip.

How Custom Group and Mix/Edit Group Mapping is Stored

Custom Group and Mix/Edit Group mapping is saved in the 
Pro Tools session file, and moves with the session to any other 
system that supports D-Control operation. 

To map an encoder to a fader (Custom Groups mode or Mix/Edit 
Groups mode):

1  While in Custom Groups mode or Mix/Edit Groups mode, 
press and hold the Map switch in the Custom Faders section 
until the switch flashes.

2  In the Custom Fader channels, touch any rotary encoders 
that you want to map to their corresponding channel fader. 

3  Do one of the following: 

• Press the flashing Map switch to confirm the mapping.

– or –

• Press the Escape switch to cancel the mapping and leave 
Map edit mode. 

The Map switch lights solid to indicate that the mapping is ac-
tive.
To bypass mapping (Custom Groups mode or Mix/Edit Groups 
mode):

Press the lit Map switch. Even when it is not displayed, map-
ping is remembered for each Custom Group or Mix/Edit 
Group.

To recall mapping (Custom Groups mode or Mix/Edit Groups 
mode): 

1  Recall the Custom Group or Mix Edit Group by pressing the 
corresponding switch in the Custom Faders section. 

2  Press the Map switch. 

Custom Fader Plug-in Map Mode

Custom Fader Plug-In Map Mode lets you map controls from en-
coders to faders on the D-Control surface. This is different 
from the Plug-In Mapping feature of Pro Tools, which lets you 
map on-screen plug-in controls to encoders on the surface. For 
more information on Plug-In Mapping features, see “Plug-in 
Mapping” on page 75. 

When in Custom Fader Plug-in mode, you can map any 
plug-in parameter on an encoder to any of the faders in the 
Custom Fader channels, including faders on different chan-
nels. In Plug-In Map mode, a mapped rotary control is dupli-
cated on the fader, and a mapped switch is duplicated on the 
channel Mute switch. (Because Plug-In mode does not use the 
faders, no swapping takes place.)

Mapping while in this mode has no restriction on the vertical 
relationship between encoders and faders.

How Plug-In Mapping is Stored

When you map a plug-in, all other instances of that plug-in 
in the session will use the same mapping. 

Plug-in mapping is saved as a preference file with a .pim ex-
tension. 

Plug-In mapping for the last opened session is remembered 
by the Pro Tools system (saved in the Pro Tools application 
preferences file), so when you create a new session on the sys-
tem, all instances of the same plug-in will use the stored map-
ping. 

Plug-in mapping files (.pim) files can be imported and ex-
ported for use with other D-Control and D-Command con-
soles. 
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To map an encoder to a fader (Plug-In mode):

1  While in Plug-In mode, press the Map switch in the Custom 
Faders section.

2  In the Custom Fader channels, press the channel Select 
switch on the channel where you want to map the encoder. 
The Select switch flashes to indicate Map mode. 

3  Do one of the following:

• In the Custom Fader channels, touch any rotary encoder 
that you want to map to the selected channel’s fader.

– or –

• In the Custom Fader channels, press any switch that you 
want to map to the selected channel’s Mute switch. 

The mapped control appears on the selected channel’s fader. 
Plug-In parameter mapping is remembered for that plug-in, 
and is usable on any channel where it occurs. 

To bypass mapping (Custom Fader Plug-In mode):

Press the lit Map switch. Even when it is not displayed, map-
ping is remembered for each plug-in. 

To recall mapping (Custom Fader Plug-In mode): 

1  Focus the plug-in in the Focus Channel Strip.

2  Recall the plug-in by pressing the Plug-In switch in the Cus-
tom Faders section. 

3  Press the Map switch.

To clear mapping (Custom Fader Plug-In mode): 

1  In Custom Faders Plug-In Map mode, display the plug-in 
whose map you want to clear. 

2  Press the Set to Default switch. 

3  Press the Do To All switch.

4  Press the Select switch on any of the Custom Fader channel 
strips. 
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Exporting and Importing .pim Files

To export plug-in mapping:

1  Press the Operation switch repeatedly to display the page 
that includes Export Plug-In Maps (“Export PIMaps”).

2  Press the Soft Key that corresponds to “Export PIMaps.”

3  Enter a name for the Plug-In Map (.pim) file, choose a loca-
tion, and click Save.

4  Hold Control (Windows) or Command (Macintosh) and 
press the Operation switch to exit.

To import plug-in mapping:

1  Press the Operation switch repeatedly to display the page 
that includes Import Plug-In Maps (“Import PIMaps”).

2  Press the Soft Key that corresponds to “Import PIMaps.”

3  Locate the Plug-In Map (.pim) file you want to use and click 
Import.

4  Hold Control (Windows) or Command (Macintosh) and 
press the Operation switch to exit.



Appendix A: Utility Mode
D-Control Utility mode lets you view system information, run 
diagnostic tests, set hardware preferences, and reset system 
settings.

Entering Utility Mode
You can enter Utility mode at any time to change D-Control 
settings. Utility mode can be accessed from the D-Control 
Main Unit and also on individual D-Control Fader Modules. 

Entering Utility Mode from a Main Unit

When putting a D-Control Main Unit into Utility mode, the 
behavior of connected Fader Modules depends on whether or 
not the units are online. 

A D-Control unit is online if Pro Tools is running and the unit 
is declared in the Peripherals page of the Setups dialog. A unit 
is offline when Pro Tools is not running, or if it is not declared 
on a system that is running Pro Tools. 

To enter Utility mode from the Main Unit:

Press the Utility switch in the Session Management section. 
The Utility switch and the Soft Keys flash to indicate Utility 
mode is active.

• If the Main Unit is online, any Fader Modules declared 
on the same Pro Tools system also enter Utility mode. 

• If the Main Unit is offline, all offline Fader Modules on 
the same Ethernet network enter Utility mode.

Entering Utility Mode on a Fader Module

You can put individual Fader Modules into Utility mode to 
test them independently of other D-Control units. 

To put an individual Fader Module into Utility mode:

1  If Pro Tools is running, do one of the following:

• Quit Pro Tools.

– or –

• Choose Setups > Peripherals, click Ethernet Controllers, 
and make sure the Fader Module is not declared.
2  Press and hold the Modifier Keys in the lower left of the 
Fader Module in the following sequence: Shift + Alt/Com-
mand + Win/Option. The encoder Select switches in the bot-
tom row flash to indicate Utility mode is active. 

Navigating Utility Mode
When the unit is in Utility mode, the Utility Setup Page is dis-
played on the Soft Key displays (Main Unit) or on the bottom 
row of encoders (Fader Module). 

The Utility Setup page has five top level options:

• System: System Info Page

• Name: Name Setup Page

• Test: Test Setup Page

• Reset: Reset D-Control to Defaults

• Pref: Preference Setup Page

To access an option on the Utility Setup Page:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to the option.

To move back up to the Utility Setup Page:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to “Escape.”

Fader Module Modifier Key sequence for Utility mode

1

3

2
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Exiting Utility Mode

To exit Utility mode, do one of the following:

Press the flashing Utility switch (Main Unit).

– or –

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

D-Control System Info Page
The System Info page provides access to the system firmware 
version and Ethernet information. 

To display the System Info page:

From the Utility Setup page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “System.”

To exit the System Info page:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

Firmware Version

In the System Info page, hold the Soft Key (Main Unit) or en-
coder Select switch (Fader Module) that corresponds to “FW 
ver.” This shows the Comm board and Motor Control board 
firmware versions. 

Ethernet Info

In the System Info page, hold the Soft Key (Main Unit) or en-
coder Select switch (Fader Module) that corresponds to 
“Ethrnt” to display the following information:

Unit Name (as named on the Name Page)

ID: Ethernet address (Machine Address Code) for the unit

Num: The Digidesign serial number for the unit

Type: The Ethernet packet type used by Digidesign for con-
trol surface communication
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D-Control Name Page
The Name page is used to view and change D-Control unit 
names. These names appear in the Pro Tools Peripherals dia-
log, and must be unique so as to identify each D-Control unit 
correctly. This is especially important if your system is on an 
Ethernet network with multiple controllers connected to it. 

To display the Name page for a D-Control unit:

1  Put the unit you want to name into Utility mode. Fader 
Modules must be put into Utility mode independently. (See 
“Entering Utility Mode on a Fader Module” on page 157.)

2  From the Utility Setup page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Name.”

The Main Unit name appears in the Soft Keys section. The 
Fader Module name appears in its encoder displays. The first 
character of the name flashes to indicate text entry.

To change the unit name: 

1  Turn the Scrub/Shuttle wheel (Main Unit) or any encoder 
knob (Fader Module) to change the selected text. 

2  To move forward and backward through the name field, 
press the flashing Soft Keys (Main Unit) or encoder Select 
switches (Fader Module) that correspond to the “<” and “>” 
symbols. 

3  When you are finished entering text, do one of the follow-
ing:

• Confirm the new name by pressing the Soft Key (Main 
Unit) or the encoder Select switch (Fader Module) that 
corresponds to “OK.”

• Clear the name field by pressing the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corre-
sponds to “Clear.”

• Cancel the new name by pressing the Soft Key (Main 
Unit) or the encoder Select switch (Fader Module) that 
corresponds to “Cancel.”



D-Control Test Pages
The Test pages let you test various mechanical and electronic 
components of the unit. 

To display the Test Setup page:

From the Utility Setup page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Test.” 

The Test Setup page has five top level test modes:

• Ethernet: Ethernet Test Page

• LED: Switch and LED Test Pages

• Display: Display Test Page

• Fader: Fader Test Page

• Rotary: Rotary Encoder Test Page

To enter a test mode on the Test Setup page:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to the test mode name.

To exit the Test Setup page:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

Ethernet Test Page

There are three test levels for Ethernet communication on 
D-Control: Internal, Mendec, and External. These tests can as-
sist Digidesign Technical Support should you ever experience 
difficulty with Ethernet communication between D-Control 
and Pro Tools. 

Each test sends data packets through that unit’s Ethernet sys-
tem. The Transmit (Xmit) and Receive (Recv) values for each 
test show the number of packets sent and received in the test, 
and the “Error” and “Retry” fields show percentage error in 
the transmission and receiving process. An error rate of 1 per-
cent or less generally indicates acceptable performance. (In 
normal operation, errors are retried and no data loss occurs.)

To display the Ethernet Test page:

1  Put the unit you want to test into Utility mode. Fader Mod-
ules must be put into Utility mode independently. (See “Enter-
ing Utility Mode on a Fader Module” on page 157.)

2  From the Test Setup page, press the Soft Key (Main Unit) or 
encoder Select switch (Fader Module) that corresponds to 
“Ethrnt.”

To exit the Ethernet Test page:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 
Internal

The Internal test verifies the first stage of Ethernet communi-
cation by sending data packets through the unit’s Ethernet 
link chip.

To perform the Internal Ethernet test:

1  From the Ethernet Test page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Clear” to clear any values in the unit’s test data page. 

2  Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to “Intrnl.”

To exit the Internal Ethernet test:

Press the flashing Soft Key (Main Unit) or encoder Select 
switch (Fader Module). 

Mendec

The Mendec (Manchester Encoder/Decoder) test verifies the 
second stage of Ethernet communication by sending data 
packets through the unit’s Ethernet encoder and decoder. 

To perform the Mendec Ethernet test:

1  From the Ethernet Test page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Clear” to clear any values in the unit’s test data page. 

2  Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to “Mendec.”

To exit the Mendec Ethernet test:

Press the flashing Soft Key (Main Unit) or encoder Select 
switch (Fader Module). 

External

The External test verifies the third stage of Ethernet commu-
nication by sending data packets out of the unit’s external 
Ethernet port and back into the unit using the Ethernet loop-
back connector (provided with the D-Control Main Unit).

To perform the External Ethernet test:

1  If Pro Tools is running, quit Pro Tools. 

2  Disconnect the unit from the Ethernet network.

3  Plug the Ethernet Loopback connector into the unit’s Ether-
net port. 

4  From the Ethernet Test page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Clear” to clear any values in the unit’s test data page. 

5  Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to “Extrnl.”
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To exit the External Ethernet test:

Press the flashing Soft Key (Main Unit) or encoder Select 
switch (Fader Module). 

Switch and LED Test Page

The Switch and LED Test page has five modes:

• Switch: Switch Test Mode

• Red: Red LED Test Mode

• Yellow: Yellow LED Test Mode

• Green: Green LED Test Mode

• Vegas: Vegas Mode

To display the Switch and LED Test page:

From the Test Setup page, press the Soft Key (Main Unit) or 
encoder Select switch (Fader Module) that corresponds to 
“LED.”

To exit the Switch and LED Test page:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

To enter any of the Switch and LED Test modes:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to the mode name. 

Switch Test Mode

Switch Test mode lets you test each switch on the unit indi-
vidually.

To test any switch:

Press the switch you want to test.

The switch LED lights as long as it is held and the Soft Key dis-
play (Main Unit) or encoder displays (Fader Module) show the 
location information for the switch.

To exit Switch Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

LED Test Modes (Red, Yellow, Green)

The LED Test modes lets you test all red, yellow, and green 
LEDs on the unit individually. 

To test LEDs:

Press the Soft Key that corresponds to “Red,” “Yellow,” or 
“Green” to test all LEDs of the corresponding color.
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To exit LED Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

Vegas Mode

Vegas mode randomly lights every switch, meter, and display 
on the unit, and runs the faders in sine wave mode.

To enter Vegas mode:

Press the Soft Key that corresponds to “Vegas.”

To exit Vegas mode:

Press any switch on the unit. 

Display Test Page

The Display Test page has three modes:

• Text: Display Test

• Time Code: Time Code Display Test

• Meter: Meter Bridge LED Test

To display the Display Test page:

From the Test Setup page, press the Soft Key (Main Unit) or 
encoder Select switch (Fader Module) that corresponds to 
“Disply.”

To exit the Display Test page:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

To enter any of the Display Test modes:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to the mode name. 

Text (Display) Test

The Text test mode cycles through a series of display tests that 
check all displays on the control surface.

To exit Text Test mode:

Press any flashing Soft Key (Main Unit) or encoder Select 
switch (Fader Module).

Meter Bridge LED Test

The Meter Bridge LED test cycles through a series of auto-
mated tests that check all LEDs on each meter.

To exit Meter Bridge LED Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 



Time Code Display Test

(Main Unit Only)

The Time Code Display test cycles through a series of auto-
mated tests that check all LED segments on the Main Unit 
Time Code display.

To exit Time Code Display Test mode:

Press the Soft Key that corresponds to “Escape.” 

Fader Test Page

The Fader Test page provides four test modes and a calibration 
mode:

• Step: Fader Step Test Mode

• Cycle: Fader Cycle Test Mode

• Group: Fader Group Test Mode

• Touch: Fader Touch Test Mode

• Recal: Recalibrates Faders

To display the Fader Test page:

From the Test Setup page, press the Soft Key (Main Unit) or 
encoder Select switch (Fader Module) that corresponds to 
“Fader.”

To exit the Fader Test page:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

To enter any of the Fader Test modes:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to the test name.

Step Test Mode

In Step Test mode, faders jump together, in stepped fashion, to 
positions that are adjustable with the Scrub/Shuttle wheel 
(Main Unit) or any encoder knob (Fader Module). 

To exit Step Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 
Cycle Test Mode

In Cycle Test mode, faders move together, from the bottom to 
top, in a continuous cycle, at a speed that is adjustable with 
the Scrub/Shuttle wheel (Main Unit) or any encoder knob 
(Fader Module). 

Fader position values are shown in the channel displays and 
are updated in real time as the faders move. 

To exit Cycle Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

Group Test Mode

In Group Test mode, faders can be moved to test group re-
sponse.

This mode displays which faders are currently being touched 
by showing the letter “T” in their channel displays.

To exit Group Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

Touch Test Mode

The Touch Test page lets you test the touch sensitivity of each 
fader. The channel displays show when a fader is touched and 
what frequency the fader is currently recognizing. The fader 
frequency value is updated in real time. 

This mode displays which faders are currently being touched 
by showing the letter “T” in their channel displays.

To exit Touch Test mode:

Press the Soft Key (Main Unit) or encoder Select switch 
(Fader Module) that corresponds to “Escape.” 

Recal

The Recal command recalibrates D-Control fader touch sensi-
tivity and position to factory specifications. 

In addition, under conditions of heavy use, the D-Control 
fader motor protection feature may disengage a fader if it is in 
danger of overheating. The Recal command reengages any dis-
engaged faders. 

To recalibrate the faders:

From the Fader Test page, press the Soft Key (Main Unit) or 
the encoder Select switch (Fader Module) that corresponds to 
“Recal.”
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Rotary Test Page

The Rotary Test page lets you test the touch-sensitive encoder 
knob and the LED ring in each rotary encoder, as well as the 
Scrub/Shuttle wheel on the Main Unit. 

To enter Rotary Test mode:

From the Test Setup page, press the Soft Key (Main Unit) or 
encoder Select switch (Fader Module) that corresponds to 
“Rotary.”

To exit Rotary Test mode:

Press the Soft Key next to “Escape” (Main Unit) or the flash-
ing encoder Select switch. 

To test the rotary encoders:

Touch any encoder knob. When the encoder knob is 
touched, the encoder’s display turns red and the “Auto” indi-
cator LED below the knob lights. 

Turn any encoder knob. When the encoder knob is turned, 
each LED in the LED ring lights in order.

To test the Scrub/Shuttle wheel:

Turn the Scrub/Shuttle wheel. The numerical value in the 
lower left display of the Soft Key section value changes de-
pending on which way you turn the wheel. 

Resetting D-Control to Factory 
Defaults
The Reset (Factory Default) page lets you reset the D-Control 
Main Unit and Fader Modules to their factory default settings.

To reset D-Control:

1  From the Utility Setup Page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Reset.”

2  Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to “OK.”

3  Do one of the following:

• Confirm your choice by pressing OK again. 

– or –

• Cancel the reset operation by pressing the Soft Key (Main 
Unit) or the encoder Select switch (Fader Module) that 
corresponds to “Cancel.”
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D-Control Preferences
D-Control Preferences let you set various display and opera-
tion preferences for the unit. 

To display the Preferences page:

From the Utility Setup Page, press the Soft Key (Main Unit) 
or the encoder Select switch (Fader Module) that corresponds 
to “Prefs.”

The D-Control Preferences page has five preferences:

• Bright: Display Brightness

• Contrast: Display Contrast

• Foot 1: Footswitch 1 Settings

• Foot 2: Footswitch 2 Settings

• Sleep: Sleep Mode Settings

To access a preference on the Preferences page:

Press the Soft Key (Main Unit) or the encoder Select switch 
(Fader Module) that corresponds to the preference name.

Display Brightness Page

The Display Brightness page lets you adjust the brightness of 
the display LEDs.

To set the display brightness:

1  From the Preferences page, press the Soft Key (Main Unit) or 
the encoder Select switch (Fader Module) that corresponds to 
“Bright.”

2  Turn the Scrub/Shuttle wheel (Main Unit) or any encoder 
knob (Fader Module) to change the brightness value. Bright-
ness values range from 0–127. 

3  Do one of the following:

• Confirm the new brightness value by pressing the Soft 
Key (Main Unit) or the encoder Select switch (Fader Mod-
ule) that corresponds to “OK.”

– or –

• Cancel the new brightness value by pressing the Soft Key 
(Main Unit) or the encoder Select switch (Fader Module) 
that corresponds to “Cancel.”



Display Contrast Page

The Display Contrast page lets you adjust the level of back-
lighting in the display LEDs. 

To set the display contrast:

1  From the Preferences page, press the Soft Key (Main Unit) or 
the encoder Select switch (Fader Module) that corresponds to 
“Contrast.”

2  To adjust the overall contrast for all displays, press the Soft 
Keys (Main Unit) or the encoder Select switches (Fader Mod-
ule) that correspond to “>>” or “<<” to increase or decrease the 
contrast value. Overall contrast values range from 0–9. 

3  To adjust the relative contrast for individual rows of dis-
plays, turn the Flip encoder knobs (Main Unit) or any encoder 
knobs in a given row (Fader Module). Individual contrast val-
ues are shown as “Step” numbers ranging from 0–62. 

4  To cycle the displays through inverted text display, repeat-
edly press the Soft Key (Main Unit) or the encoder Select 
switch (Fader Module) that corresponds to “Invert.”

5  Do one of the following:

• Confirm the new contrast values by pressing the Soft Key 
(Main Unit) or the encoder Select switch (Fader Module) 
that corresponds to “OK.”

• Reset the contrast values to their defaults by pressing the 
Soft Key (Main Unit) or the encoder Select switch (Fader 
Module) that corresponds to “Reset.”

• Cancel the new contrast values by pressing the Soft Key 
(Main Unit) or the encoder Select switch (Fader Module) 
that corresponds to “Cancel.”
Footswitch 1 and 2 Settings Pages
(Main Unit Only)

The Footswitch Settings pages for Footswitch 1 and Foot-
switch 2 let you set the function for each. For each setting, 
pressing the footswitch is the functional equivalent of press-
ing the corresponding switch on the D-Control Main Unit.

Each Footswitch Settings page has four options:

• Flip + / Flip – : Changes the polarity of the footswitch 
connection to positive (+) or negative (–). 

• Play: Simulates pressing the Play switch on the transport

• Record: Simulates pressing the Record switch on the 
transport

• Talkback: Simulates pressing the Talkback switch on the 
D-Control Main Unit

To set the function of the footswitches:

1  From the Preferences page, press the Soft Key that corre-
sponds to “Foot 1” or “Foot 2.”

2  Press the Soft Key that corresponds to the function you want 
to assign to the footswitch. The Soft Key for the selected func-
tion lights continuously. 

Press the Soft Key that corresponds to “Escape.” 

Sleep Mode Settings Page

Sleep mode saves power by dimming the LEDs on the D-Con-
trol unit. The Sleep Mode Settings page lets you set the 
amount of idle time before the LEDs on the unit dim automat-
ically. 

To set the time before the D-Control unit sleeps:

1  From the Preferences page, press the Soft Key (Main Unit) or 
the encoder Select switch (Fader Module) that corresponds to 
“Sleep.”

2  Turn the Scrub/Shuttle wheel (Main Unit) or any encoder 
knob (Fader Module) to change the time before the unit goes 
to sleep. Times range in 1-minute increments from 1 to 59 
minutes, then in 1-hour increments from 1 to 12 hours, to Off 
(the unit never goes to sleep). 
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Appendix B: Audio Connections and Pinouts

All external D-Control audio connections are made to the back panel of the XMON interface, shown below. All audio connectors 
are standard female DB-25 connectors. The connector for communication with D-Control is a 15-pin female connector. 
XMON back panel connectors

Cue Inputs

Cue Outputs

Main Inputs Surround Inputs Stereo Inputs

Main Outputs Alt Outputs Talkback/Listenback/Utility D-Control connector
25-Pin Female Connector Pinouts
All XMON DB-25 connector pinouts conform to the pin num-
bering scheme shown below. 

Cue Inputs

DB-25 Connector (user view)

Cue Inputs

Signal Name Hot (+) Cold (–) Ground (shield)

Cue Input 1 (Left) 24 12 25

Cue Input 1 (Right) 10 23 11

Cue Input 2 (Left) 21 9 22

Cue Input 2 (Right) 7 20 8

Cue Input 3 (Left) 18 6 19

Cue Input 3 (Right) 4 17 5

[Not Connected] 15 3 16

[Not Connected] 1 14 2

GND 13

SHIELD GND connector housing

113

1425
Main Inputs

Known Issue with XMON REV A, B, C, and D With XMON REV 
A–D, if you have any need to mix signals from Cue Outputs 1, 
2, or 3 with other signals from Pro Tools or the XMON, swap 
the Hot (+) and Cold (–) connections for either the Cue Inputs 
or the Cue Outputs. 

Known Issue with XMON REV E With XMON REV E, if you 
have any need to mix signals from Cue Outputs 1, 2, or 3 with 
other signals from Pro Tools or the XMON, swap the Hot (+) 
and Cold (–) connections for both the Cue Inputs and the Cue 
Outputs. 

Main Inputs

Signal Name Hot (+) Cold (–) Ground (shield)

Main Input 1 (L) 24 12 25

Main Input 2 (Lc) 10 23 11

Main Input 3 (C) 21 9 22

Main Input 4 (Rc) 7 20 8

Main Input 5 (R) 18 6 19

Main Input 6 (Ls) 4 17 5

Main Input 7 (Rs) 15 3 16

Main Input 8 (LFE) 1 14 2

GND 13

SHIELD GND connector housing
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Surround Inputs

Stereo Inputs

Surround Inputs

Signal Name Hot (+) Cold (–) Ground (shield)

Surround Input 1 (L) 24 12 25

Surround Input 2 (Lc) 10 23 11

Surround Input 3 (C) 21 9 22

Surround Input 4 (Rc) 7 20 8

Surround Input 5 (R) 18 6 19

Surround Input 6 (Ls) 4 17 5

Surround Input 7 (Rs) 15 3 16

Surround Input 8 (LFE) 1 14 2

GND 13

SHIELD GND connector housing

Stereo Inputs

Signal Name Hot (+) Cold (–) Ground (shield)

Stereo Input 1 (Left) 24 12 25

Stereo Input 1 (Right) 10 23 11

Stereo Input 2 (Left) 21 9 22

Stereo Input 2 (Right) 7 20 8

Stereo Input 3 (Left) 18 6 19

Stereo Input 3 (Right) 4 17 5

Stereo Input 4 (Left) 15 3 16

Stereo Input 4 (Right) 1 14 2

GND 13

SHIELD GND connector housing
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Cue Outputs

Main Speaker Outputs

Cue Outputs

Signal Name Hot (+) Cold (–) Ground (shield)

SLS Output (Left) 24 12 25

SLS Output (Right) 10 23 11

Cue Output 1 (Left) 21 9 22

Cue Output 1 (Right) 7 20 8

Cue Output 2 (Left) 18 6 19

Cue Output 2 (Right) 4 17 5

Cue Output 3 (Left) 15 3 16

Cue Output 3 (Right) 1 14 2

GND 13

SHIELD GND connector housing

Main Speaker Outputs

Signal Name Hot (+) Cold (–) Ground (shield)

Main 1 (L) 24 12 25

Main 2 (Lc) 10 23 11

Main 3 (C) 21 9 22

Main 4 (Rc) 7 20 8

Main 5 (R) 18 6 19

Main 6 (Ls) 4 17 5

Main 7 (Rs) 15 3 16

Main 8 (LFE) 1 14 2

GND 13

SHIELD GND connector housing



Alt Speaker Outputs

Talkback/Listenback Pinouts

Alt Speaker Outputs

Signal Name Hot (+) Cold (–) Ground (shield)

Alt 1 (L) 24 12 25

Alt 2 (Lc) 10 23 11

Alt 3 (C) 21 9 22

Alt 4 (Rc) 7 20 8

Alt 5 (R) 18 6 19

Alt 6 (Ls) 4 17 5

Alt 7 (Rs) 15 3 16

Alt 8 (LFE) 1 14 2

GND 13

SHIELD GND connector housing

Talkback/Listenback

Signal Name Hot (+) Cold (–) Ground (shield)

Ext Talkback Mic 
Input

24 12 25

Listen Mic 1 Input 10 23 11

Listen Mic 2 Input 21 9 22

AFL Input 1 20 7 8

AFL Input 2 6 18 19

Mini Speaker Out (L) 4 17 5

Mini Speaker Out (R) 15 3 16

Talkback/Slate Out 1 14 2

GND 13

SHIELD GND connector housing
15-Pin Connector Pinouts
The XMON 15-pin connector pinouts conform to the pin 
numbering scheme shown below. 

XMON to D-Control Connector Pinouts

15-pin connector (user view)

XMON to D-Control Pinouts

Signal Name Hot (+) Cold (–) Ground (shield)

RS422 Input 1 9

RS422 Output 2 10

(NC) 12 4

(NC) 11 3

Headphones L 5 13

Headphones R 6 14

Internal Talkback Mic 15 8

GND 7

SHIELD GND connector housing

18

915
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Index
Numerics
9-Pin Remote switch 94

A
Actions switch (automation) 109
After-Fader Listen (Monitor section) 120
All Notes Off switch 102
All switch (automation) 62
Alt outputs (Monitor section) 117
Arrow switches 97
Assign controls 59, 127, 128

Inputs 59
Inserts 60
Outputs 60
plug-ins 61
Sends 60

Assign Matrix 139
I/O 146
inserts 142
Lock Enable preference 140
preferences 139
sends 144

Assign Talkback switch 122
Attack control (Dynamics plug-ins) 79
Audio Files switch 111
Audition Mode switch 95
Audition switches 95

Audition Mode 95
Mark In 95
Mark Out 95
Post-Roll 95
Pre-Roll 95

Auto Insert/Punch switch 96
Auto Join switch 109
Auto Talkback switch 123
AutoMatch indicators 56
AutoMatch switch 109
AutoMatching automation 137
automation

AutoMatching 137
capturing 136
enabling for plug-ins 74, 154
encoder mode indicator 50
plug-ins 59, 83, 89
punching 137
snapshots 136

Automation controls 109
Action 109
Auto Join 109
AutoMatch 109
Join 109
Modes 110
Prefs 110

Automation Enable controls 62
Inserts 62
Mute 62
Pan 62
Send Mute 62
Send Pan 62
Send Volume 62
Volume 62
Automation Mode controls 8, 69
Latch 69
Off 69
Read 69
Touch 69
Trim 69
Write 69

Automation Mode indicators 56
Automation Mode switches 55
Automation Safe mode 59, 132, 154
Automation Safe switch (plug-ins) 83
Automation Suspend switch 67
Automation switch (plug-ins) 83, 89
Automation Trim switch 55
Automation Write controls

Write to All 62
Write to End 63
Write to Next 63
Write to Punch 63
Write to Start 63

Automation Write To switches 62
All 62
End 63
Next 63
Punch 63
Start 63

Auxiliary Input tracks 135

B
B/M/P (see Bypass/Mute/Pre)
Back and Play switch 96
Back switch 95
Bank Justification preference 40
Bank Select matrix 98
Bank Select switch 106
Bank Select switches 8
bank size (Custom Faders) 150
Bank/Cycle switch

and Custom Fader mode 68
Bank/Nudge switches 8, 98
banking (tracks) 8
Broadcast mode (Monitor section) 120
Bypass switch (plug-ins) 83, 90
Bypass/Mute/Pre switches (rotary encoders) 51, 132

Show Values 61
Switch Info 61
switch mode 61

Bypass/Spill switches (channel strips) 53

C
calibration

faders 45
meters 45
output level indication 45

Calibration Mode switch 118
capturing automation 136
channel display modes 55
Channel Select switches

for channel strips 54
for Monitor section 119
for plug-ins 81, 88
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Channel Strip Function controls 54
Automation Mode 55
Automation Trim 55
Channel Select 54
display modes 55
Input Monitor Mode 54
Mute 55
Record Enable 54
Record Safe mode 54
Solo 55

Channel Strip Master Function controls 66
Automation Suspend 67
Display Mode 67
Escape 66
Mute Clear 67
Select/Focus 67
Solo Clear 67

Channel Strip Master section 8
Channel Strip Mode controls 52, 54

Bypass/Spill 53
Dynamics 52
EQ 52
Global Input 66
Input 52
Inserts 52
Mic Pre 52
Pan 53
Sends 53

channel strips 49
Channel Select switch 54
fader section 56
Focus Channel Strip 8, 49
master section 57

channels
focusing 54, 93, 131
Inline Console mode 135
PRE controls 135
selecting 54

Clear Clip switch 102
clipping indication 54, 102, 124, 125
Compare switch (plug-ins) 83, 89
connections

audio 35, 165
alt 167
control room 36
cue system 37, 165, 166
headphone 37
main 165, 166
solo outputs 167
stereo inputs 166
surround inputs 166
talkback/listenback 167

Ethernet 9, 10, 33, 34, 39
footswitch 9, 34
power 33
USB 9, 34
XMON 9, 12, 35, 167

Console Preferences
Meter 107
Operation 107
User 106

Control Room Monitor system 116
Dim Level control 117
Input controls 116
Input Level Trim controls 116
Input Source Sum controls 116
Monitor Output Mode controls 118
Output Channel Select switches 119
Output controls 117
Output Level Trim controls 117

Custom Fader Bank Justification preference 42
Custom Fader Flip mode 68, 154
Custom Fader Hidden Tracks preference 43
Custom Fader Map modes 68, 155

and Custom Fader Plug-in mode 155
and Custom Groups mode 155
and Mix/Edit Groups mode 155

Custom Fader Mode indicators 56
Custom Fader modes 67, 149

Custom Groups 67, 150
Expanded Plug-in view 154
Mix/Edit Groups 67, 151
Plug-in 68, 153
Tracks 68, 153
D-Control Guide70
Custom Faders 8
bank size 150
banks 149
display 67
displaying plug-ins 68
locking plug-ins 68
plug-in view definitions 43, 153
preferences 42

Custom Groups mode (Custom Fader) 67, 150
Cycle switch (plug-ins) 83, 90

D
D-Control Units

declaring 39
naming 40

Dim function 121, 123
Dim Level control 117
Display Brightness 162
Display Contrast 163
Display Mode switch 67
Display preferences 44
Do To All switches 64, 65
Do To Selected switches 64, 65
Dual Transport mode 99
Dynamics (plug-ins) 8, 71, 78

gain reduction display 77, 84
Dynamics plug-in controls

Attack 79
External Key 82
Filter Frequency 80
Filter In 80
Filter Q/Slope 80
Gain 80
Hold 80
Hysteresis 79
Key Listen 82
Knee 79
Notch/Shelf 80
Range 79
Ratio 79
Release 79
Threshold 80

Dynamics switches (channel strips) 52

E
Edit Controls

Edit Functions 105
Edit controls 105

Edit Functions 105
Edit Modes 105
Edit Tools 105

Edit Function switches 105, 113
Edit Mode switches 112
Edit window

navigation 8, 97
Edit/Timeline switch 112
Enable Parameters switch 59
Encoder Order preference 41
Encoder Select switches 50
End (Start/End/Length) switch 112
End switch (automation) 63
EQ (plug-ins) 8, 71, 85
EQ Band Pass controls (plug-ins) 87
EQ plug-in controls

Band Pass 87
High Shelf/Peak 86
High-Pass 86
Low Shelf/Peak 86
Low-Pass 86

EQ switches (channel strips) 52
Escape switch 66
Ethernet 9, 10, 33, 34, 39
expansion options 4
Explode switch 113
External Key switch (Dynamics plug-ins) 82
External Machines switches 96

Auto Insert/Punch 96
Insert/Assemble 96
Machine Insert 96
Track Arm from Channel Strips 96
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back panel overview 10
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Utility mode 157

faders 56
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Faders On/Off preference 40
Filter Frequency controls (Dynamics plug-ins) 80
Filter In switches (Dynamics plug-ins) 80
Filter Q /Slope controls (Dynamics plug-ins) 80
Flip mode 57, 133, 134
Flip switch (Custom Fader mode) 68
Flip switches 57
Flop mode 58, 133
Focus Channel Strip 8, 49
Focus mode (Channel Select switch) 54
focusing

channels 54, 93, 113, 131
plug-ins 72, 132

footswitch 9, 34
Footswitch settings 163
Forward and Play 96

G
Gain controls (plug-ins) 84, 90
Gain/Hold control (Dynamics plug-ins) 80
Global Channel Strip Mode controls 66
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EQ 66
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Mic Pre 66
Page 66
Pan 66
Sends 66

Global controls 64
Do To All 64
Do To Selected 64
Set To Default 65
Suspend Groups 65

Global Input switch 66
Go To End switch 95
Go To Start switch 95
Go To switch 113
Group Status indicators 56
Group switch 103
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creating 152
deleting 152
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H
Headphone/Cue system 121

Input controls 122
Output controls 121

High Shelf/Peak controls (EQ plug-ins) 86
High-Pass controls (EQ plug-ins) 86

I
I/O Assign Matrix 146
I/O paths

assigning 147
displaying 129, 130

Inline Console mode 135
Input controls (Monitor section) 116
Input Level Trim controls (Monitor section) 116
Input Monitor Mode switches 54
Input Source Sum controls (Monitor section) 116
Input switches 52
inputs
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main 116
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stereo 116
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surround 116
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Insert Assign Matrix 142
Insert/Assemble switch 96
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assigning 127, 128, 134, 143
making inactive 130

Inserts switch (automation) 62
Inserts switches 52
Instant Playback switch 96
Instrument tracks 49, 50, 51, 57, 61

J
Join switch 109

K
Key Listen switch (Dynamics plug-ins) 82
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keyboard modifiers 56
Knee/Hysteresis control (Dynamics plug-ins) 79

L
Latch switch (automation) 69
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Length (Start/End/Length) switch 112
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inputs (Monitor section) 116
output channels (Monitor section) 119
outputs (Monitor section) 117
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Link Edit and Timeline switch 112
Listen system 123

Mic Level control 123
Mic Select switches 123
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connections 167
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Back 95
Back and Play 96
Forward and Play 96
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Go To Start 95
Instant Playback 96

location display 124
Lock Enable preference (Assign Matrix) 140
Lock switch (Custom Fader Plug-In mode) 68
Lock switch (plug-ins) 83, 89
Loop Playback switch 94
Low Shelf/Peak controls (EQ plug-ins) 86
Low-Pass controls (EQ plug-ins) 86

M
Machine Insert switch 96
Machine Online switches 96, 100
MachineControl

and transport controls 91
Main and Sub Counter switches 112
Main inputs (Monitor section) 116
Main outputs (Monitor section) 117
Main Unit

back panel overview 9
components 3
top panel overview 7
Utility mode 157

Make Inactive controls 58, 130
Inputs 58
Inserts 58
Outputs 58
Sends 58

Management controls 103
Map switch (Custom Fader mode) 68
mapping

Custom Fader Map modes 155
plug-in mapping 75

Mark In switch 95
Mark Out switch 95
Master Input Monitor Mode switch 94
Master Link switch (plug-ins) 81, 88
Master Record Enable switch 94
Master Record Mode switches 94

Master Input Monitor Mode switch 94
Master Record Enable switch 94

Maximum Custom Fader Bank Size preference 42, 75
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Memory Location switch 106
Memory Locations 113
meter displays (Fader Module) 125
meter displays (Main Unit) 124
Meter preferences 44
Meter switch 107
meters 8

calibration 45
plug-ins 84
reference levels 125

Mic Pre switches 52
MIDI controls 51
MIDI switch 106
Mini (stereo) outputs (Monitor section) 117
Miscellaneous controls 8, 112
Mix/Edit Groups mode (Custom Fader) 67, 151, 152
Modes switch (automation) 110
modifier switches 56
Monitor Output Mode controls 118

Calibration switch 118
Dim switch 118
Mono switch 118
Mute switch 118

Monitor section 115
Control Room Monitoring controls 116
displays 119
Headphone/Cue controls 121
Talkback/Listen controls 122

monitoring 8, 115, 116
Mono switch 118
Mute Clear switch 67
Mute switch (automation) 62
Mute switch (Monitor section) 118
Mute switches (channel strips) 55

N
Navigate Mode switch 97
navigation controls 8, 97
Next switch (automation) 63
Notch/Shelf switches (Dynamics plug-ins) 80
nudging (tracks) 8

O
Off switch (automation) 69
online status

external machines 94
Pro Tools 94

opening sessions 111
Operation switch 107
Output Channel Select switches (Monitor section)

Mute 119
Solo 119

Output Channel Trim mode (Monitor section) 119
Output controls (Monitor section) 117
Output Level Trim controls (Monitor section) 117
outputs

assigning 127
making inactive 130

outputs (Monitor section)
Alt 117
calibrating 118
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main 117
Mini (stereo) 117
selecting 117
trimming 117, 119

P
Page switch (plug-ins) 82
Page switches (channel strips) 52
Pan on Lower Encoder preference 41
Pan switch (automation) 62
Pan switches 53
pinout diagrams 165
Playlist switch 104
playlists

assigning 132
Plug-in Automation controls 59
plug-in controls

Dynamics 8, 71, 78
EQ 8, 71, 85
Gain 84, 90

Plug-in mode (Custom Fader) 68, 153
D-Control Guide72
plug-ins 8, 71, 78, 85
assigning 71
Automation Safe 59, 154
Automation Safe switch 83
Automation switch 83, 89
Bypass switch 83, 90
bypassing 83, 90, 133, 154
changing settings 73
Channel Select switches 81, 88
Compare switch 83, 89, 154
copying settings 74
Custom Fader mode 153
Cycle switch 83, 90
Dynamics 78, 132
Dynamics gain reduction 77
enabling automation 59, 74, 154
EQ 85, 132
focusing 43, 72, 132, 153
Lock switch 83, 89
making inactive 73, 133
mapping 75
Master Link switch 81, 88
meters 84
multichannel 71, 81, 88
multi-mono 71, 81, 88, 154
multiple plug-in windows 73
opening plug-in windows 72, 83, 90
Page switch 82
Safe switch 90
Save As switch 82, 89
Select/Link/Bypass Mode switch 81, 88
targeting 73
Window switch 83, 90

Post-Roll switch 95
PRE controls 135

tracks 135
Pre-Fader Listen (Monitor section) 120
Preferences (D-Control) 40, 162

Assign Matrix 139
Bank Justification 40
Custom Fader Bank Justification 42
Custom Fader Hidden Tracks 43
Custom Faders 42
Display 44
Display Brightness 162
Display Contrast 163
Encoder Order 41
Faders On/Off 40
Footswitch settings 163
Learn Touch 75
Maximum Custom Fader Bank Size 42, 75
Meters 44
Pan on Lower Encoder 41
Rotary Encoder Velocity mode 41
Select Switch Latch mode 42
Sleep Mode settings 163
Touch Value 40

Prefs switch (automation) 110
Pre-Roll switch 95
Pro Tools Online switch 94
Publish switch 102
Punch Capture command 137
Punch switch (automation) 63
punching automation 137

Q
QuickPunch switch 94
QWERTY Disable switch 102

R
Ratio/Range control (Dynamics plug-ins) 79
Read switch (automation) 69
Record Enable switches 54
Record Safe mode 54
Redo switch 102
reference level preference (meters) 125
Release Control (Dynamics plug-ins) 79
requirements

connections 4, 33, 35, 165
operational 4
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automation mode indicator 50
Bypass/Mute/Pre Switch mode 61
display color 50
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Safe switch (plug-ins) 90
Save As switch (plug-in settings) 82, 89
Save switch (sessions) 102
saving settings 82, 89
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Scrub switch 93
Scrub/Shuttle controls 92

Scrub switch 93
Scrub/Shuttle wheel 92
Shuttle switch 93
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Scrub/Shuttle wheel 92
moving windows 92
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scrubbing 93
selecting 92
zooming 92

scrubbing (Scrub/Shuttle wheel) 93
Select mode (Channel Select switch) 54
Select Switch Latch mode 42
Select/Focus switch 67
Select/Link/Bypass Mode switch (plug-ins) 81, 88
Select/MIDI controls 106

Bank Select 106
Memory Location 106
MIDI 106

selecting
Scrub/Shuttle wheel 92
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setting Start/End/Length 112

Send Assign Matrix 144
Send Mute switch (automation) 62
Send Pan mode 54
Send Pan switch (automation) 62
Send Volume switch (automation) 62
sends

assigning 127, 128, 134, 145
Automation Safe 59
clipping indication 54
displaying 129
making inactive 130
muting 133
setting pre- or post-fader 133
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Redo 102
Save 102
Undo 102
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opening 111
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Set to Default switch 65
Show Values switch 61
Show/Hide switch 111
Shuttle switch 93
Single Transport mode 99
slave tracks 51
Sleep Mode settings 163
Snap switch 103
snapshots 136
Soft Keys 8, 103

Automation controls 109
Edit controls 105
Management controls 103
Select/MIDI controls 106

solo
focusing tracks 131
latching 55
output connections 167

Solo Clear switch 67
Solo In Place (Monitor section) 120
Solo Latch options (Monitor section) 120
Solo Mode controls (Monitor section)

After-Fader Listen 120
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Pre-Fader Listen 120
Solo in Place 120

Solo Safe mode 55
Solo switches 55
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specifications

mechanical 5
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assembly 19, 20, 21
components 3, 16
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hardware 17
installing D-Control units 22, 23, 24
leveling 18

Start (Start/End/Length) switch 112
Start switch (automation) 63
Stereo inputs (Monitor section) 116
Sum mode (Monitor section) 116
Surround inputs (Monitor section) 116
Suspend Groups switch 65
Switch Info switch 61
System Info (Utility mode) 158

T
talkback

Assign switch 122
connections 167
Dim function 121, 123
External level control 122
Level control (built-in) 122
microphone (built-in) 124

Talkback switches 8, 69, 123
Auto Talkback switch 123

Talkback/Listen system 122
targeting plug-ins 73
Test pages (Utility mode) 159
Threshold control (Dynamics plug-ins) 80
time scale display 8, 124
time scale display format indicator 124
Touch switch (automation) 69
Touch Value preference 40
Track Arm from Channel Strips switch 96
Track Size switches 113
Track switch 104
trackball

moving or replacing 31
TrackPunch switch 94
tracks

Automation Safe 59
focusing 54, 93, 131
Inline Console mode 135
making inactive 130
nudging 93
selecting 54, 131

Tracks mode (Custom Fader) 68, 153
transport controls 8, 91
Transport Master 100
Transport mode 99
Transport Mode switches 94

9-pin Remote 94
Loop Playback 94
Pro Tools Online 94
QuickPunch 94
TrackPunch 94

Trim mode (Monitor section) 119
Trim switch (automation) 69
Trim switch (Scrub/Shuttle controls) 93

U
Undo switch 102
Unit Name (Utility mode) 158
User switch 106
Utility mode 102, 157

Reset Unit 162
System Info 158
Test pages 159
Unit Name 158

Utility switch (Utility mode) 102
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VCA Master tracks 49, 50, 51, 53, 152, 153
video display 8, 27
view definitions 43, 153
Volume switch (automation) 62

W
Window Configurations 114
Window Management switches 8, 101
Window switch (Custom Fader Plug-In mode) 68
Window switch (plug-ins) 83, 90
windows

moving 92
opening 101, 104

Write switch (automation) 69
Write to All (automation) 62
Write to End (automation) 63
Write to Next (automation) 63
Write to Punch (automation) 63
Write to Start (automation) 63

X
XMON 165

back panel overview 12
components 3
connections 9, 12, 35, 167
front panel overview 11
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Zoom Mode switch 97
Zoom Preset switches 97
Zoom Toggle 113
Zoom/Navigate section 97

Arrow switches 97
Navigate Mode switch 97
Zoom Mode switch 97
Zoom Preset switches 97

zooming
Scrub/Shuttle wheel 92
D-Control Guide74
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